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Contacting RUCKUS Customer Services and Support

The Customer Services and Support (CSS) organization is available to provide assistance to customers with active warranties on their RUCKUS
products, and customers and partners with active support contracts.

For product support information and details on contacting the Support Team, go directly to the RUCKUS Support Portal using https://
support.ruckuswireless.com, or go to https://www.commscope.com/ruckus and select Support.

What Support Do | Need?

Technical issues are usually described in terms of priority (or severity). To determine if you need to call and open a case or access the self-service
resources, use the following criteria:

e  Priority 1 (P1)—Critical. Network or service is down and business is impacted. No known workaround. Go to the Open a Case section.

e  Priority 2 (P2)—High. Network or service is impacted, but not down. Business impact may be high. Workaround may be available. Go to
the Open a Case section.

e  Priority 3 (P3)—Medium. Network or service is moderately impacted, but most business remains functional. Go to the Self-Service
Resources section.

e  Priority 4 (P4)—Low. Requests for information, product documentation, or product enhancements. Go to the Self-Service Resources
section.

Open a Case

When your entire network is down (P1), or severely impacted (P2), call the appropriate telephone number listed below to get help:
e Continental United States: 1-855-782-5871
e Canada: 1-855-782-5871

e  Europe, Middle East, Africa, Central and South America, and Asia Pacific, toll-free numbers are available at https://
support.ruckuswireless.com/contact-us and Live Chat is also available.

e  Worldwide toll number for our support organization. Phone charges will apply: +1-650-265-0903

We suggest that you keep a physical note of the appropriate support number in case you have an entire network outage.
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Document Feedback

Self-Service Resources
The RUCKUS Support Portal at https://support.ruckuswireless.com offers a number of tools to help you to research and resolve problems with your
RUCKUS products, including:

o  Technical Documentation—https://support.ruckuswireless.com/documents

e  Community Forums—https://forums.ruckuswireless.com/

e  Knowledge Base Articles—https://support.ruckuswireless.com/answers

e  Software Downloads and Release Notes—https://support.ruckuswireless.com/#products_grid

e  Security Bulletins—https://support.ruckuswireless.com/security

Using these resources will help you to resolve some issues, and will provide TAC with additional data from your troubleshooting analysis if you still
require assistance through a support case or RMA. If you still require help, open and manage your case at https://support.ruckuswireless.com/

casefmanagement.

Document Feedback

RUCKUS is interested in improving its documentation and welcomes your comments and suggestions.
You can email your comments to RUCKUS at #Ruckus-Docs@commscope.com.
When contacting us, include the following information:
e  Document title and release number
e  Document part number (on the cover page)
e  Page number (if appropriate)
For example:
e  RUCKUS SmartZone Upgrade Guide, Release 5.0
e  Part number: 800-71850-001 Rev A
e Page7

RUCKUS Product Documentation Resources

Visit the RUCKUS website to locate related documentation for your product and additional RUCKUS resources.

Release Notes and other user documentation are available at https://support.ruckuswireless.com/documents. You can locate the documentation by
product or perform a text search. Access to Release Notes requires an active support contract and a RUCKUS Support Portal user account. Other
technical documentation content is available without logging in to the RUCKUS Support Portal.

White papers, data sheets, and other product documentation are available at https://www.commscope.com/ruckus .

Online Training Resources

To access a variety of online RUCKUS training modules, including free introductory courses to wireless networking essentials, site surveys, and
products, visit the RUCKUS Training Portal at https://commscopeuniversity.myabsorb.com/. The registration is a two-step process described in this
video. You create a CommScope account and then register for, and request access for, CommScope University.

RUCKUS Virtual SmartZone Getting Started Guide
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Preface
Command Syntax Conventions

The following table lists the text conventions that are used throughout this guide.

TABLE 1 Text Conventions

Convention Description
monospace Identifies command syntax examples
bold User interface (Ul) components such

as screen or page names, keyboard
keys, software buttons, and field
names

italics Publication titles

Notes, Cautions, and Safety Warnings

Example
device (config) # interface ethernet 1/1/6

On the Start menu, click All Programs.

Refer to the RUCKUS Small Cell Release Notes for more information.

Notes, cautions, and warning statements may be used in this document. They are listed in the order of increasing severity of potential hazards.

NOTE

A NOTE provides a tip, guidance, or advice, emphasizes important information, or provides a reference to related information.

ATTENTION

An ATTENTION statement indicates some information that you must read before continuing with the current action or task.

CAUTION
A A CAUTION statement alerts you to situations that can be potentially hazardous to you or cause damage to hardware, firmware,

software, or data.

DANGER
A A DANGER statement indicates conditions or situations that can be potentially lethal or extremely hazardous to you. Safety labels are
also attached directly to products to warn of these conditions or situations.

Command Syntax Conventions

Bold and italic text identify command syntax components. Delimiters and operators define groupings of parameters and their logical relationships.

Convention Description

bold text Identifies command names, keywords, and command options.
italic text Identifies a variable.

[] Syntax components displayed within square brackets are optional.

Default responses to system prompts are enclosed in square brackets.

{x|yl z} A choice of required parameters is enclosed in curly brackets separated by vertical bars. You must select one of the options.
x|y A vertical bar separates mutually exclusive elements.
<> Nonprinting characters, for example, passwords, are enclosed in angle brackets.

Repeat the previous element, for example, member[member...].

\ Indicates a “soft” line break in command examples. If a backslash separates two lines of a command input, enter the entire command at

the prompt without the backslash.
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About This Guide

This Virtual SmartZone (vSZ) Getting Started Guide provides information on how to set up the vSZ virtual appliance on the network. You can install
the vSZ on any of the supported hypervisors.

Topics covered in this guide include preparing your chosen hypervisor, installing the vSZ image on to the hypervisor, and completing the vSZ Setup
Wizard.

This guide is intended for use by those responsible for installing and setting up network equipment. Consequently, it assumes a basic working
knowledge of local area networking, wireless networking, and wireless devices.

NOTE
If release notes are shipped with your product and the information there differs from the information in this guide, follow the instructions
in the release notes.

Most user guides and release notes are available in Adobe Acrobat Reader Portable Document Format (PDF) or HTML on the Ruckus Networks
support website at https://support.ruckuswireless.com/documents.

Notice Conventions

The following table lists the notice conventions that are used throughout this guide.

TABLE 2 Notice Conventions

Notice Type Description
NOTE Information that describes important features or instructions
CAUTION! Information that alerts you to potential loss of data or potential damage to an

application, system, or device

WARNING! Information that alerts you to potential personal injury
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New In This Document

TABLE 3 Key Features and Enhancements in SmartZone 6.1.0 (December 2021)

Feature

Description

Reference

Resource table

Updated: Support for vSZ-H and vSZ-E resources.

° Virtual SmartZone Minimum
Requirements on page 16

vsz installation for GCP

Updated: Installation procedure for GCP.

Refer to Creating a Network and Configuring Firewall
Rules on page 150 and Creating a vSZ Image for
Virtual Machines on page 145 for more information.

Clustering Limitations for vSZ-E

Deleted: Above 2 nodes in a cluster at Resource
Level 2, additional 2 CPU cores need to be added to
each node to support the added search capabilities
and replication.

Clustering Limitations on page 22

SmartZone new Ul

Updated: New Ul images and navigation.

° Connect to vSZ Using CLI on LINUX Server
on page 254

. Upgrading the Controller Software on
page 273

° Verifying the Upgrade on page 276

° Creating a Cluster Backup on page 277
° Restoring a Cluster Backup on page 278
. Deleting a Cluster Backup on page 281
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Obtaining the vSZ Distribution

You have to download the .OVA file and documentation for the controller from the vSZ download page on the Ruckus Networks support website.
The vSZ distribution package, which is based on the Open Virtualization Format (OVF) framework, consists of a virtual appliance.

Open Virtualization Format contains the following files:
e  Description file (.ovf)
e  Manifest file (.mf)

e  Virtual machine state file (.vmdk)

Preparing the vSZ Interface Settings to Use

vSZ comes with the option to operate with either one (1) network interface or three (3) network interfaces. Once the network interface
configuration has been made and setup executed, the number of network interfaces can no longer be modified.

CAUTION
A vSZ supports one (1) network interface on public cloud. Three (3) network interfaces option is only for on-premises vSZ.

CAUTION
A If you choose to operate the vSZ with three network interfaces, you must configure the three vSZ interfaces to be on three different

subnets when you run the Setup Wizard. Failure to do so may result in loss of access to the web interface or failure of system functions
and services.

e |Paddress

e  Netmask

e  Gateway

e  Primary DNS server

e  Secondary DNS server

TABLE 4 vSZ interfaces

Interface Description

AP Used for AP configuration and client traffic

Cluster Used for cluster traffic

Management (Web) Used for management traffic. The IP address that you assign to this interface will
be the IP address at which you can access the vSZ web interface.
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Virtual SmartZone Minimum Requirements

NOTE
One or more resources can be higher than the specified requirements. For example, if the instance requires 24Gb RAM, assigning 32Gb
RAM is supported.

Hypervisor Hardware Performance Requirements

vSZ requires enough hardware resources to sustain the service. vSZ cannot support deployment in low performance hypervisor.
e  Sharing hardware server to multiple vSZ instances is not recommended.

® VSZ needs to be deployed on dedicated hardware resource to avoid different VM instance grabbing CPU or IO resources, which can impact
vSZ stability in a hypervisor, especially in a scenario where thousands of APs per node are deployed.

e  VvSZ needs to reach both CPU and IO requirement. Measure the hypervisor hardware performance before deploying vSZ.

o  Disks IO is most important in vSZ cluster. Disk 10 is the slowest subsystem in a server, which means that write-heavy clusters can easily
saturate their disks, which in turn become the bottleneck of the cluster. Avoid network-attached storage (NAS). People routinely claim
their NAS solution is faster and more reliable than local drives. NAS is often slower, displays larger latencies with a wider deviation in
average latency, and is a single point of failure.

Hypervisor CPU/IO Requirements - Private Hypervisor

CPU Performance Requirement
e  CPU single core events per second/per core need > 180 events/sec
e  Required CPU level is higher than the Intel Xeon CPU E5-4620 v4 with 2.10 GHz
10 performance requirement detail
VvSZ require high 10 performance deploy environment. Measure the hypervisor 10 performance before deployment. vSZ 10 throughput
requirements :
e |0 requirement per resource level - Refer to the Disk 10 Requirement column in the resource table.

e  Avoid network-attached storage (NAS/SAN). The general claim is that the NAS/SAN solution is faster and more reliable than the local
drives. NAS/SAN is often slower, displays larger latencies with a wider deviation in average latency, and is a single point of failure.

o  Virtual Disk - Preallocated/Eager Zeroed/Fixed Size is required to provide good performance and low latency for 10. Avoid using "Thick
Provision Lazy Zeroed/Dynamic Expanding" to impact 10 performance. [*].
How to benchmark vSZ CPU/IO Performance
o The vSZ setup process will detect the 10 performance at first setup step.

e  Usethe SZ CLI in debug-tools > system > system performance. The command will run system benchmark on CPU and IO for vSZ.

Network Latency Requirement between vSZ nodes

A fast and reliable network is important for performance in a distributed system. Low latency helps ensure that nodes can communicate easily,
while high bandwidth helps shared movement and recovery. Avoid clusters that span multiple data centers, even if the data centers are located in
close proximity. It is highly recommended to avoid clusters that span large geographic distances.

VvSZ requires low network latency between vSZ nodes on the control & cluster interface network. vSZ cannot support deployment in high network
latency environment.

RUCKUS Virtual SmartZone Getting Started Guide
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vSZ interface network latency between nodes: Cluster Interface network latency need < 60 ms.

Before upgrading vSZ to this release, verify that the virtual machine on which vSZ is installed has sufficient resources to handle the number of APs,

wireless clients and ICX Switches that you plan to manage. See the tables below for the required virtual machine system resources.

The values for vCPU, RAM, and Disk Size are linked together and cannot be changed individually. When changing one of these parameters, all three

values need to match exactly with an existing Resource Level. Taking vSZ-H Resource Level 5 as an example: when adjusting the number of vCPU
from 4 to 6, the amount of RAM needs to be adjusted to 22GB and the Disk Size needs to be adjusted to 300GB, thereby matching all the values of
Resource Level 6.

NOTE

The vSZ deployed in the Nutanix Hypervisor introduces more overhead on memory. The 10K AP per node is not sustained on 48GB
memory setting. [SCG-113477]

Workaround: When deploying vSZ on Nutanix it is recommended to allocate more memory for vSZ usage. For a 10K AP resource level,
setup needs 24 core CPU and 50 GB (+2GB) memory to control. Alternatively decrease to 25% AP deployment in vSZ resource level. For
example, 7500 AP in 10K AP resource level.

WARNING
These vSZ required resources may change from release to release. Before upgrading vSZ, always check the required resource tables for
the release to which you are upgrading.

NOTE
When initially building up the network it can use a higher Resource Level than needed for the number of APs first deployed, if all the
three parameters (vCPU, RAM and Disk Size) match exactly with that higher Resource Level.

ATTENTION
It is recommended that there should be only one concurrent CLI connection per cluster when configuring vSZ.

In the following tables the high scale resources are broken into two tables for easy readability. These tables are based on the AP Count Range.

TABLE 5 vSZ High Scale required resources

10,001

6,001
5,001
3,001
2,501
1,001
501

101

AP Count Range Max Clients Nodes per AP Count per Node AP/Switch Maximum Switch (w/o
Cluster (without Switch) Capacity Ratio AP)
From To Max Max
30,000 300,000 4 10,000 5:1 6,000
20,000 200,000 3 5:1 4,000
10,000 100,000 1-2 10,000 5:1 2,000
6,000 60,000 1-2 6,000 5:1 1,200
5,000 50,000 1-2 5,000 5:1 1,000
3,000 30,000 1-2 3,000 5:1 600
2,500 25,000 1-2 2,500 5:1 500
1,000 20,000 1-2 1,000 5:1 200
500 10,000 1-2 500 5:1 100
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TABLE 5 vSZ High Scale required resources (continued)

AP Count Range Max Clients Nodes per AP Count per Node AP/Switch Maximum Switch (w/o
Cluster (without Switch) Capacity Ratio AP)
From To Max Max
1 100 2,000 1-2 100 5:1 20

TABLE 6 vSZ High Scale required resources

AP Count Range Minimum vCPU per ~ Minimum RAM per Minimum Minimum Disk IO | Preserved Concurrent Resource
node nodel!! Disk Size per  Requirement per  Event/Alarm = CLI Level
nodel?! node Days Connection
From To Logic Processor GB GB MiB/s Max Max (per

node not per

cluster)
10,001 30,000 24 48 600 45 3/7 Days 4 8

20,000

6,001 10,000 24 48 600 45 3/7 Days 4 7
5,001 6,000 16 30 300 35 3/7 Days 2 6.6
3,001 5,000 12 28 300 30 3/7 Days 2 6.5
2,501 3,000 8 24 300 30 3/7 Days 2 6.1
1,001 2,500 [¢) 22 300 25 3/7 Days 2 )
501 1,000 464 18 150 20 3/7 Days 2 5
101 500 4 16 150 15 3/7 Days 2 4
1 100 2-40"31 13 150 15 3/7 Days 2 3

In the following tables the essential scale resources are broken into two tables for easy readability. These tables are based on the AP Count Range.

TABLE 7 vSZ Essentials required resources

AP Count Range Maximum Clients Nodes per AP Count per Node AP/Switch Capacity Ratio = Maximum Switch
Cluster (w/0 AP)
From To Max Max
1025 3,000 60,000 4 1,024 5:1 600
2,000 40,000 3 5:1 400
501 1,024 25,000 1-2 1,024 5:1 204
101 500 10,000 1-2 500 5:1 100
1 100 2,000 1-2 100 5:1 20
NOTE
The recommended vCPU core for the vSZ-E with AP Count Range 1 through 100 is 2-4.
TABLE 8 vSZ Essentials required resources
AP Count Range Minimum vCPU  Minimum Minimum Disk = Minimum Disk Preserved Event/ Concurrent CLI Resource Level
per node RAM per Size per 10 Requirement  Alarm Days Connection
node [ nodel?
From To Logic Processor GB GB MiB/s Max Max (per node not
per cluster)
1025 3,000 8 20 250 20 7 Days 2 3

2,000
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TABLE 8 vSZ Essentials required resources (continued)

Minimum vCPU
per node

AP Count Range

From To Logic Processor
501 1,024 8
101 500 4
1 100 2-41"31
NOTE

Minimum
RAM per
node [

GB

20
16
13

Minimum Disk

Size per
nodel?

GB

250
150
150

Minimum Disk

Installation Preparation

Virtual SmartZone Minimum Requirements

Preserved Event/ ~Concurrent CLI

10 Requirement  Alarm Days
MiB/s Max

20 7 Days

15 7 Days

15 7 Days

Resource Level
Connection

Max (per node not

per cluster)

2 2

2 1.5
2 1

[1] - vSZ-H and vSZ-E have different report interval. For example, AP sends the status to vSZ-E every 90 seconds but to vSZ-H it is sent
every 180 seconds, which means that vSZ-E need more RAM in scaling environment based on the resource level.

[2] - NICs assigned to direct 10 cannot be shared. Moreover, VMware features such as vMotion, DRS, and HA are unsupported.

In the following tables the high scale resources are broken into two tables for easy readability. These tables are based on the AP Count Range.

TABLE 9 vSZ High Scale
AP Count Range

From To

10,001 30,000
20,000

6,001 10,000

3,001 6,000

1,001 3,000

501 1,000

101 500

1 100

TABLE 10 vSZ High Scale
AP Count Range

From To
10,001 30,000
20,000
6,001 10,000
3,001 6,000
1,001 3,000
501 1,000
101 500

RUCKUS Virtual SmartZone Getting Started Guide
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Max Clients

300,000
200,000
100,000
60,000
30,000
20,000
10,000
2,000

Minimum Disk Size

GB

600

600

300

300

150

150

Nodes per Cluster

Switch)
Max
4 10,000
3
1-2 10,000
1-204l 6,000
1-2 3,000
1-2 1,000
1-2 500
1-2 100

Recommended Machine
Type for AWS

c5.9xlarge (36 vCPU/72 GB
RAM)

c5.9xlarge (36 vCPU/72 GB
RAM)

c5.4xlarge (16 vCPU/32 GB
RAM)

m5.2xlarge (8 vCPU/32 GB
RAM)

r5.xlarge (4 vCPU/32GB
RAM)

mb5.xlarge (4 vCPU/16 GB
RAM)

AP Count per Node (without

Recommended

Maximum Switch (w/o AP)

Max
6,000
4,000
2,000
1,200
600
200
100
20

Disk 10 Requirement

Machine type for

AZure

F32s_v2 (32 vCPU/64 | 45

GB RAM)

F32s_v2 (32 vCPU/64 | 45

GB RAM)

F16s_v2 (16 vCPU/32 | 35

GB RAM)

D8s_v3 (8 vCPU/32 25

GB RAM)

E4s_v3 (4 vCPU/32 20

GB RAM)

D4s_v3 (4 vCPU/16 15

GB RAM)
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TABLE 10 vSZ High Scale (continued)

AP Count Range Minimum Disk Size Recommended Machine Recommended Disk 10 Requirement
From To GB Type for AWS Machine type for
AZure
1 100 150 r5.large (2 vCPU/16 GB RAM) | DS11_v2 (2 vCPU/14 | 15
GB RAM)

or

D4s_v3 (4 vCPU/16
GB RAM)

In the following tables the essential scale resources are broken into two tables for easy readability. These tables are based on the AP Count Range.

TABLE 11 vSZ Essentials required resources

AP Count Range Maximum Clients Nodes per Cluster AP Count per Node Maximum Switch (w/o
AP)

From To Max Max

1025 3,000 60,000 4 1,024 600

2,000 40,000 3 400

501 1,024 25,000 1-2 1,024 204

101 500 10,000 1-2 500 100
1 100 2,000 1-2 100 20

NOTE
The recommended vCPU core for the vSZ-E with AP Count Range 1 through 100 is 2-4.

TABLE 12 vSZ Essentials required resources

AP Count Range Minimum Disk Size Recommended Machine Recommended Machine type = Disk 10 Requirement
From To GB Type for AWS for AZure
1025 3,000 250 mb5.2xlarge (8 vCPU/32 GB | D8s_v3 (8 vCPU/32 GB RAM) 20
2,000 RAM)
501 1,024 250 m5.2xlarge (8 vCPU/32 GB | D8s_v3 (8 vCPU/32 GB RAM) 20
RAM)
101 500 150 mb5.xlarge (4 vCPU/16 GB D4s_v3 (4 vCPU/16 GB RAM) 15
RAM)
1 100 150 r5.large (2 vCPU/16 GB DS11_v2 (2 vCPU/14 GB RAM) | 15
RAM) or

D4s_v3 (4 vCPU/16 GB RAM)

RUCKUS Virtual SmartZone Getting Started Guide
20 Part Number: 800-72269-001 Rev G



NOTE

Installation Preparation
Virtual SmartZone Minimum Requirements

[1] - Increase the vSZ total memory 2~4 GB when running on special or extreme deploy environment when vSZ raise a memory
exceed (90%) alarm. For example:

- Deploy 4-node vSZ cluster on Nutanix with full 30K AP capacity.
- One vSZ node down in 4-node vSZ cluster to long term sustain 30K AP in 3 alive vSZ nodes.

The solution should be recovered the fail vSZ node as soon as possible. But if user need run 3 nodes with 30K AP in long
term sustain, it need to increase the vSZ memory to run.
- All APs with full statistic reports (AVC, HCCD, UE, ...) to SZ on full load stress condition.

[2] - Required Disk Type

- AWS: General Purpose SSD (gp2)
- GCE: SSD
- Azure: Standard-SSD

[3] - If deployed hardware CPU computing performance is not good as recommended in 100 AP resource level, the 2 cores CPU

setting cannot be supported. Upgrade to 4 cores instead of 2 cores in this case.

[4] - If deployed hardware CPU computing performance is not good as recommended Hypervisor (like Hyper-V) in 4-CPU setting
to support 1000K AP, upgrade to 6 cores instead of 4 cores in this case.

The 6000 AP resource profile level could support to 4 nodes cluster. The total supported AP number will be up to 18,000 APs in

a 4 node vSZ cluster.

Workaround if virtualization platform always need Thin Provision/Lazy Zeroed/Dynamic Expanding case.

User could skip this setup validation and user has to understand the risk user skip. In high APs deployment environment, high
10 performance is required. It is a hidden command and not recommended to execute in production deployment.

CLI # debug

CLI (debug) # debug-tools

(debug tool-set) system $ use sz

(debug tool-set) sz $ skip-setup-capability-check

Change Log of vSZ Resource Plan

New support for 3000, 6000 APs resource level for more flexibile deployment and better cost effectiveness for customer.

Due to system limitation for the minimum disk requirement, the base disk size requirement is increased from 100 GB to 150 GB on low

level resource profile. No impact for user to upgrade from previous version. Requires new setup vSZ to follow new disk size.

As the resource level has hit the system limitation in some case, for the vSZ-E 1024 APs resource level memory is increased from 18 GB to
20 GB. No impact for user to upgrade from previous version. User need to change only the memory setting when encountering memory

usage alarm exceeding 90%.

Adding additional notes vSZ memory required in extreme vSZ deployment and cases.

New session, vSZ-H instance Resource Allocate Instruction, is added.
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Clustering Limitations

The following are the limitations for vSZ-H and vSZ-E.

Clustering Limitations for vSZ-H

e  vSZ-H supports up to 10,000 APs per node or 30,000 APs per cluster, assuming proper system resources are made available. It supports
clustering of up to 4 nodes when using Resource Level 8.

e At 4 nodes, the maximum number of APs and clients that can be supported are 30,000 and 300,000 respectively.

Clustering Limitations for vSZ-E

e  VvSZ-E supports up to 1,024 APs per node or 3000 APs per cluster, assuming proper system resources are available. It supports clustering of
up to 4 nodes when using Resource Level 3.

® At 4 nodes, the maximum number of APs and clients that can be supported are 3,000 and 60,000 respectively.

o  NAT operation for vSZ cluster: Currently, each node requires its own public IP address for its NAT'ed interface. As such, a 1:1 NAT is
recommended for setting up a cluster behind a NAT environment.
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° Installing the vSZ on VMWare vSphere Hypervisor
° Installing the vSZ on Windows Server Hyper V
° Installing the vSZ on a Kernel based Virtual Machine Hypervisor
e Installing the vSZ on an OpenStack Hypervisor
e Installing the vSZ on a Nutanix Hypervisor

Preparing a Hypervisor

This section lists the hypervisors (and their release versions) on which you can install the vSZ.

TABLE 13 Hypervisors that the vSZ supports

Vendor Hypervisor Version

VMWare ESXi 5.5 and later (6.7 or later recommended)
Windows Windows Server Hyper-V Windows Server Hyper-V (2016 and 2019)
KVM CentOS 7.4(1708), 7.5 (1804), 7.7 (1908), and 8 (1905)
OpenStack CentOS Stein, Rocky, and Queens

Nutanix Nutanix Nutanix Community Edition

Hypervisor CPU/IO Requirements - Self Own Hypervisor

Benchmarking vSZ CPU/I0 Performance

Refer to the SZ System Benchmark Tool (SZ_System Benchmark Tool 0.ksp) released by Ruckus to measure vSZ in Hypervisor

performance. This tool provides the benchmark result and performance measure to run vSZ on CPU (Central Processing Unit) and 10 (Input Output).

Performance Requirement

CPU | cpu single core events per second/per core need > 180.

10 Requirements change per resource level. Refer to resource table for minimum values (column 'Disk 10 requirement')

NOTE

This benchmark tool is relevant for SmartZone releases 3.4.2, 3.6.2 and 5.1.1. From release 5.2, the system benchmark tool will be inbuilt

through CLI command.

NOTE

You can download the SZ_System Benchmark Tool O0.ksp from the support website: https://support.ruckuswireless.com/

software/2138-smartzone-5-1-1-mr1-virtual-smartzone-system-benchmark-tool-ksp.
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Installing the vSZ on VMWare vSphere Hypervisor

You have to install the vSZ on a VMWare vSphere hypervisor.

Before You Begin

You have to complete the prerequisites before installing the vSZ on VMWare vSphere.

Verify that you have the prerequisites before installing the vSZ on VMWare vSphere.

Verify that vSphere client is installed.
You can deploy the vSZ only on hosts that are running ESXi version 5.5 and later (6.7 or later recommended).

The vSZ appliance requires at least 150GB of disk space and is limited to a maximum size of 600GB. The vSZ appliance can be deployed
with thin provisioned virtual disks that can grow to the maximum size of 600GB.

Preallocated/Eager Zeroed/Fixed Size is required to provide good performance and low latency for 10.

Avoid using "Thick Provision Lazy Zeroed/Dynamic Expanding" to impact 10 performance.

Creating a vSZ Instance from the OVA File

You can create a vSZ instance using the vSphere Web Client.

Before continuing, ensure you have already downloaded the vSZ distribution package. See Obtaining the vSZ Distribution for more information.

Follow these steps to create a vSZ instance from the OVA file.

1.

24

Use the VMWare vSphere client to log on to the ESXi management interface.
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2.

FIGURE 1 Click Deploy OVF Template

Installing the vSZ on a Hypervisor
Installing the vSZ on VMWare vSphere Hypervisor

Click File> Deploy OVF Template. The Source screen of the Deploy OVF Template wizard appears.

@ Ruckus-Testl - vSphere Client

File | Edit View Inventory Administration Plug-ins Help

Mew 3

[E=1 EoR =<5

htory b [El Hosts and Clusters

| E’,jv Search Inventory |Q|

Li)eploy OVF Template... i

Export 3
Report 3

Browse VA Marketplace...
Print Maps 3
Exit

[ [VSEg-2-5-pul |
3 vsm-5.1.2-1
B & vscg-cluster-1
{1 Barracuda Ly
3 John-vSCG
3 VMware Stu| _
& vscg-165-1
[ vscg-2.5.0.1
G vscg-2.5.0.1
[ vscg-2.5.0.1
@& vscg-cluster-2
3 sim-1
38 sim-2
B i PLM Lab
IE 172.16.112.217|
nazon-EC2- 1

vecg2 5.0.0.75
wern? &1 1106
] I 3

B e @

What is a Virtual Machine?

T A virtual machine is a software computer that, like a

physical computer, runs an operating system and
applications. An operating system installed on a virtual
machine is called a guest operating system.

Because every virtual machine is an isolated computing
environment, you can use virtual machines as desktop or
workstation environments, as testing environments, or to
consolidate server applications.

In vCenter Server, virtual machines run on hosts or
clusters. The same host can run many virtual machines.

Basic Tasks

Power Off the virtual machine

I Suspend the virtual machine

summary ' ResourceAllocation ' Performance ' Tasks & Events

vSphere Client

Alarms ' Console ' Permissions ' M

[»

Virtu

Cluster | S[5 &(

‘\' Datacer
vCenter Server

ol

F Tasks @ Marms |

lroot
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3. Click Browse to locate the .ova file that you downloaded earlier. Select the template.

FIGURE 2 Click Browse, and then locate and select .ova file

@ Deploy OVF Template - Ul X

Source
Select the source location.

Source

OVF Template Details

End User License Agreement

Name and Location

Disk Format

Network Mapping Deploy from a file or URL

Ready to Complete -
- tsao 1\Downloads\vscg-6.0.0.0.1331.0va Browse... |

Enter a URL to download and install the OVF package from the Internet, or
specify a location accessible from your computer, such as a local hard drive, a
network share, or a CD/DVD drive.

Help | < Back || Next > I Cancel i
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4. Click Next. The OVF Template Details screen appears.

FIGURE 3 The OVF Template Details screen

@ Deploy OVF Template

OVF Template Details
Verify OVF template details.

Source

OVF Template Details

End User License Agreement Product:

Name and Location -
Version:

Disk Format

Network Mapping Vendor:

Ready to Complete
Download size:
Size on disk:
Description:

Installing the vSZ on a Hypervisor
Installing the vSZ on VMWare vSphere Hypervisor

Virtual SmartZone
6.0.0.0.1331

Ruckus Wireless, Inc.

1.8GB

3.0 GB (thin provisioned)
150.0 GB (thick provisioned)

Ruckus Virtual SmartZone (vSZ), is a Network Functions
Virtualization (NFV) based WLAN Controller for service providers
and enterprises who desire a carrier-class solution that runs in the
doud. It supports all of the WLAN Controller features of the
industry leading 5Z-300 and 5Z-100, while also enabling the
rollout of highly scalable and resilient wireless LAN doud services.

Help |

< Back || Next > I

Cancel

5. Review the OVA virtual appliance details, and then click Next. The End User License Agreement (EULA) screen appears.
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6. Click Accept to agree to the EULA terms, and then click Next.

FIGURE 4 Accept the EULA for the vSZ OVA

F@__Depln}'m"FTerqﬂate

o A

|
|
1
E

End User License Agreement
Accept the end user license agreements.

n Souree
VET ate Details
End User License Agreemd
Mame and Location
Ciesk Farmat
Pletwork Mapping
Ready to Complete

RLICKLIS WIRELESS, TNC. -
Wirlual SmaritZame (vSI) Software License 1
PLEASE READ THIS SOFTWARE LICEMSE CAREFULLY. RUCKUS WIRELESS, INC, [(RUCKLST U

5 WILLING TO LICENSE THE SOFTWARE

TO YOU {"LICEMSEE ) OMLY O THE COMDITION THAT THE LICENSEE ACCEPTS ALL OF THE
FOLLOWING TERME AMD CONDITIONS,

IF A USER ACCEPTS THIS LICENSE, OR DOWNLOADS, LISES OR INSTALLS THE SOFTWARE,
AS AN EMPLOYEE OF, OR AS AN AGENT

0R. CONTRACTOR. FOR THE BENEFIT OF, A COMPANY, THAT COMPANY SHALL BE DEEMED
THE LICEMSEE AND THE USER REPRESENTS

THAT IT HAS THE POVWER AND AUTHORITY TO ACCEPT THIS AGREEMENT ON BEHALF OF THE
COMPAMY,

BY DOWHLOADING, INSTALLTNG AMDJOR USING THE SOFTWARE, LICENSEE ACKMNOWLEDGES
THAT IT HAS READ THIS LICENSE AND

AGREES TO BE BOUND BY ITS TERMS AMD COMDITIONS, IF LECENSEE DOES MOT AGREE TO
THE TERMS AND CORDITIONS OF THIS

LICEMSE, RUCKLUS IS UNWILLIMG TO LICENSE THE SOFTWARE. IM THAT EVENT, LICEMSEE
AT MOT DOWTLCAD, LSS OR. INSTALL

THE SOFTWARE AMND SHALL BE GIVEM A FULL REFUND OF ANY LICENSE FEES ACTUWLLY PAID
FOR THE SOFTWARE.

1) Definitiona

Diewice” means a sngle Ruckus access point on Lcensee’s network,

TDocumentation” means the pubished technical manuals, induding any updates thereto,
relating to the use of the Software made generaly

avalable by Rudwus.

Evaluation Term” means the imited period of time folowang Licensee's inital download of the
Software durng which Licensee & permitied

ta use the Software without placing an Order; provided, that the Evaluation Term is subject ta
early termination as provided in this

agreement.

“Software” means a copy of a machne executable version of a Rudus software product that
Ruckus makes availsble to Licerses for doverdosd -

[aceept ]

e

« Back Mext > I Cancel
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7. Select the disk format that is appropriate for your deployment scenario. Options include:

e  Thick Provision Lazy Zeroed
e  Thick Provision Eager Zeroed

e  Thin Provision

FIGURE 5 Select the disk format for your deployment scenario

(%) Deploy OVF Template

Disk Format
In which format do you want to store the virtual disks?

Source Datastore: Idatastore 1

OVF Template Details
User se Agreeme |
End User License Agreement Available space (GB): 154.6

Name and Location
Disk Format
Network Mapping

Ready to Complete

{* Thick Provision Lazy Zeroed
" Thick Provision Eager Zeroed

" Thin Provision

Installing the vSZ on a Hypervisor
Installing the vSZ on VMWare vSphere Hypervisor

Help |

< Back

Next >

Cancel

RUCKUS Virtual SmartZone Getting Started Guide
Part Number: 800-72269-001 Rev G

29



Installing the vSZ on a Hypervisor
Installing the vSZ on VMWare vSphere Hypervisor

30

8.

FIGURE 6 ESXi 6.7 with two options

11 Newe virtual machine - 5.1.2.0

+ 1 Select creation type

¥ 2 Select OV and WMDK files Select deployrment options

Deployment options

+ 3 Select storage
w4 License agresmernts

b 5 Deployrnent 13

Hetwork mappings

6 Ready 1o compilete:

Digk prowisioning

Poweer on automatically

Wi Rlatwidrk | Cor

Thin '™ Thick

O

Back

Cancel

Mlext Finish

|

Click Next. The Network Mapping screen appears.
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9. Select the ESXi virtual network interface that you want to use for the control interface, and then click Next. The Ready to Complete screen
appears.

The installation screen only allows you to select the virtual network interface for the control interface. After you complete the installation
(and before you power on and set up the vSZ), you will need to adjust the cluster and management interfaces as appropriate.

FIGURE 7 Select the virtual network interface that the template will use

r - - - R
{4 Deplay OVF Template e o5 S
Hebwork Mapping
What netwarks should the deployed template use?

||
| Source

OVF Template Details Map the networks used in this OVF template to nebwarks in your inventory

End Liser Licenss Aoresment

Mleme and Location Saurce Metworks | Destination Networks

Dk Farmat I 1 §

g ormet VM Network Control Network

Nebwork Mapping

Aeady to Comokeie

Desoiption:
The WM Metwork netwark »
|
L
Ll |
Help I = Badk J Hext » I Cancel J
A
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10. Review the settings that you have configured on the previous screens. If you find a setting that you want to change, click Back until you
reach the screen where you can edit the setting. Update the setting, and then click Next until you reach the Ready to Complete screen
again.

FIGURE 8 Review the settings that you have configured

@ Deploy OVF Template — O X

Ready to Complete
Are these the options you want to use?

Cource
ﬁmglate Details When you dick Finish, the deployment task will be started.
End User License Agreement Deployment settings:
Name and Location OVFfile: C:\Users\dtsao1\Downloads\vscg-6.0.0.0.1331.ova
Disk Format Download size: 1.8 GB
%phte Size ondisk: 150.0 GB
Name: Virtual SmartZone
Host/Cluster localhost.video®loal
Datastore: datastorel
| Disk provisioning: Thick Provision Lazy Zeroed
Network Mapping: "VM Network”to "Management interface vmnic2"

I™ Power on after deployment

Help | < Back || Finish I Cancel

11. Make sure that the Power on after deployment check box is clear so you can adjust the network settings before the vSZ setup.Caution: If
you power on the vSZ after installation, you will no longer be able to adjust the network settings.

12. Click Finish.
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ESXi deploys the new vSZ instance. When ESXi completes the deployment, the new vSZ instance appears on the list of installed virtual machines on

the target host.

FIGURE 9 The vSZ instance appears on the list of installed VMs

vmware* vSphere Web Client #® &
4 vCenter ) X (1 vSCG1-DataCenter  Actions ~
| o 2 03 e | Getting Started Summary Monitor Manage Ref
w (71 localhost i
~ fin Datacenter What is a Virtual Machine?
s 10.3.3.
v (1033244 A virtual machine is a software computer that,

Ebpm_m_g_g_n_n_za (cha like a physical computer, runs an operating
EﬁFreeRﬁ.DIUS (Jeanette) system and applications. An operating system

5B HS20-R2_CentOS (Dave
b HS20-R2_OSU (Dave)
(B Novell (Jeanette)

5B portal (Jeanette)

(b portalt (Jeanette)

G portal2 (Jeanette)

(3p portal3 (Jeanette)
Eb RuckuslLabs-SCG-TME

& SCI Demo LCS (Jeanett
G5p VMware vCenter Server

ﬁvaCG-Puhlic SE Access
g vSCG1-DataCentar

5 Win2008 (Deepak)
(5 ZDVM-Public (Deepak) |

installed on a virtual machine is called a guest
operating system.

Because every virtual machine is an isolated
computing environment, you can use virtual
machines as desktop or workstation
environments, as testing environments, or to
consolidate server applications.

In vCenter Server, virtual machines run on
hosts or clusters. The same host can run many
virtual machines.

You have completed creating a vSZ instance from the OVA file.

Allocating Resources and Assigning Network Interfaces

Before starting the vSZ instance for the first time, edit the virtual machine settings to allocate CPU and memory resources to the vSZ and to assign

the ESXi network interfaces to the remaining vSZ interfaces (cluster and management).

Ensure that you read steps 1-7 before starting the application.

Follow these steps to allocate resources and assign network interfaces to the vSZ.

1. On the list of virtual machines, click the new vSZ instance.

2. Click Actions to display the additional options, and then click Edit Settings.

3. Set the number of CPUs and the amount of RAM to allocate to the vSZ instance. By default, the OVA template is set to 4 CPUs and 13GB of

RAM.
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import process. Ensure that the Connect at Power On check box is selected.

Power On option is selected.

Connect at Power On option is selected.

NOTE

All three interfaces, if used, must be of the same adaptor type. For example, E1000 or VMXNET3.

FIGURE 10 Select the interfaces to use

Under Network adapter 1, verify that it is the same ESXi network interface that you selected for the control interface during the OVA

Under Network adapter 2, select the ESXi network interface for the cluster interface from the drop-down list. Ensure that the Connect at

Under Network adapter 3, select the ESXi network interface for the management interface from the drop-down list. Ensure that the

34
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7. Click OK. You have completed allocating resources and assigning network interfaces to the vSzZ.

Powering on the vSZ virtual machine

The next step is to power on the vSZ virtual appliance.

1. From the list of virtual machines on the host, click the vSZ instance.

2. Under Basic Tasks, click Power on the virtual machine.

FIGURE 11 Click Power on the virtual machine

g1 vSCG1-DataCenter »
(3p Win2008 (Deepak)
(5 ZDVM-Public (Deepak)
Basic Tasks Explore Further

[» Power on the virtual machine Learn how to install a guest
operating system

Learn more about virtual
machines

&3 Edit virtual machine settings
Learn about templates

3. Open a console window to monitor the startup process. To do this, click the Action menu, and then click Open Console.

After the vSZ completes its startup process, you are ready to perform the initial IP address setup of the vSZ. You will use the console
connection to perform this task.

Installing the vSZ on Windows Server Hyper V

Before you begin, verify that Hyper-V is enabled on Windows Server. Follow these steps to install the vSZ on Windows Server Hyper-V.
1.  Obtain a copy of the vSZ image in VHD format.
2. Extract the vSZ image to the .vhd disk file.
3. Copy the image to the Windows Server on which you are running Hyper-V.
4,

On the Windows Server, click Start > Administrative Tools, and then double-click Hyper-V Manager.
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5. Inthe Hyper-V Manager, select the Hyper-V core for which you want to create a virtual machine and click Virtual Machine > Action > New

> New Virtual Machine Wizard. The appears and displays the Before You Begin screen.

FIGURE 12 Click Action > New > Virtual Machine

File

Action

Wiew  Help

&= 7

=5 Hyper- Manager

Mew

Wirtual Machine..,

Irmport Virkual Machine...

Hyper-t Settings...
Wirtual Switch Manager..,
Wirtual 38N Manager..,

Hard Disk...
Floppy Disk...

Lk CPU Usage Assighed Mermory

ines were found on this server

Edit Disk...
Inspect Disk..,

Stop Service
Rernaove Server

Refresh

Wi

Help

L

T
L<]

Checkpoints

| Actions

Details

Mo item selected.

<

Mesnr

Irnport Virkual Machine..,

Hyper-Y Settings...

Wirtual Switch Manager..,

Wirtual 34N Manager..,
Edit Disk...

Inspect Disk..,

Stop Service

Rernowve Server
Refresh

Wik

Help

was s

Displays the Mew Yirtual Machine Wizard,

36

RUCKUS Virtual SmartZone Getting Started Guide

Part Number: 800-72269-001 Rev G



Installing the vSZ on a Hypervisor
Installing the vSZ on Windows Server Hyper V

6. Click Next. The Specify Name and Location screen appears.

FIGURE 13 The New Virtual Machine Wizard screen

e New Yirtual Machine Wizard -

[ *.’ Before You Begin

u Begin This wizard helps wou create a virtual machine, ¥ou can use virtual machines in place of physical
computers For & variety of uses, You can use this wizard ko configure the virbual machine now, and
vou can change the configuration later using Hyper-Y Manager,

Specify Mame and Location

Specify Generation
[P To create a wirtual machine, do one of the Following:

Assign Mermory
. ) + Click Finish ko create a virtual machine that is configured with default values,
Configure Networking » Click Mext bo create a wirtual machine with a custom configuration,

Connect Virtual Hard Disk
Installation Options

Surnmary

Do mot show this page again

Mext = | | Firish | | Zancel
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7.

8.

In Name, type a name for the virtual machine that you are installing (for example, Virtual SmartZone).

FIGURE 14 Specify Name and Location

e Mew Yirtual Machine Wizard -

[ kn' Specify Name and Location
.L'i!f i

Before You Begin Choose a name and lacation Far this virtual machine,

ame and Lo The name is displayed in Hyper-Y Manager. 'We recommend that you use a name that helps yvou easily
Sperify Generation identify this wirtual machine, such as the name of the guest operating syskem or workload.
Assign Memory Mame: |'\.-'52|

configure Metworking ‘o can creake a Folder or use an existing folder to store the virtual machine, IF vou don't select a

Connect Virtual Hard Disk folder, the virtual maching is stored in the default Folder configured For this server,
Installation Options [] store the wirtual machine in a different location
Surnrmary C:\ProgramDatalMicrosoftiwindows\Hyper -
)
< Previous | | Mexk = | | Finish | | Cancel

Specify the folder on the server where you want to install the virtual machine.

a)

b)

To install the virtual machine in the default location, make sure that the Store the virtual machine in a different location check box is
clear.

To install the virtual machine in a location other than the default, select and Store the virtual machine in a different location check
box, and then browse to or type the new location.
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9. Click Next. The Specify Generation screen appears.

FIGURE 15 Specify Generation

e Mew Virtual Machine Wizard -
| . .
i *. Specify Generation
.I_;#‘ i
Befare Wou Begin “hoose the generation of this virtual machine,
Specify Mame and Location ® Generation 1

This wirtual machine generation provides the same virtual hardware ba the wirtual maching as in
previous wersions of Hyper-y,

Assign Mernory

Configure Metworking () Generation 2

This wirtual machine generation provides support For Features such as Secure Book, 351 book, and

Connect Virtual Hard Disk P*E boot using a standard network adapter. Guest operating swstems musk be running at least

Installation Cptions windows Server 2012 or 64-bit versions of Windows 8,
SUnAiMmary /1, Once a virbual machine has been created, you cannot change its generation,
< Previous | | Mext = | | Finish | | Zancel

10. Select Generation 1 for the virtual machine that you are installing. Hyper-V offers Generation 1 and Generation 2. See the Hyper-V
documentation for more information about these two generations.
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11. Click Next. The Assign Memory screen appears.

FIGURE 16 Assign Memory

i Mew ¥Wirtual Machine Wizard -
| .
[ kn Assign Memory
.L'i!f i
Before You Begin Specify the amaount of memary to allocate to this virtual machine, You can specify an amounk from 32

ME thraugh 29250 ME. To improve performance, specify more than the minimum armount recommended
for the operating syskem,

Specify Generation Skartup rernory: |15E|E|D ME

Specify Narme and Lacation

[ Use Cynamic Mermory For this virkual machine,
Canfigure Mebwarking

Cannact Yirtual Hard Disk .;ﬁ] ‘When you decide how much remory bo assign ko 5 wirkual machine, consider how vou inkend to

use the virtual machine and the operating system that it will run,
Inskallation Qpkions

Surnmary

< Previous | | Mexk = | | Finish || Cancel

12. In Startup memory, type 13GB for vSZ High Scale or 13GB for vSZ Essentials (as relevant), which are the minimum memory that Ruckus
Networks recommends for deploying vSZ. You can type a higher value if more memory is available on the server. For more information,
see Table 4 and Table 5.
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13. Click Next. The Configure Networking

FIGURE 17 Configuring Network

s Mewy Yirtual Machine Wizard -
| .
[ kn Configure Networking
.I_;#‘ i
Before YYou Begin Each new virtual machine includes a network adapter. You can configure the network adapter ko use a

wirkual switch, or it can remain disconnecked.
Specify Name and Location !

Specify Generation Connection: | ws-brz v

Assign Mermoary

Conneck Wirkual Hard Disk
Installation Options

Summary

< Previous | | Mext = | | Finish | | Zancel

14. In Connection, select the network adapter that you want the virtual machine to use.
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15. Click Next. The Connect Virtual Hard Disk screen appears.

FIGURE 18 Connect Virtual Hard Disk

i New Yirtual Machine Wizard
rnb F Connect Virtual Hard Disk

Before You Begin
Specify Marme and Location
Specify Generation

Assign Memory

Configure Metwarking

Surmary

# wirtual machine reguires storage so that yvou can install an operating system, You can specify the

storage now or configure it laker by modifving the virtual maching’s properties.
() Create a virtual hard disk
|Jse this option to create a YHDY dynamically expanding virkual hard disk,
w52, whdx
CserstPubliciDocumentsiHyper-wWirtual Hard Disks',

127 | GB (Maximum: &4 TB)

(®) Use an existing virtual hard disk.

|Jse this option to attach an existing virtual hard disk, either WHD or YHDY Farmat,

[Tl Te N Llser s’ Publich DocumentsiHy per-W Virkual Hard Disks) || Browse, .,

() Akkach a virtual hard disk later

Idse this option ko skip this step now and atkach an existing virkual hard disk later,

< Previous Cancel

16. Select Use an existing virtual hard disk.
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17. Click Browse to specify the location of the existing virtual hard disk for the virtual machine to use.

FIGURE 19 Selecting Virtual Hard Disk

Organize ~

1M ylab

ﬁ Microsoft Managerne wscg-340.0.238vhd
40.0 GB

T |_L| <« Cit v users » public » Documents » hyper-v » Virtual hard disks

v & | | Search Virtual hard disks

2

B

-0 @

File name: [vscg-3.4.0.0.238.vhd

v |virtual hard disk files

V]
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18. Click Next. The Completing New Virtual Machine Wizard screen appears.

19.

FIGURE 20 Completing New Virtual Machine Wizard

Befare Wou Begin

Specify Mame and Location
Specify Generation

Assign Mermnory

Configure Networking

Connect Yirtual Hard Disk,

Summary

[ &.’ Completing the New Virtual Machine Wizard

¥ou hawve successfully completed the Mew Wirtual Machine wizard, ¥ou are about bo create the
fFollawing wirtual machine.

Mew Yirtual Machine Wizard -

Description:
Mame: w3Z
Generation:  Generation 1
Memory: 15000 MB
Mekwark: wa-brZ
Hard Disk:  CriusersipubliciDocumentsihyper-wivirtual hard diskstwscg-3.4.0,0,238 vhd (WHD, Fixe
< m >

To create the virkual machine and close the wizard, click Finish,

Finish | | Zancel

Review the settings that you can configure for the virtual machine. If you find any setting that need to be changed, click Previous until you

reach the screen where you can update the setting. Update the setting, and then click Next until the Completing New Virtual Machine

Wizard screen appears again.
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20. Click Finish to install the virtual machine. When Windows Server completes installing the virtual machine, the New Virtual Machine
Wizard disappears and the virtual machine you installed appears on the list of virtual machines on Hyper-V Manager.

FIGURE 21 The virtual machine you installed appears on the list of virtual machines on Hyper- V Manager

(== |

33 Hyper-¥ Manager

File  Action Miew Help

=

23 Hyper-Y Manager Actions
g vLaB Virtual Machines
53 SIN-BTWERUANHLI - -
g MNarne State CPU Usage Assigned Memory | Mew »

R aoff
Lep Irnpaort Virtual Machine..

< mn

Checkpoints
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Hyper- Settings..,

3

Wirtual 54N Manager..,

)N =]

Edit Disk...
Inspect Disk..,
) Stop Service

. Rernove Server
Refresh

Wi

=

Help

Wirtual Switch Manager..,
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21. Right-click the virtual machine you installed, and then click Start to power on the virtual machine.

FIGURE 22 Right-click the virtual machine, and then click Start

File  Action  View Help

| #

25 Hyper-¥ Manager
Ha vLap
Ii WIN-BTVERUANHLI

Virtual Machines

Marne

Connect..,

State

CPU Usage

Settings..

[ st

Checkpuoint

-

Move...
Export...
Rename..,

Delete...

Enable Replication...

Help

Assighed Mernory

|

<]

Checkpoints

The Virtual Machine Connection screen appears.
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| Actions

MNew
|ﬁ Hyper-\ Settings...

ﬁl Wirtual SAM Manager...
¢4 Edit Disk...
(EL Inspect Disk...
() Stop Service
75 Remave Server
3 FRefresh
Wiew
7]

Help

Les Import Virdual Machine..,

FT irtual Switch Manager...

| =F Crnnert..
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FIGURE 23 Virtual Machine Connection

=F] Hyper-¥ kanager = [ =] 2%
File  Action  View Help
o= 25 =
=5 Hyper- Manager Actions
43 vLaR Virtual Machines
35 WIN-BTVERUANHLI L5 &
88 ) Mame State CPU Usage Azsigned Memary | New »
] vaz Running 12% 15000 HBE [

§ I ott Wirtyal fachi
ik vSZ on WLAB - Virtual Machine Connection = [ = -

File Action Media Cliphoard  View Help

@O0 U i

punt: special device rdata-ng- rootfsi-state-sopt/ruckuswireless- wsg-sconf. cli g
ounting local filesystems: [ OK 1 »
Enabling local filesystem guotas: [ OK 1
Enabling ~etc/fstab swaps: [ 0K 1
Entering non-interactive startup
Btarting syslog-ng: [ OK 1 -
alling the system activity data collector (sadc):
Starting monitoring for UG uwgh@: 1 logical volume(s) in wolume group “vgBd"

0Kk 1

ipotables: Applying firewall rules: [ OK 1
iptables: Applying firewall rules: [ OK 1

< m

Status: Running
< T [ =0 EXpOf.,

22. Login to the virtual machine with your credentials.

You have now completed installing the vSZ on Windows Server Hyper-V.

This section describes how to install the vSZ on a KVM hypervisor.

The vSZ image for a kernel-based virtual machine (KVM) is distributed in QCOW?2 format.

1. Obtain the vSZ image in QCOW?2 format.
2. Copy the image to the KVM.

3. Open the terminal window.
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4. Make the image bin file executable by entering the following command: chmod +x {file name of the controller QCOW bin} See Figure for
an example.

FIGURE 24 Make the bin file executable

lun@weilun:~/Downloads — o X

File Edit View Search Terminal Help

[lun@weilun Downloads]s chmod +x vscg-5.2.0.0.653.qcow2.bin
[lun@weilun Downloads]s |

5. Extract the contents of the QCOW?2 bin file.

FIGURE 25 Extract the contents of the QCOW2 image

lun@weilun:~Downloads = o x

File Edit Wiew Search Termminal Help

[lun@weilun Downloads]$ ./vscg-5.2.0.0.653.qcow2.bin I
RUCKLS WIRELESS, INC.
Virtual SmartZone (v5Z) Software License

PLEASE READ THIS SOFTWARE LICENSE CAREFULLY. RUCKUS WIRELESS, INC. ("RU
CKUS")} IS WILLING TO LICENSE THE SOFTWARE TO YOU (“LICENSEE") ONLY ON THE CONDIT
ION THAT THE LICENSEE ACCEPTS ALL OF THE FOLLOWING TERMS AND CONDITIONS. IF A US
ER ACCEPTS THIS LICENSE, OR DOWNLOADS, USES OR INSTALLS THE SOFTWARE, AS AN EMPL
OYEE OF, OR AS AN AGENT OR CONTRACTOR FOR THE BENEFIT OF, A COMPANY, THAT COMPAN
¥ SHALL BE DEEMED THE LICENSEE AND THE USER REPRESENTS THAT IT HAS THE POWER AND
AUTHORITY TO ACCEPT THIS AGREEMENT ON BEHALF OF THE COMPANY. BY DOWNLOADING, IN
STALLING AND/OR USING THE SOFTWARE, LICENSEE ACKNOWLEDGES THAT IT HAS READ THIS
LICENSE AND AGREES TO BE BOUND BY ITS TERMS AND CONDITIONS. IF LICENSEE DOES NOT
AGREE TO THE TERMS AND CONDITIONS OF THIS LICENSE, RUCKUS IS UNWILLING TO LICEN
SE THE SOFTWARE. 1IN THAT EVENT, LICENSEE MAY NOT DOWNLOAD, USE OR INSTALL THE 5
OFTWARE AND SHALL BE GIVEN A FULL REFUND OF ANY LICENSE FEES ACTUALLY PAID FOR T
HE SOFTWARE.
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6. At the Accept this agreement? [yes/no] prompt, enter yes.

FIGURE 26 Accept the EULA terms

File Edit View Search Terminal Help

interpretation or meaning of this agreement. If any provision of this agreemen
t is held by an arbitrator or a court of competent jurisdiction to be contrary t
o law, then the remaining provisions of this agreement will remain in full force
and effect. MNo delay or omission by either party to exercise any right or powe
r it has under this agreement will be construed as a waiver of such right or pow
er. A waiver by either party of any breach by the other party will not be const
rued to be a waiver of any succeeding breach or any other covenant by the other
party. All waivers must be in writing and signed by the party waiving its right
5. This agreement may not be assigned by Licensee by operation of law or otherwi
se, without the prior written consent of Ruckus, which consent will not be unrea
sonably withheld. This agreement may be executed simultaneously in any number o
T counterparts, each of which will be deemed an original, but all of which toget
her constitute one and the same agreement. The parties agree that electronic si
gnatures are valid signatures for enforcement of this agreement. This agreement
constitutes the entire agreement between Ruckus and Licensee with respect to th
e subject matter hereof. This agreement supersedes all prior negotiations, agre
ements and undertakings between the parties with respect to such subject matter.
As a matter of clarity, the preceding two sentences do not affect either party
's obligations regarding confidential information under any other agreement betw
een the parties. No modification of this agreement will be effective unless con
tained in writing and signed by an authorized representative of each party. Not
withstanding applicable law, electronic communications will not be deemed signed
writings. Any additional orders for licenses hereunder shall be governed by th
e terms of this agreement. No term or condition contained in Licensee's purchas
e order or similar document will apply unless specifically agreed to by Ruckus i
n writing, even it Ruckus has accepted the order set forth in such purchase orde
r, and all such terms or conditions are otherwise hereby expressly rejected by R
uckus. In the event of a conflict between this agreement and any other applicabl
e agreement, this agreement shall govern.
Accept this agreement? [yes/no]:yes|]

The KVM continues to extract the contents of the image. When the extraction process is complete, the QCOW?2 file appears in the same
directory as the .bin file.

FIGURE 27 The QCOW?2 file appears in the same directory as the .bin file

luni@weilun:~/Downloads — o x

File Edit View Search Terminal Help

[lun@weilun Downloads]s s -al | grep vscg-5.2.0.0.653.gcow?

-MW-r--r-- 1 lun lun 3278766088 Dec 27 23:49 vscg-5.2.0.0.653.gcow2
~rwirwxr-x 1 lun lun 1576753888 Jan 2 17:30 vscg-5.2.0.0.653.gcow2.bin
[lun@weilun Downloads]$
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NOTE
If the “uudecode: command not found” error appears during the extraction process, install the “sharutils” package on the KVM,
and then try extracting the image again.

7. Resize the vSZ disk image, if necessary. By default, the vSZ disk size is 50GB. If you want to allocate more disk space to the vSZ, run the
gemu-img command. The complete syntax is as follows: gemu-img resize {file name of the controller QCOW bin} +size

Setting Up the vSZ

You can set up the vSZ using the Red Hat Virtual Machine Manager (also known as “virt-manager”). If you are installing the vSZ on a different
hypervisor or virtual machine monitor, the procedure may be slightly different. Refer to the hypervisor documentation for more information.

1. Start the Virtual Machine Manager by clicking Applications > System Tools > Virtual Machine Manager. Or double-click the Virtual Machine
Manager icon if it appears on the desktop. The Virtual Machine Manager interface appears.

FIGURE 28 The Virtual Machine Manager interface

Virtual Machine Manager - o »

File Edit View Help

E;J IE_I Open ¥ 0 -

2. InFile, click Create New VM. Or click the New VM icon. The New VM screen appears
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3. Configure the options on the New VM (Step 1 of 4) screen.
a) In Name, type a name that you want to assign to the virtual machine.

b) In Choose how you would like to install the operating system, click Import existing disk image.

FIGURE 29 Type a name and select how you want to install the operating system

Virtual Machine Manager - O x

File Edit View Help

E-J E Open = B

Name CPU usage

QEMU/KVM '
MNew VM x

m Create a new virtual machine

Connection: QEMU/EKVM I .

Choose how you would like to install the operating system

(_) Local install media (ISO image or CDROM) .
() Network Install (HTTP, FTP, or NFS)

() Network Boot (PXE)

() Import existing disk image |

Cancel Back Forward |

| N Nl W

4. Click Forward. The Locate Existing Storage dialog box appears.
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5. Browse to the location of the vSZ QCOW2 image, select the image file, and then click Open. The New VM (Step 2 of 4) screen reappears
and displays the storage path to the QCOW?2 image file that you selected.

FIGURE 30 Browse to the vSZ QCOW2 image

Cancel Mame | Q Cpen
it Home 4 f¥lun Downloads # I
[ Documents Name ~ Size Modified

) || ZFT9B2.BLT Obytes 17 Jan 2018

ZF7982.6l7 Obytes 17 Jan 201B
dd Music | wseg-5.2.0.0.653.qcow2.bin L6GE 1730
& Pictures E wscg-5.2.0.0.653.gcow 1 3.3GB Fri
L wseg-5.2.0.0.524.qcow2 159GE 5 MNov 2019
Ml Videos @ vscg-5.2.0.0.449 g0 18GB 22 Aug 2019
B thinclient_drives & | wscg-5.1.0.0.496.qeowd.bin L3GE 20 Mov 2018
wscg-5.1.0.0.496.qoow 2 5.4 GB 3 Oct 2019
+ Other Locations | wseg-5.0.0.0.675.qcowdbin 1L1GB 19 Sep 2018
wscg-5.0.0.0.675.qcow 3.2G8 2 Naov 2018
| wscg-3.5.1.0.296.qcow2 136 GB 22 Jun 2018
wmlinuz 43MB 12 Sep 2019
) wdp-6.0.0.99.189.qcow2 24GE 8 Nov 2019
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6. Inthe lower portion of the New VM (Step 2 of 4) screen, select the operating system type and version.
a) In OS type, select Linux.

b) In Version, select Generic 2.6.x kernel.

FIGURE 31 Select the operating system and version

Maw VM x

m Create a new virtual machine

Provide the existing storage path:

fhomeflun/Downloadsfvscg-5.2.0.0.653. qoowl Browse...

Choose an operating system type and version

05 type: | Linux -

Version: | CentOS 7.0 -

Cancel Back Farward

7. Click Forward. The New VM (Step 3 of 4) screen appears.
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8. Configure the memory and CPU settings of the virtual machine.
a) In Memory (RAM), set to memory (in MB) that you want to allocate to the vSZ.
b) In CPU, set the number of CPUs that you want to allocate to the vSZ.

FIGURE 32 Configure the memory and CPU settings

r ]

Virtual Machine Manager = o !
File Edit View Help

E-J E| Open = |

Name _CPU usage
MNew VM x

m Create a new virtual machine

Choose Memaory and CPU settings

Memory (RAM}): = 16384

+

Up to 65373 MiB available on the host

CPUs: | 4 +

Up to 12 available

Cancel Back Forward

vOP-for-vS7-H-203

laEamEEmEEE:
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9. Click Forward. The New VM (Step 4 of 4) screen appears and displays a summary of the settings you configured.

FIGURE 33 A summary of the settings you configured appears

Mew WM b

Create a new virtual machine

Ready to begin the installation
Mame: | centos?.0

05; Centds 7.0
Install: Import existing 05 image
Memory: 16384 MiB
CPUs: 4
Storage: -/Downlaadsivscg-5.2.0.0.653.qc0w 2

[w Customize configuration before install

F Metwork selection

Cancel Back Finish

10. Verify that the settings you configured on the previous screens are correct. If you need to make changes to any of the settings, click Back
until you reach the screen on which the setting appears, make the change, and then click Forward until you reach the New VM (Step 4 of
4) screen again.

11. Click Finish to install the vSZ on the virtual machine.
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12. After you complete installing the vSZ on the virtual machine, decide how many interfaces you want the vSZ to use. The vSZ supports
either a single interface or three interfaces. By default, a single interface exists after installation.

e |f you want the vSZ to use a single interface, you do not need to take action in this step. Continue to the next step.

e If you want the vSZ to use three interfaces, you must create the two additional interfaces before the initial bootup of the vSZ. Once
the vSZ has completed its initial bootup, you will no longer be able to change the number of interfaces.

If you want to add interfaces, you must do so before the initial bootup of the vSZ. After the initial bootup, you will no longer be able to

change the number of interfaces.

FIGURE 34 By default, a single interface exists

r

v5Z-H on QEMU/KVM

4 Begin Installation & Cancel Installation

M oyerview Virtual Network Interface
g:} CPUs Network source:  Bridge br0: Host device enp7s0 v
== Memory

Device model: | virtio

Boot Options

(= VirtlO Disk 1 MAC address: | 52:54:00:7d:c6:55

|L/I Tablet

@ Display Spice
Eif sound iche

e Console

t=> Channel gemu-ga
=2 Channel spice
B video QXL

m Controller USB 0
@ usB Redirector 1
@ usB Redirector 2

Add Hardware

13. Power on the virtual machine. The vSZ performs its initial bootup.

14. When the vSZ login prompt appears, enter admin.

Remove Cancel Apply

You have completed setting up the vSZ on a KVM hypervisor. You are now ready to start the vSZ Setup Wizard. See Using the Setup Wizard to Install

vSZ for more information.
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Installing the vSZ on an OpenStack Hypervisor

You have to install the vSZ on an OpenStack hypervisor.

Configuring System Settings
1. Login the system as a rootuser.
2. Stop and disable the Firewall since OpenStack uses iptables.

systemctl stop firewalld
systemctl disable firewalld

3. Stop and disable NetworkManager.

systemctl stop NetworkManager
systemctl disable NetworkManager
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58

4.

example: interface name is enp1s0

TYPE=Ethernet

PROXY_ METHOD=none

BROWSER ONLY=no

BOOTPROTO=static

DEFROUTE=no

IPV4 FAILURE FATAL=no
IPV6INIT=yes

IPV6_AUTOCONF=yes

IPV6 DEFROUTE=yes

IPV6 FAILURE FATAL=no
IPV6_ADDR GEN MODE=stable-privacy
NAME=enplsO
UUID=d320d308-fle6-46cc-a5db-68848e9ab5d6
DEVICE=enplsO0

ONBOOT=yes

IPADDR=172.17.21.242

PREFIX=23

GATEWAY=172.17.20.1

IPV6 PRIVACY=no

example: interface name is enp3s0

TYPE=Ethernet

PROXY METHOD=none
BROWSER_ONLY=no
BOOTPROTO=static
DEFROUTE=no
IPV4_FAILURE_FATALZHO
IPV6INIT=yes
IPV67AUTOCONF=DO
IPV6_DEFROUTE:yeS
IPV6_FAILURE_FATAL:no
IPV6 ADDR GEN MODE=stable-privacy
NAME=enp3s0
UUID=b0dd6767-3ef5-4d63-9cl2-aa3cc4771a3l
DEVICE=enp3s0

ONBOOT=yes
IPADDR=192.168.66.2
PREFIX=24
GATEWAY=192.168.66.1
IPV6ADDR=2001:66::2/64
IPV67DEFAULTGW=2001:66::1
IPV6_PRIVACY:no

example: interface name is enp6s0

TYPE=Ethernet

PROXY METHOD=none

BROWSER_ONLY=no

BOOTPROTO=static

DEFROUTE=yes

IPV4 FAILURE FATAL=no
IPV6INIT=yes

IPV6_ AUTOCONF=no
IPV6_DEFROUTE=yes

IPV6 FAILURE FATAL=no

IPV6 ADDR GEN MODE=stable-privacy
NAME=enp6s0
UUID=5d9762b5-2b43-47ce-83af-35c£741901cd
DEVICE=enp6s0

ONBOOT=yes

IPADDR=10.10.30.2

PREFIX=16

GATEWAY=10.10.0.1

DNS1=8.8.8.8
IPV6ADDR=2001:0030:2516:164::2/64

Assign static IP address to all the interfaces. Else, DHCP will cause network issue while deploying an instance.
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IPV6_ DEFAULTGW=2001:b030:2516:164::1
IPV67PRIVACY=DO

5. Update the system package.
yum -y update
6. Reboot the system using the CLI command.

Reboot

7. Verify if all the interfaces use the correct IP.

ip addr
ifconfig

8. Use the install net-tools package by command.

yum install net-tools

9. Change the hostname to the one that we use.

hostnamectl set-hostname "openstack.example.com"

10. Append hostname and IP mapping to /etc/hosts based on the network topology. The IP address could be any interface on the OpenStack
Sever, and ensure you use the same hostname used in the previous step.

vi /etc/hosts

127.0.0.1 localhost localhost.localdomain localhost4 localhost4.localdomainé
::1 localhost localhost.localdomain localhost6 localhost6.localdomainé
10.10.30.2 openstack.example.com

11. Add repositories to the system for installing the OpenStack (refer to https://www.rdoproject.org/).

yum install -y centos-release-openstack-rocky

12. Login the system as a root user using SSH, modify /etc/ssh/sshd_config.

vi /etc/ssh/sshd_config
PermitRootLogin yes <—unmark this line.
systemctl restart sshd

13. Install the Packstack package.

yum install -y openstack-packstack

Installing OpenStack
1. Generate the OpenStack answer file.

packstack --gen-answer-file=/root/answer.txt
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2. Editthe /root/answer. txt file, and modify the content based on your environment,

NOTE
Plan how you want to map the OVS interfaces (extnet), bridge interfaces(br-ex) and physical interfaces(enp1s0). You will need
these information while deploying a vSZ instace. In this case, extnet=br-ex=enp1s0

# Skip the provision of Demo project
CONFIG_PROVISION DEMO=n

# Change Admin Password - Used to Login to OpenStack Dashboard
CONFIG KEYSTONE ADMIN PW=XXX

# Config OpenStack Dashboard over SSL
CONFIG HORIZON SSL=y

# Map physical network bridge to the logical name. <Logical Name:Bridge Name>
CONFIG NEUTRON OVS BRIDGE MAPPINGS=extnet:br-ex,extnetl:br-exl,extnet2:br-ex2

# Create bridge for external connectivity. <Bridge Name: NW card name>
CONFIG_NEUTRON OVS BRIDGE IFACES=br-ex:enpls0,br-exl:enp3s0,br-ex2:enp6s0

# external-physnet="extnet"
CONFIG_NEUTRON OVS EXTERNAL PHYSNET=extnet,extnetl,extnet2

3. Run the Packstack installer with the answer . txt. It will take about 30-60 minutes to complete installation.

packstack --answer-file=/root/answer.txt

4.  Verify if the newly created bridge interfaces use the correct IP address; physical interface will not have IP address setting.
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5. Check the network script. If the scripts are not modified automatically, edit them properly, and then restart the network by using the
command systemctl restart network.

[root@localhost ~J#ifconfig

br-ex: flags=4163<UP,BROADCAST, RUNNING, MULTICAST> mtu 1500

inet 172.17.21.242 netmask 255.255.254.0 broadcast 172.17.21.255
inet6 fe80::7cfO:cfff:fe87:£54b prefixlen 64 scopeid 0x20<link>
ether 68:05:ca:20:92:be txqueuelen 1000 (Ethernet)

RX packets 8053 bytes 529150 (516.7 KiB)

RX errors 0 dropped 3370 overruns 0 frame O

TX packets 14 bytes 900 (900.0 B)

TX errors 0 dropped 0 overruns 0 carrier 0 collisions 0

br-exl: flags=4163<UP, BROADCAST, RUNNING,MULTICAST> mtu 1500
inet 192.168.66.2 netmask 255.255.255.0 broadcast 192.168.66.255
inet6 fe80::f£8db:3cff:fe23:4f48 prefixlen 64 scopeid 0x20<link>
ether 74:d4:35:51:e6:46 txqueuelen 1000 (Ethernet)
RX packets 0 bytes 0 (0.0 B)
RX errors 0 dropped O overruns 0 frame 0
TX packets 14 bytes 900 (900.0 B)
TX errors 0 dropped 0 overruns O carrier 0 collisions 0

br-ex2: flags=4163<UP, BROADCAST,RUNNING,MULTICAST> mtu 1500

inet 10.10.30.2 netmask 255.255.0.0 broadcast 10.10.255.255

inet6 fe80::788c:5cff:fefd:e347 prefixlen 64 scopeid 0x20<link>

inet6 2001:b030:2516:164:6a05:caff:fe20:9%9ec9 prefixlen 64 scopeid 0x0<global>
ether 68:05:ca:20:9e:c9 txqueuelen 1000 (Ethernet)

RX packets 26860 bytes 32501357 (30.9 MiB)

RX errors 0 dropped O overruns 0 frame 0

TX packets 17037 bytes 2002913 (1.9 MiB)

TX errors 0 dropped 0 overruns 0 carrier 0 collisions 0

enpls0: flags=4163<UP,BROADCAST, RUNNING, MULTICAST> mtu 1500
inet6 fe80::6a05:caff:fe20:92be prefixlen 64 scopeid 0x20<link>
ether 68:05:ca:20:92:be txqueuelen 1000 (Ethernet)

RX packets 11772 bytes 965550 (942.9 KiB)

RX errors 0 dropped 1732 overruns 0 frame O

TX packets 18 bytes 1498 (1.4 KiB)

TX errors 0 dropped 0 overruns 0 carrier 0 collisions 0
device interrupt 16 memory 0xf7ec0000-£7ee0000

enp3s0: flags=4163<UP,BROADCAST, RUNNING,MULTICAST> mtu 1500
inet6 fe80::76d4:35ff:fe51:e646 prefixlen 64 scopeid 0x20<link>
ether 74:d4:35:51:e6:46 txqueuelen 1000 (Ethernet)

RX packets 6734 bytes 430976 (420.8 KiB)

RX errors 0 dropped O overruns 0 frame 0

TX packets 246 bytes 21098 (20.6 KiB)

TX errors 0 dropped 0 overruns O carrier 0 collisions 0

enp6s0: flags=4163<UP,BROADCAST, RUNNING,MULTICAST> mtu 1500
inet6 fe80::6a05:caff:fe20:9ec9 prefixlen 64 scopeid 0x20<link>
ether 68:05:ca:20:9e:c9 txqueuelen 1000 (Ethernet)

RX packets 236349 bytes 306637429 (292.4 MiB)

RX errors 0 dropped O overruns 0 frame 0

TX packets 143142 bytes 12982731 (12.3 MiB)

TX errors 0 dropped 0 overruns O carrier 0 collisions 0
device interrupt 16 memory Oxf7cc0000-£7ce0000

lo: flags=73<UP, LOOPBACK, RUNNING> mtu 65536

inet 127.0.0.1 netmask 255.0.0.0

inet6 ::1 prefixlen 128 scopeid 0xl10<host>

loop txqueuelen 1000 (Local Loopback)

RX packets 3188295 bytes 411123149 (392.0 MiB)

RX errors 0 dropped 0 overruns 0 frame 0

TX packets 3188295 bytes 411123149 (392.0 MiB)

TX errors 0 dropped 0 overruns 0 carrier 0 collisions 0

[root@localhost ~]# cat /etc/sysconfig/network-scripts/ifcfg-enp1s0
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DEVICE=enplsO
NAME=enpls0
DEVICETYPE=ovs
TYPE=OVSPort

OVS BRIDGE=br-ex
ONBOOT=yes
BOOTPROTO=none

[root@localhost ~]# cat /etc/sysconfig/network-scripts/ifcfg-enp3s0

DEVICE=enp3s0
NAME=enp3s0
DEVICETYPE=ovs
TYPE=OVSPort
OVS_BRIDGE=br-exl
ONBOOT=yes
BOOTPROTO=none

[root@localhost ~]# cat /etc/sysconfig/network-scripts/ifcfg-enp6s0

DEVICE=enp6s0
NAME=enp6s0
DEVICETYPE=ovs
TYPE=OVSPort

OVS BRIDGE=br-ex2
ONBOOT=yes
BOOTPROTO=none

[root@localhost ~]# cat /etc/sysconfig/network-scripts/ifcfg-br-ex

PROXY METHOD=none

BROWSER_ONLY=no

DEFROUTE=no
UUID=d320d308-fle6-46cc-a5db-68848e9%ab5d6
ONBOOT=yes

IPADDR=172.17.21.242

PREFIX=23

GATEWAY=172.17.20.1

DEVICE=br-ex

NAME=br-ex

DEVICETYPE=o0vs

OVSBOOTPROTO=static

TYPE=OVSBridge

OVS_EXTRA="set bridge br-ex fail mode=standalone"

[root@localhost ~]# cat /etc/sysconfig/network-scripts/ifcfg-br-ex1

PROXY METHOD=none

BROWSER ONLY=no

DEFROUTE=no
UUID=b0dd6767-3e£5-4d63-9cl2-aa3ccd4771a3l
ONBOOT=yes

IPADDR=192.168.66.2

PREFIX=24

GATEWAY=192.168.66.1

DEVICE=br-exl

NAME=br-ex1l

DEVICETYPE=o0ovs

OVSBOOTPROTO=static

TYPE=0OVSBridge

OVS_EXTRA="set bridge br-exl fail mode=standalone"

[root@localhost ~]# cat /etc/sysconfig/network-scripts/ifcfg-br-ex2

PROXY METHOD=none

BROWSER_ONLY=no

DEFROUTE=yes
UUID=5d9762b5-2b43-47ce-83af-35cf741901cd
ONBOOT=yes

IPADDR=10.10.30.2
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PREFIX=16

GATEWAY=10.10.0.1

DEVICE=br-ex2

NAME=br-ex2

DEVICETYPE=o0ovs

OVSBOOTPROTO=static

TYPE=OVSBridge

OVS_EXTRA="set bridge br-ex2 fail mode=standalone"

6. Check the OpenStack package version.
[root@localhost ~]# source ./keystonerc_admin

[root@openstackl ~(keystone_admin)]# nova-manage --version
17.0.5

7. Check https://releases.openstack.org/ and make sure you have installed the correct version with the supported service projects.

FIGURE 35 OpenStack Version
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Accessing the OpenStack Dashboard

1. Open https://IP_Address/dashboard or https://fqdn/dashboard if the fgdn can be resolved.

NOTE
Use the Firefox browser to access the link.

FIGURE 36 OpenStack Login
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Log in

User Hame

Password
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2. Login OpenStack using the Administrator User Name and the Password.

NOTE
If you forget the password, you can get it from the file /root/keystore admin.
[root@openstack ~]# cat keystonerc_admin
unset OS_SERVICE TOKEN
export OS USERNAME=admin
export OS_PASSWORD='admin'
export OS_AUTH URL=http://10.10.30.2:5000/v3
export PS1='[\u@\h \W(keystone admin)]\$ '
export OS_PROJECT_NAME=admin
export OS_USER _DOMAIN NAME=Default

export OS_PROJECT_DOMAIN NAME=Default
export OS IDENTITY API VERSION=3

Creating Global Items

Creating a New User
1.  From the OpenStack homepage, click Identity > Users.

The Users page appears as shown in the following image.

FIGURE 37 OpenStack Home Page
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2. Click Create User.

The Create User page appears as shown in the following image.

FIGURE 38 Creating a User
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3. Enter the User Name, Password, Confirm Password and click Create User.

You have created a new user.
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Creating a New Project

1.  From the OpenStack homepage, click Identity > Projects.

The Projects page appear as shown in the following image.

FIGURE 39 OpenStack Project Page

TIopenstack. = sonin~

Prajact
Manbty ¢
Admin >
oty . Projects

Groups

Foles 0 Hame
O aémin
o
O semoce

Diselaving 3 itams

RUCKUS Virtual SmartZone Getting Started Guide

Part Number: 800-72269-001 Rev G

Displaying 3 itame

Description

admin tanant

Tenant for the openstack ssnices

Project D

A1abET2098STNIEIRE 100 1dIEFHGCT

GoaT1db0EEI acibheEsa 13 TR

TISCUZEMAC 1ch1ecSIEREITE M

Installing the vSZ on a Hypervisor

Installing the vSZ on an OpenStack Hypervisor

Pruoject Mams ==

& aomin *

Fitar

Diomain Hame Enabled Actions
Yoz Warage Members | =
Yoz Warage Members | =
ez Manage Memibers -

67



Installing the vSZ on a Hypervisor
Installing the vSZ on an OpenStack Hypervisor

2. Click Create Project.

The Create Project page appear as shown in the following image.

FIGURE 40 Creating a Project
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Domain Name
=

Name
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3. From the Project Information tab, enter the Name for the project.
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4, Select the Project Members tab.

The Edit Project page appear as shown in the following image.
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a
5. From the list of All Users, click the add . button to select the required user.

The selected users are moved to the Project Members list.

6. From the drop-down select the rights to be assigned to each user.

7. Select the Quotas tab and assign the required resource pool for the project.

8. Click Create Project.

You have created a new project.
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Creating an External Network
1. From the OpenStack homepage, click Admin > Network > Networks.

The Networks page appears as shown in the following image.

FIGURE 41 Networks Page
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2. Click Create Networks.

The Create Networks page appears as shown in the following image.

FIGURE 42 Network tab page
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3. Update the following information:

e  Name: Enter the interface name.
®  Project: From the drop-down menu, first select admin and then select other projects.
e  Provider Network Type: From the drop-down menu select Flat.
o  Physical Network: Enter the OVS physical interface name.
o  Select the following check boxes :
a. Enable Admin State
b. Shared
c. External Network
d. Create Subnet
4.  Click Next.

The Subnet page appear as shown in the following image.

FIGURE 43 Subnet tab page
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5. Update the following information:

e  Subnet Name: Enter the subnet name.
o  Network Address: Enter the static IP of your OVS bridge.
e |P Version: Select the IP Version
e  Gateway IP: Enter the gateway IP of this OVS bridge.
6. Click Next.

The Subnet Details tab page appear as shown in the following image.

FIGURE 44 Subnet Details tab page
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Specify additional attributes for the subnet.
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7. Select the Enable DHCP check box.

8. For Allocation Pools, enter the DHCP pool range. Separate the range with a comma.

9. For DNS Name Servers, enter the DNS server address, one address per line.

10. Click Create.

NOTE

Repeat the procedure until you create an external interface for Control, Cluster and Management interface.

Creating Flavors

1. From the OpenStack homepage, click Admin > Compute > Flavors.

The Flavors page appears.

FIGURE 45 Flavors Page
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2. Click Create Flavor.

The Create Flavor page appears.

FIGURE 46 Flavor Settings page
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3. Enter a Name for the flavor you create.
4.  Assign the hardware resource that you are going to deploy.

5. Click Create Flavor.
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Creating an Image
1. From the OpenStack homepage, click Admin > Compute > Images.

The Images page appears.

FIGURE 47 Images Page
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2. Click Create Image.

The Create Image page appears.

FIGURE 48 Image Settings page
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3. Image Name: Enter a name.
4. Click Browse and select the vSZ gcow? file

5. Format: Select QCOW2-QEMU Emulator.
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6. Click Create Image.

NOTE
Logout openstack.

Creating Project Items

Creating Security Groups

1. Login OpenStack with the user credential created in Creating a New User on page 65.

2. From the homepage, click Project > Network > Security Groups.

The Security Groups page is displayed.

FIGURE 49 Security Group Page
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3. Click Create Security Group.

The Create Security Group page is displayed.

FIGURE 50 Creating a Security Group
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Description to network interfaces of a VM. After the security group is

created, you can add rules to the security group.

Cancel Create Security Group

4. Enter a Name for the security group and click Create Security Group.

The new group is listed in the Security Groups page.

5. Select the group from the list and click Manage Rules.

The Manage Security Group Rules page is displayed.

FIGURE 51 Managing Rules
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Project / Network / Security Groups / Manage S

Compute 7, Manage Security Group Rules: vsz_allow_all (d8a49c2e-
Volumes , b3b3-42e3-8fe3-20ef2bcef896)

Hetwork v

+ Add Rule

Network Topology

Displaying 2 items
Networks

O Direction Ether Type IP Protocol Port Range Remote IP Prefix Remote Security Group Actions
Routers
O Egess 1P Any Any 00,000 E Delete Rule
Security Groups
Floating IPs D Egress 24 Any Any 7] - Delete Rule

Trunks Displaying 2 items
Objact Store »

Identity >
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Click Add Rule.

The Add Rule page is displayed.

FIGURE 52 Adding Rules

Add Rule

Rule *
ALL ICMP . Description:
Rules define which traffic is allowed to instances assigned
Direction to the security group. A security group rule consists of
three main parts:
Ingress -

Rule: You can specify the desired rule template or use
Remote * @ custom rules, the options are Custom TCP Rule, Custom
UDP Rule, or Custom ICMP Rule.

Open Port/Port Range: For TCP and UDP rules you
may choose to open either a single port or a range of
CIDR @ ports. Selecting the "Port Range" option will provide you
0.0.0.0/0 with space to provide both the starting and ending ports
for the range. For ICMP rules you instead specify an
ICMP type and code in the spaces provided.

CIDR -

Remote: You must specify the source of the traffic to be
allowed via this rule. You may do so either in the form of
an IP address block (CIDR) or via a source group
(Secunty Group). Selecting a securty group as the
source will allow any other instance in that security group
access to any other instance via this rule.

Cancel Add

Rule: Select the rule for this security group.

Direction: Select the traffic direction.

NOTE
Refer the Administrator Guide for port configuration.

RUCKUS Virtual SmartZone Getting Started Guide
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9. Click Add, the system takes a few seconds to complete the action..

The new rules are listed in the Manage Security Group Rules page .

FIGURE 53 New Rules

fEopenstack. st~ atestv
Project v
Project / Network / Security Groups / Manage Security Group Rul
API Access
Computs > Manage Security Group Rules: test (d3677028-9deb5-40f2-8a4a-aea636b87b0a)
Volumes >
. . +asrae | [T

Displaying & items
Network Topology
O Direction Ether Type IP Protocol Port Range Remote IP Prefix Remote Security Group Actions
Networks

O Egess 1Pvé Any Any 0 = Delete Rule
Routers
Security Groups O Egess 1Pv4 Any Any 0.0.0.0/0 - Delete Rule
Floating IPs
O Ingress 1Pvd ICMP Any 0.0.0.0/0 - Delete Rule
Object Store >
O Ingress 1Pv4 TCcP 1- 66635 0.0.0.0/0 - Delete Rule
O Ingress 1Pvd ubpP 1-65535 0.0.0.0/0 - Delete Rule

Displaying & items

Identity >

Creating Key Pairs
1. From the homepage, click Project > Compute > Key Pairs.

The Key Pairs page is displayed.

FIGURE 54 Key Pairs Page

-
f3openstack. =esi~ atestw
Project v

Project / Compute / Key Pairs
AP| Access

Compits . Key Pairs

Overview
Images Key Pair Name Fingerprint Actions
Notomsto diply.
Volumes >
Network >
Object Store >
Identity >
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2. Click Create Key Pairs.

The Create Key Pair page is displayed.

FIGURE 55 Creating Key Pairs

Create Key Pair

Key Pair Name *

ruckus-project-key

X Cancel

3. Enter the Key Pair Name and click Create Key Pair.

The key . pem file download window should appear automatically.

FIGURE 56 Key.pem File Download

Key Pairs are how you login to your instance after it is launched. Choose a
key pair name you will recognize. Names may only include alphanumeric
characters, spaces, or dashes.

+ Create Key Pair

EAEIT: ruckus-project-key.pem

EEATERRE:

ruckus-project-key.pem I:\\‘,

e

1&3%188Y: Text Document (1.6 KB)

| ruckus-project-key.pem l

1 blob:
Firefox BEZZANAIREIRREHETE 7

() BERYAR (0): | EmEditor (FEEE)

o ETFEE (9

[ S tEAEREE B EhR A LERRIR 5 - (A)

L

BiH

4. Save the file to the Linux PC and change permission using command chmod 600 test.pem.

It is used to establish ssh vSZ connection with floating IP address. Other terminal tools also can use this key file to establish ssh connection

with vSZ.
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Deploying three-interface vSZ without built-in SNAT

Launching an Instance for three-interface vSZ

NOTE
Login OpenStack with user account that we just created.

1. From the homepage, click Project > Compute > Instances.

The Instances page is displayed.

FIGURE 57 Instances Page

-
T:openstack. mest-
Project v
Project / Compute / Instances
APl Access

Compute . Instances

Overview

Instances

Images Instance Name Image Name 1P Address Flavor Key Pair Status Availability Zone
Key Pairs Mo items to display.
Volumes >
Network >
Object Store >
Identity >

RUCKUS Virtual SmartZone Getting Started Guide
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Instance ID =+

Power State

Time since created

& test ~

Filter & Launch Instance

Actions
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2. Click Launch Instance.

The Launch Instance page is displayed.

FIGURE 58 Launch Instance Page

Launch Instance

Detail Please provide the initial hostname for the instance, the availability zone where it will be deployed, and the instance 9
etails o ) .
count. Increase the Count to create multiple instances with the same settings.

Source * Instance Name ™ Total Instances
( {10 Max)
| vSZ_node
Flavor * . |
Description 10%
Metworks *
MNetwork Ports
Availability Zone W 0 Current Usage
1 Added
Security Groups nova E| 9 Remaining
Key Pair Count ™
1 Y
Configuration &
Server Groups
Scheduler Hints
Metadata
X Cancel < Back Mext » & Launch Instance
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3. From the Details, enter the Instance Name and click Next.

The Source tab is displayed.

FIGURE 59 Source Tab Page

Launch Instance

Instance source is the template used to create an instance. You can use an image, a snapshot of an instance 9
(image snapshot), a volume or a volume snapshot (if enabled). You can also choose to use persistent storage by

. creating a new volume.
Source
Select Boot Source Create New Volume

Flavor * Image E| Yes m2

Details

Metworks *

Allocated
Network Ports Name Updated Size Type Visibility
Security Groups Select an item from Available items below
Key Pair w Available Select one
Configuration Q x
Server Groups Name Updated Size Type Visibility
Scheduler Hints > 362055 TI27/18 10:54 AM 246 GB qoow2 Public ‘Po
Metadata > 362052 7/20/18 5:02 PM 241GB qoow?2 Public +
x Cancel < Back Mext » & Launch Instance

+
4.  From the Available list, click Move to move the image to the Allocated list.

5. For Create New Volume, select No.
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6. Click Next.

The Flavor tab is displayed.

FIGURE 60 Flavor Tab Page

Launch Instance

Details

Source

Flavor

Networks *
Network Ports
Security Groups
Key Pair
Configuration
Server Groups
Scheduler Hints

Metadata

x Cancel

Flavors manage the sizing for the compute, memory and storage capacity of the

instance.

Allocated

Name

w Available

VCPUS

RAM

Select an ifem from Available items below

Total
Disk

Q | Click here for filters or full text search.

Name

> mini

? small

v5Z_mini
mum

? medium

> V&7

VCPUS

2

RAM

2GB

38 GB

13 GB

16 GB

18 GB

Total
Disk

50 GB

50 GB

150 GB

100 GB

150 GB

Root Ephemeral )

Disk Disk Public
Select one

®

Root Ephemeral a

Disk  Disk Public

0GB 0GB Yes 4

5 GB 0GB Yes 4

150 GB 0GB Yes 4

100GB 0GB Yes 4

150 GB 0GB Yes +

< Back Next »

7. From the Available list, click Move

86

to move the resource plan to the Allocated list.
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8. Click Next.

The Networks tab is displayed.

FIGURE 61 Networks Tab Page

Launch Instance

Details

Source

Flavor

MNetwork Ports
Security Groups
Key Pair
Configuration
Server Groups
Scheduler Hints

Metadata

X Cancel

9. From the Available list, click Move

Installing the vSZ on a Hypervisor

Metworks provide the communication channels for instances in the cloud.

Shared

Installing the vSZ on an OpenStack Hypervisor

2]

Select networks from those listed below.

Select an item from Available items below

w Allocated
Network Subnets Associated

w Available

Q,

Network Subnets Associated

> cluster cluster

?» control control

> mgmt mgmt

to move the network interfaces to the Allocated list.

Interfaces must be selected in the following order:

a. Control interface
b. Cluster interface
c. Management interface

10. Click Next.

The Network Ports tab is displayed.

RUCKUS Virtual SmartZone Getting Started Guide
Part Number: 800-72269-001 Rev G

Shared

Yes

Admin State Status

Select at least one network

x
Admin State Status
Up Active Qe
Up Active ‘b?
Up Active ‘I'o
< Back ‘ Mext » ‘ ‘
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11. Click Next.

The Security Groups tab is displayed.

FIGURE 62 Security Groups Tab Page

Launch Instance

Select the security groups to launch the instance in.
Details v areip 9
w Allocated
Source Name Description
Flavor > default Default security group e"'
MNetworks
w Available

Select one or more
MNetwork Ports
Q x

Security Groups
Name Description

Key Pair o
> vsz_allow_all +

Configuration {D
Server Groups
Scheduler Hints

Metadata

x Cancel «Back | Next » ‘ & | aunch Instance

*
12. From the Available list, click Move to move the rule to the Allocated list.

o
13. From the Allocated list, click the Remove to delete the default rule.

RUCKUS Virtual SmartZone Getting Started Guide
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14. Click Next.

The Key Pair tab is displayed.

FIGURE 63 Key Pair Tab Page

Launch Instance

Details

Source

Flavor

Networks
Metwork Ports
Security Groups
Configuration
Server Groups
Scheduler Hints

Metadata

x Cancel

15. From the Available list, click Move

RUCKUS Virtual SmartZone Getting Started Guide
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A key pair allows you to SSH into your newly created instance. You may select an existing key pair, import a key 0
pair, or generate a new key pair.

+ Create Key Pair

Allocated
Displaying 1 item

Name

> ruckus-project-key

Displaying 1 item

v Available

Q
Displaying 0 items

Name

Displaying 0 items

& Import Key Pair

Fingerprint

00:62:d9:4b: 1c:e0:6a:e9:cf.0f.60:31:29:89:42:77

No items to display.

N

Select one

< Back l Next » | & Launch Instance

to move the key pair to the Allocated list. If there is only one key pair, the system will
automatically move it to the Allocated list.
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16. Click Launch Instance to configure.

The system will take a few minutes to complete the process. Once it is done, you can see the Power State change to Running.

FIGURE 64 Instances Page

TS openstack. =z~

Project v
Project / Compute / Instances
API Access
. Instances
Overview
Images Displaying 1 item
Key Pairs O Instance Name Image Name
Volumes >
Network >
o 74 362055
Object Store >
Identity >

Displaying 1 item

Deploying One-interface vSZ with built-in SNAT

Creating an Internal Network

NOTE

IP Address

control
10.10.30.128
cluster
192.168.66.122
mgmt
172.17.21.237

Flavor

¥SZ_resource_plan

Login OpenStack with user account that we just created.

1. From the homepage, click Project > Network > Networks.

The Networks page is displayed.

90

Key Pair

ruckus-project-key

Status

Active

Instance ID =+

Availability Zone

Task

None

Fiter | & Launch Instance | vore Actions

Power State Time since created Actions

Running 9 minutes Greate Snapshot =
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2. Click Create Network.

The Create Network page is displayed.

FIGURE 65 Creating an Internal Network

r

Create Network

Metwork Subnet Subnet Details

Network Name

| lnternal_Management |

# Enable Admin State @

 Create Subnet

Availability Zone Hints @

nova

3. Enter the Network Name and click Next.

The Subnet tab is displayed.

4.  Enter the Subnet Name.

5.  Enter the Network Address for the internal network and click Next.
The Subnet Details tab is displayed.

6. In DNS Name Server: enter the DNS address.

RUCKUS Virtual SmartZone Getting Started Guide
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Create a new network. In addition, a subnet associated
with the network can be created in the following steps of
this wizard.

[

Cancel « Back
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7. Click Create.

The system will take few seconds to complete the action.

FIGURE 66 Internal Network

2openstack. =z~
Project -
Project / Network / Networks
APl Access
Compte > Networks
Volumes >
Netwark v

Network Topology  DisPlaying 4 tems

s O Name Subnets Associated

Routers o internal_mgmt_subnet 10.199.3.0/24
Security Groups O cluster cluster 192.168.66.0/24
Floating IPs O  control «control 10.10.0.0/16
Trunks o mgmt mgmt 172.17.20 0/23
Object Stors > Displaying 4 items
Identity >

Creating Router Settings
1. From the homepage, click Project > Network > Routers.

The Routers page is displayed.

FIGURE 67 Routers Page

fEopenstack. miest~
Project v
Project / Network / Routers
API Access
Compute » Routers
Volumes >
Network v
Network Topology Name Status External Network
Networks
Security Groups
Floating IPs
Object Store >
Identity >
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Shared External
No No

Yes Yes

Yes Yes

Yes Yes

No items to display.

Name =+

Status

Active

Active

Active

Active

Admin State

Admin State

uP

up

uP

uP

Router Name =+

a =
Filter 4 Create Network
Availability Zones Actions
nova EditNetwork | ~
nova
nova
nova
&testw

Fiter |+ Create Router

Actions
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2. Click Create Router.

The Create Router page is displayed.

FIGURE 68 Create Router Page

Installing the vSZ on a Hypervisor
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Create Router

Router Name

R_mgmt

& Enable Admin State
External Network

mgmt

Availability Zone Hints @

nova

Description:

Creates a router with specified parameters.

Cancel Create Router

3. Router Name: Enter the router name.

4. External Network: Select the external network which must be the NAT interface.

RUCKUS Virtual SmartZone Getting Started Guide
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Click Create Router.

The newly created router is listed in the Routers page.

FIGURE 69 New Router in the Routers Page

fsopenstack. =wz-

Project ~
Project / Network / Routers
AP| Access
Compute » Routers
Volumes >
Network v

Network Topology Displaying 1 item

. O Name Status External Network Admin State
Networks

o e fee o -

Security Groups Displaying 1 item
Floating IPs
Trunks
Object Store >

dentity >

Select the router and click the Interfaces tab.

The Interfaces tab page is displayed.

FIGURE 70 Interface Tab Page

tsopenstack. =wz-

Project v
Project / Network / Routers / R_mgmt
APl Access
Computs > R_mgmt
Volumes >
Overview Interfacgs Static Routes
Network v &

Network Topology
Networks Name Fixed IPs Status Type
No tems o displey
Security Groups
Floating IPs
Trunks
Object Store >

Identity >

Router Name = » Filer = Create Router

Admin State

Availability Zones Actions

nova Clear Gateway [

Clear Gateway [Rd

# Add Interface

Actions
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7. Click Add Interface.

The Add Interface page is displayed.

FIGURE 71 Add Interface Page

Add Interface

Subnet *

Internal_Management: 10.199.3.0/24 (internal_... = Descrlptlun:

You can connect a specified subnet to the router.
IP Address (optional) @ If you don't specify an IP address here, the gateway's

IP address of the selected subnet will be used as the
IP address of the newly created interface of the router.
If the gateway's IP address is in use, you must use a
different address which belongs to the selected subnet.

8. Subnet: Select the interface that you created.

9.  Click Submit.

10. Click Project > Network > Network Topology.

RUCKUS Virtual SmartZone Getting Started Guide
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11. Click Normal mode and ensure that the router is created correctly.

FIGURE 72 Network Topology

Project ~
Project / Network / MNetwork Topology

APl Access

Compute > Network Topology

Volumes >
Network v
Topology Graph
Network Topology
m H
Networks I Small | 28 Normal
Routers

Security Groups

Floating IPs
Trunks
Object Store > 6
Identity >

juawabeuep |eulaju)

DETUOT LV LY
YEIOEBEL DL
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Allocating Floating IPs

1.  From the homepage, click Project > Network > Floating IPs.

The Floating IPs page is displayed.
FIGURE 73 Floating IPs Page

Project -
Project / Network / Floating IPs

API Access
Compute » Floating IPs
Volumes >

Network v

Installing the vSZ on a Hypervisor
Installing the vSZ on an OpenStack Hypervisor

% Allocate IP To Project

Network Topology IP Address Mapped Fixed IP Address Pool Status Actions
Networks No items to display.
Object Store >
Identity >
2. Click Allocate IP to Project.
The Allocate Floating IP page is displayed.
FIGURE 74 Allocate Floating IP Page
Allocate Floating IP
Pool *
gt Description:
Allocate a floating IP from a given floating IP pool.
Description

3. From the Pool, select the external interface.

RUCKUS Virtual SmartZone Getting Started Guide
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Project Quotas

Floating IP

Cancel Allocate IP
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4. Click Allocate IP.

The system takes a few seconds to allocate the IP.

FIGURE 75 Allocated Floating IP

openstack. =z L.
Project v
Project / Network / Floating IPs
APl Access
Compute > Floating IPs
Volumes >
Network v Floating IP Address =+ Filter % Allocate IP To Project
Network Topalogy Displaying 1 item
Networks 0O  IP Address Description Mapped Fixed IP Address Pool Status Actions
Routers o 1721721233 B mgmt Down Associate |~
Security Groups Displaying 1 item
.
Trunks
Object Store >
Identity >
Launching an Instance for One-interface vSZ
NOTE
Login OpenStack with user account that we just created.
1. From the homepage, click Project > Compute > Instances.
The Instances page is displayed.
FIGURE 76 Instances Page
R openstack. meste ateste
Project v
Project / Compute / Instances
APl Access
Compute . Instances
Ovenview
Images Instance Name Image Name IP Address Flavor Key Pair Status Availability Zone Task Power State Time since created Actions
Key Pairs No items to display.
Volumes >
Network >
Object Store >
Identity >
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2. Click Launch Instance.

The Launch Instance page is displayed.

FIGURE 77 Launch Instance Page

Launch Instance

Source ¥

Flavor *
Metworks *
Network Ports
Security Groups
Key Pair
Configuration
Server Groups
Scheduler Hints

Metadata

x Cancel

Installing the vSZ on a Hypervisor

Installing the vSZ on an OpenStack Hypervisor

Please provide the initial hostname for the instance, the availability zene where it will be deployed, and the instance 9
count. Increase the Count to create multiple instances with the same settings.

Instance Name *

Total Instances

( : (10 Max)
| vsz_tint
Description 20%

Availability Zone

nova

Count®

1

B 1 Current Usage
1 Added

E| 8 Remaining

Gl

< Back MNext » & Launch Instance

RUCKUS Virtual SmartZone Getting Started Guide
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3. From the Details, enter the Instance Name and click Next.

The Source tab is displayed.

FIGURE 78 Source Tab Page

Launch Instance

Instance source is the template used to create an instance. You can use an image, a snapshot of an instance 9
(image snapshot), a volume or a volume snapshot (if enabled). You can also choose to use persistent storage by

. creating a new volume.
Source
Select Boot Source Create New Volume

Flavor * Image E| Yes m2

Details

Metworks *

Allocated
Network Ports Name Updated Size Type Visibility
Security Groups Select an item from Available items below
Key Pair w Available Select one
Configuration Q x
Server Groups Name Updated Size Type Visibility
Scheduler Hints > 362055 TI27/18 10:54 AM 246 GB qoow2 Public ‘Po
Metadata > 362052 7/20/18 5:02 PM 241GB qoow?2 Public +
x Cancel < Back Mext » & Launch Instance

+
4.  From the Available list, click Move to move the image to the Allocated list.

5. For Create New Volume, select No.

RUCKUS Virtual SmartZone Getting Started Guide
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6. Click Next.

The Flavor tab is displayed.

FIGURE 79 Flavor Tab Page
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Launch Instance

Details

Source

Flavor

Networks *
Network Ports
Security Groups
Key Pair
Configuration
Server Groups
Scheduler Hints

Metadata

x Cancel

Flavors manage the sizing for the compute, memory and storage capacity of the

instance.

Allocated

Name

w Available

VCPUS

RAM

Select an ifem from Available items below

Total
Disk

Q | Click here for filters or full text search.

Name

> mini

? small

v5Z_mini
mum

? medium

> V&7

VCPUS

2

RAM

2GB

38 GB

13 GB

16 GB

18 GB

Total
Disk

50 GB

50 GB

150 GB

100 GB

150 GB

Root Ephemeral

Disk Disk

Root Ephemeral

Disk Disk

50GB 0GB

50GB 0GB

150GB 0GB

100GB 0GB

150 GB 0GB

< Back Next »

Public
Select one
x

Public

Yes +
Yes +
Yes +
Yes +
Yes +

7. From the Available list, click Move

RUCKUS Virtual SmartZone Getting Started Guide
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8. Click Next.

The Networks tab is displayed.

FIGURE 80 Networks Tab Page

Launch Instance

. MNetworks provide the communication channels for instances in the cloud. 9
Details
Vv Allocated Select networks from those listed below.
Source
Network Subnets Associated Shared Admin State Status
Flavor

Select an item from Available ifems below

w Avallable

Metwork Ports

Select at least one network

Q x

Security Groups
Network Subnets Associated Shared Admin State Status

Key Pair

2> Internal_Management internal_mgmt_subnet Mo Up Active + |
Configuration

> cluster cluster Yes Up Active +
Server Groups

2 control cantrol Yes Up Active +
Scheduler Hints

> mgmt mgmt Yes Up Active +
Metadata
® Cancel < Back Mext » & Launch Instance

*
9. From the Available list, click Move to move the network interfaces to the Allocated list.

10. Click Next.

The Network Ports tab is displayed.

RUCKUS Virtual SmartZone Getting Started Guide
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11. Click Next.

The Security Groups tab is displayed.

FIGURE 81 Security Groups Tab Page

Launch Instance

Select the security groups to launch the instance in.
Details v areip 9
w Allocated
Source Name Description
Flavor > default Default security group e"'
MNetworks
w Available

Select one or more
MNetwork Ports
Q x

Security Groups
Name Description

Key Pair o
> vsz_allow_all +

Configuration {D
Server Groups
Scheduler Hints

Metadata

x Cancel «Back | Next » ‘ & | aunch Instance

*
12. From the Available list, click Move to move the rule to the Allocated list.

o
13. From the Allocated list, click the Remove to delete the default rule.
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14. Click Next.

The Key Pair tab is displayed.

FIGURE 82 Key Pair Tab Page

Launch Instance

Details
Source

Flavor
Networks
Network Ports

Secunty Groups

Configuration

Server Groups

Scheduler Hints

Metadata

x Cancel

15. From the Available list, click Move

104

A key pair allows you to SSH into your newly created instance. You may select an existing key pair, import a key e

pair, or generate a new key pair.

<+ Create Key Pair

Allocated
Displaying 1 item

Name

¥ ruckus-project-key

Displaying 1 item

w Available

Q
Displaying 0 items

Name

Displaying 0 items

& Import Key Pair

Fingerprint

00:62:d9:4b:1c:e0:6a:e9:cf.0f.60:31:29:89:42:77

Fingerprint

No items to display.

N

Select one

< Back l Next » | & Launch Instance

to move the key pair to the Allocated list. If there is only one key pair, the system will
automatically move it to the Allocated list.
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16. Click Launch Instance to configure.

The system will take a few minutes to complete the process. Once it is done, you can see the Power State change to Running.

FIGURE 83 Instances Page

=
T:openstack. =z~ . .
Project ~
Project / Compute / Instances
APl Access
Compute . Instances
Instance ID = = Fiter | & Launch Instance More Actions =
Images Displaying 2 items
Key Pairs O Instance Name Image Name IP Address Flavor Key Pair Status Availability Zone Task Power State Time since created Actions
Volumes > o vSZ_tinf 362055 1019937 vSZ_resource_plan ruckus-project-key Active nova None Running 0 minutes Create Snapshot  ~
Network >
control
Object Store > 10.10.30.128
dentity N o vz 362055 cluster VSZ_tesource_plan ruckus-project-key Active nova None  Running 2 hours, 16 minutes Create Snapshot | v
192.168.66.122
mgmt
17217.21.237
Displaving 2 items
Associating Floating IPs
1. From the homepage, click Project > Compute > Instances.
The Instances page is displayed.
FIGURE 84 Associating Floating IP
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Project v
Project / Compute / Instances
API Access
Compie ~ Instances
Overview
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Images Displaying 2 items:
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Volumes > O vSZ_tinf 362055 10.199.3.7 vSZ_resource_plan ruckus-project-key Active nova None Running 0 minutes Create Snapshot T‘
Network > Assodiate Floating IP
control Attach Interface b
Object Store > 10.10.30.128 Detach Interface
362056 cluster sz us-project ke At M N S howe 16 Editinstance
oy - s uckus-proect ey e Ruming ours, 16 minutes -

192.168.66.122
mgmt

172.17.21.237

Displaying 2 items
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2. Select the drop-down by the vSZ that you want to associate the floating IP and select Associate Floating IP.

The Manage Floating IP Associations page is displayed.

FIGURE 85 Manage Floating IP Associations

Manage Floating IP Associations

*
IP Address Select the IP address you wish to associate with the

172.17.21.233 - + selected instance or port.

Port to be associated *

vSZ_1inf: 10.199.3.7 - S

3. From IP Address, select the floating IP that was reserved.

4. Click Associate.

The system will take few seconds to associate the IP to the instance.
FIGURE 86 Associated Floating IP
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o vsZ_tinf 362055 Floating IPs urce_p ruckus-project-key Active nova None  Running 8 minutes Create Snapshot |~
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Object Store >
control
Identity > 10.10.30.128
0 wz 362055 shustey. vZ_resource_plan [ Active nova None  Running 2 hours, 25 minutes Create Snapshot | ~
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Displaying 2 items
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Setting up a vSZ Cluster
To setup a vSZ Cluster:
1.  From the homepage, click Project > Compute > Instances.

The Instances page is displayed.

2. Click the Console tab.

The Console page is displayed.

FIGURE 87 Console Tab Page

-

s openstack. =z~ & nolan ~
Project ~

Project / Compute / Instances / vSZ_finf

APl Access

i Create Snapshat | =

Compute + VSZ_1inf g

Ovenview

m - = o —

mages  INStance Console

Key Pairs If console is not responding to keyboard input: click the grey status bar below. Click here to show only console
To exit the fullscreen mode, click the browser's back button
Volumes >
Network > Co Send CtrlAltDel
Mounting other filesy
Object Store > Starting acpi daemon: [ OK 1
Starting HAL daemon: [ 0K 1
dentity N Hyper-U drivers are not loaded

Hyper-U FCOPY daemon not started:[WARNING]
Hyper-U drivers are not loade

Hyper-U XUP daemon not started:[WARNINGI

Hyper-U drivers are not loaded.

Hyper-U Us5 daemon not started: (UARNING]

Retrigger failed udev eventsl OK

Applying deadline elevator: dm-8 uda Lok 1

Applying ktune sysctl settings:

sete ktune .dtunedadm.conf: [ OK

Calling ’setcsktune.d/tunedadm.sh start’: setcstune-profilessfunctions: line 149
: sete/sysconfigscpuspeed: Read-only file system

Lok 1

Applying sysctl settings from setcssysctl.ds11-goe-netuork-security.cont
Applying sysctl settings from rsetcssysctl.cont

Starting kdump:[FAILED]
Generating SSHZ DSA host key: [ OK
Generating SSHZ RSA host key: [ OK
Generating SSHZ ECDSA host key: [ OK
Generating SSHZ EDZ5519 host key: [ 0K
Starting ssha:l 0K 1

ntpdate: Synchronizing with time server:

3. Follow the vSZ setup as explained in Using the Setup Wizard to Install vSZ on page 205.

NOTE
Always use DHCP in the vSZ system to avoid network issues.

Linux PC uses the private key to connect to the vSZ console.

ssh -i test.pem admin@192.168.66.203

The authenticity of host '192.168.66.203 (192.168.66.203)"' can't be established.
ECDSA key fingerprint is SHA256:B7d90MnrTEU6xDI0pGuUZ4gHWDZpgGINQ6lxt7citmkU.
ECDSA key fingerprint is MD5:85:c2:44:34:52:af:83:el:8f:6f:af:46:6£:a8:20:97.
Are you sure you want to continue connecting (yes/no)? yes

Warning: Permanently added '192.168.66.203"' (ECDSA) to the list of known hosts.
FHEH A H AR

# Welcome to vSZ #

FHEFHHHH AR AR

admin@192.168.66.203"'s password:
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Installing the vSZ on a Nutanix Hypervisor

Hardware Requirements for Nutanix Hypervisor

NOTE

vSZ deployment on Nutanix needs more memory allocation for vSZ usage. For 10,000 AP per node either setup 24 Core CPU and 50 GB
(+2GB) memory to control or lower down the AP deployment number by 25% in vSZ resource level. For example, 7500 AP in 10000 AP
resource level.

TABLE 14
Component Recommendation
CPUs Intel CPUs with VT-x support
System Memory 16 GB minimum
One Controller VM per node with optional deduplication/Compression features and additional memory for one or more
user VMs,
Network Interface Card (NIC) Intel-based NIC
Host bus adapter (HBA) Community-Edition supports Advanced Host Control Interface (AHCI) SATA or LSI controller with:
° IT mode (Nutanix testing shows better performance than IR)
] IR mode with pass-through
. IR mode with RAID-0
Storage Devices, All Drivers Maximum number of SSD or HDD per node is 4
Storage Devices, cold Tier 500 GB or greater available

Load the vSZ Image on the Nutanix Hypervisor

1. Login the Hypervisor CVM.

The homepage is displayed.
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From the upper-right corner of the page, click Settings and select Image Configuration as shown in the following image.

FIGURE 88 Image Configuration

Unnamed

Hypervisor Summary Prism Central Cluster-wide Controller I0PS Health

1510PS

AHV Not registered ta Prism
Central
VERSION NUTANIX
20180425199 Register or

o830 M 0s30PM 1030 M

Storage Summary Cluster-wide Controller 10 B/W T36KBpS VMe
920 KBps
114 TIB free (physical) of 124 TIB Services
Storage Containers

0830 M 0s30PM 130 M

WM Summary Cluster-wide Controller Latency s08ms Data Resiliency Status
s0ams
Availa... Best Effort
on 5 on nost 10.157.7.143
5 . OF o : on nost 10.157.7.143
VMIS) Suspend... 0 .
Pause 0 —— i . "
Data Reslliency
Hardware Summary Cluster CPU Usage Cluster Memory Usage
1 1 i iti Rebulld capacity avallable 94
CommuninyEdivion 33,29 30.25- ey
- v
HOST  BLOCK MODEL OF 644 GHz OF 18876 GiB Last svent 3 minutes ago v

Auto rebulld In progress

The Image Configuration window is displayed.

From Image Configuration form, click Upload Image. and add the vSZ image in QCOW2 format.

For example, vscg-5.1.2.0.243.gcow?2.

The default image size is 100 GB. If the image size is more than the default size, the file must be resized in the other Linux base and then
uploaded.

e  Toresize the image file:

gemu-img resize <image file name>.qgcow2 +500G

o  To check the resized image:
gemu-img info <resized image file name>.qgcow2

The Create Image window is displayed.

Enter the following information to add the vSZ image in QCOW?2 format:
e Name

e  Annotation

° Image Type

e  Storage Container

e Image Source

Click Save.

Create the vSZ Image on the Nutanix Hypervisor

1.

From the upper-left side of the screen, click Home and select VM.

RUCKUS Virtual SmartZone Getting Started Guide
Part Number: 800-72269-001 Rev G 109



Installing the vSZ on a Hypervisor
Installing the vSZ on a Nutanix Hypervisor

On the upper-right of the screen, click Create VM. The Create VM window is displayed.
From the Create VM screen, scroll down to Disks area to add two new disks.

Click Add New Disk, the Add Disk form appears.

oo 0N

From the Operation drop-down, select Clone from Image Service and click Add as shown in the following image.

FIGURE 89 Adding First Disk

DISK -

OPERATION
J—
Clone from Image Service =i Y Make sure you SK'j-"ECt
- from Image Service

BUST

SCsl ~

arris ~

7E (GIB
Please note that changing the size of an image is not allowed.

Canl:e' m

6. Repeat Step 4 and Step 5 to add the second disk.
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7. Repeat Step 4, from the Operation drop-down, select Allocate on Storage Container and click Add as shown in the following image.

FIGURE 90 Allocating Storage Container

DISK -
OPERATION

Allocate on Storage Container -
BLIS TYPE

SCSl -
STORAGE CONTAIMNER

SelfserviceContainer ~
SIZE (GIB
| 20| |
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8. From the Disks list, select the first disk added and delete CD-ROM as shown in the following image.

FIGURE 91 Disk Selection

Disks

@ Make sure you delete
CD-ROM EMPTY=true: BUS=ide Fox this CD-Rom slection
Select thisasthe Boot

Device $ © Dk SIZE=100GIE; BUS=scsi ;%

DISK SIZE=20GIB; CONTAINER=Se... F X

Volume Groups

Please create a VM before you can add a velume group.

Network Adapters (NIC)

9. Click Save.
10. Scroll down to the Network Adapters (NIC) area.
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11. Select the VLAN Name from the drop-down and click Add as shown in the following image.

FIGURE 92 Creating NIC

VLA sV

corp-net

:E“-II:EI m
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12. VSZ-H create the three interfaces as follows:

e  First interface: Control Interface

e Second interface: Cluster Interface

e Third interface: Management Interface

FIGURE 93 Creating vSZ-H Interfaces

Update VM ? b4
Network Adapters [NIC) + Add New MIC
VLAN ID VLAM MAME MAC REQUESTEL
vian.Q control 50:6b:8d:0b:dc:... £ -
vian.D cluster 50:6b:8d:39:60:... PR
vian.O manage 50:6b:Bd:40:9c:... F X

13. Click Save.

VM Host Affinity

You haven't pinned the VM to any hosts yet.

] Enable Flash Mode ()

Power-on the vSZ Virtual Machine

From the VM screen, select the newly created vSZ VM and click Power on as shown in the following image.
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oKBps

3 34 KBps

Once the vSZ virtual machine is up and running, click Launch Console, the console is displayed as shown in the following image.

FIGURE 95 VM Console

NTNX B02e8913-A/AHV 4 2068 277GiB/ 120 GiB 2248% 0%

v s 206 - -
[ e

A N hps//10.150.7.64:

Connected (encrypted) to: ruckus-vez

ting up Logical Uolume Management
now active
1

> ruckusvsz ing local filesystems: [ OK
ing local filesystem quotas:

sete fstab suaps: ok

non-interactive startup

rngd: Unable to open File: /dev/tpnd

VM Performance Virtual Disk:

. . CPU Usage syslog-ng: [

Memory Usage

ip6tables: Applying firewall rules: [ OK 1
i : Applying firewall rules: [ OK

up loopback interfac
. A o inging up interface bondd

up interface durmmyd:
Controller 10PS inging up interface br@:
Petermining IP information for bré... doene.

Bringing up interface br-tun:
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Introduction

You can install vSZ on Microsoft Azure using the procedure outlined.

NOTE

The minimum memory and CPU requirements have changed in this release. You may need to upgrade your infrastructure before
upgrading. Please read carefully. This is the minimum requirement recommended. Refer to the tables in Virtual SmartZone Minimum
Requirements on page 16 in the Installation Preparation chapter.

Public cloud solution resource requirement

e  CPU or Memory: Minimum requirement of D series and above.

NOTE
Does not support A and B series

e  Storage Requirement (Disk Storage): Minimum requirement of SSD 150 GB above.

NOTE
Any CPU with credit limitation type cannot support. For example AWS T2 instance or Azure B-series.
Select the proper disk size to run vSZ since disk sizes may have different disk 10 performance in each cloud platform.

Logging into Microsoft Azure

As the first step of installing vSZ on Microsoft Azure, you have to log into Microsoft Azure.

1. Click https://portal.azure.com to access the Microsoft Azure site.
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2. Enter your login credentials.

The Azure portal appears as shown in the following image.

FIGURE 96 Portal Tab
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~
Welcome to Azure!
Den't have a subscription? Check out the fallowing options.
Start with an Azure free trial Manage Azure Active Directory Access student benefits
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- viee [P ——
Azure services LS
— = =
+ () o @ = o a < -
Create a Resource Virtual App Services Storage SOLdstabases  Azure Datsbase  Azure Cosmos Kubsmetes More services
resource groups machines accounts for PostgreSQL DB services
v

Creating a Resource Group

To create a resource group:

1. From Azure services section, click Resource groups. The Resource groups page is displayed.

2. Click Add, the Create a resource group is displayed as shown in the following image.

FIGURE 97 Creating a Resource Group

) SN T - SRR p—

* Create a resource group

Create a resource group X

Basics Tags FReview + create
Resource group - A container that holds related resources for an Azure selution. The resource group can inchude all the
resources for the solution, or only those resources that you want to manage a5 a group, You decide how you want to

allocate resources to resource groups based on what makes the most sense for your organization, Learn more B

Project details
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Resource group * (0

Resource details
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3. Update the following information:

®  Subscription: Select Pay-As-You-Go
. Resource group: Enter a name for the resource group
e  Region: Select a region
4. Click Create.
The new resource group is created.

5. Select the resource group to view its related components.

FIGURE 98 Resource Group Components
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Creating a Storage Account and Container

To create a Microsoft Azure storage account, perform the steps outlined in this section.

1. From the Azure services section, click Storage accounts. The Storage accounts screen is displayed.
FIGURE 99 Storage account
e TS
Storage accounts b
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2.

Click Add and enter a Name for the storage account. The Create Storage account page is displayed.

FIGURE 100 Storage Account

Microsoﬂ Azure AL Search resources, services, and docs (G+/)

Home » Storage accounts > Create storage account

Create storage account

Praject details

Select the subscription to manage deployed resources and costs. Uise resource groups like folders to organize and manage all
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Resource group * | HTH

S |
Create new

Instance details

The default deployment model is Resource Manager, which supports the latest Azure features. You may choose to deploy using
the classic deployment model instead. Choose classic deployment madel

Storage account name * () [ hthsa ~ ]
Location * | {Asia Pacific) Southeast Asia ~ |
Performance (0 ':i} Standard {:) Premium

Account kind O | StorageV2 (general purpose v2) el |
Replication (& | Locally-redundant storage (LRS) hal |
Access tier (default) @ () Cool__(®) Haot

RUCKUS Virtual SmartZone Getting Started Guide
Part Number: 800-72269-001 Rev G



Installing the vSZ on Microsoft Azure
Creating a Container to Upload the vSZ Image to Microsoft Azure

3. Update the following:

e  Resource group: Select the resource group created in the procedure.
o  Account kind: Select Storage v2

e Replication: Select LRS

NOTE
All other configurations can be left default or be configured as required.

4. Click Create.

Creating a Container to Upload the vSZ Image to Microsoft
Azure

A container must be created to upload the vSZ image to Microsoft Azure. Follow these steps outlined in this section to create a container and
upload the vSZ image to Microsoft Azure.

1. Go to the storage account created in the previous procedure and select Containers.

FIGURE 101 Container creation
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2. From the Containers page click + Container.
3. Inthe New Container pane, enter a Name for the container and select Public access level.

4. Click Create, a new container is created.
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5. Select the new container and click Upload.

FIGURE 102 Uploading the vSZ image file
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6. Browse for the vSZ image file and click Open.

NOTE

Extract the software zip file downloaded from the support site and upload only the vhd image.
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Creating a Virtual Network

Follow these steps to create a virtual network.
1. From the Azure services section, select Virtual networks and click Add.

The Create virtual network page is displayed as shown in the following image.

FIGURE 103 Creating a virtual network
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Home » Virtual networks * Create virtual network

Create virtual network

Basics IP Addresses  Security Tags Review + create
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benefits of Azure’s infrastructure such as scale, availability. and isclation. Learn more about virtual network
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2. From the Basics tab, update the following:
e  Resource group: select the resource group created in the previous procedure.
o  Name: enter a name for the network.
®  Region: select a region.

3. Click Next: IP Address, the IP Addresses tab is displayed.

A default IPv4 private address is displayed.
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4. To create a new IPv4 address, enter the IP address in IPv4 address space.
FIGURE 104 IPv4 Address

Home > Virtual networks »* Create virtual network

Create virtual network

Basics IP Addresses Security Tags Review + create

The virtual network's address space, specified as one or more address prefixes in CIDR notation (e.g. 192.168.1.0/24).
IPvd address space

10.7.0.016 10.7.0.0 - 10.7.255.255 (65536 addresses) ]

I_] Add IPv6 address space (D

The subnet's address range in CIDR notation {(e.g. 192.168.1.0/24). It must be contained by the address space of the virtual
network

- Add subnet
[_] Subnet name Subnet address range

I:I default 10.7.0.0/24

Review + create = Previous Mext : Security = Download a template for automation

5. The Security and Tags tab can be updated or left to apply default settings.

6. Click Review + create.

Creating Network Security Groups

Network security group is the Azure firewall rule. You can have different firewall rules for each vSZ instance.
To create a network security group:
1. From the Azure services section, select Network Security Groups and click Create.

The Create Network Security Group page is displayed.
2. In the Basics tab, udpate the following:

e  Resource group: select the resource group

e Name: enter a name for the security group

e  Region: select a region to which it applies
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3. Click Next: Tags to update the tag settings or click Review + Create to apply the default settings.

A new network security group is created.

4. Select the new security group and click Settings > + Add.

The Add inbound security rule page is displayed.

FIGURE 105 Network security groups
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5. Update the following information:
e  Source: select the source port.
e  Source port ranges: enter the source port range.
e Destination: select the destination port.
e Destination port ranges: select the destination port ranges.
o  Protocol: select one of the options—Any, TCP or UDP.
e  Action: select Allow or Deny.
e  Priority: enter the rule priority number.
o  Name: enter a name for the rule.

e Description: enter a short description about the rule.
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6. Click Add, the new rule is added to the existing rule list as shown in the following image.

FIGURE 106 Inbound Security Rule List
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Creating a vSZ Image on Microsoft Azure

Follow these steps to create a vSZ image on Microsoft Azure:

1.  From the Azure Services section, select Images and click Create.

NOTE
ssh is allowed by default, so add port 443 and 8443 for AP connection and Web access.

FIGURE 107 Creating an image

I!—i:-rnc‘ # Images » Create image

Create image

MName *

| HTHImage

Subscription *

| Pay-As-You-Go - Commscope 2020 - Ruckus Smart Zone

Resource group *
| HTH

Create nsw
Location *

| (Asia Pacific) Southeast Asia

Zone resiliency (O

On Off

05 disk

o5 type * O
((windows (I
VM generation * (1)

( Gen1 JECCUE

storage blob *

I https://hthsa blob.core windows.net/hthcontainer/fvscg-5.2.0.0.699.vhd

2. Update the following fields:

e Name: enter a name for the image

e  Resource group: select the resource group

®  Location: select the region

e  Zone resiliency: click Off

e  OStype: select Linux

e VM generation: select Gen 1

e  Storage blob: click Browse and select the vhd image that was uploaded in the earlier procedure.

3. Click Create.
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Creating a vSZ Virtual Machine

Follow these steps to create a vSZ virtual machine.

128

1.

Select the image created in the previous procedure and click Create VM.

The Create a virtual manager page is displayed.

FIGURE 108 Basics tab

Home

Microsoft Azure

Create a virtual machine

WOUr Fesources

i

Resource group * (1)

Instance details

Virtual machine name * (1)

Availability eptions (0

Images » HTHImage » Create a virtual machine

L Search resources, services, and docs G+

HTH

Create new

hth-vsz

Mo infrastructure redundancy required

Image * (D)

HTHI:"'age

Azure Spot instance (1)

Browie |l“ FII.II'.'FII\'. |II'Id |:IIHI'|!I1." i”'ln.lll_;t"\-

':j Yes i' Mo

Sizge ¥ (D

Standard Dds v3

4 wopus, 16 GiB memory ($182.50/month])

Change size

Update the following fields:

Resource group: select an option.

Virtual machine name: enter a name.

Size: select D4s v3 for assigning 4 vCPUs and 16 GB memory to the vSZ.

Authentication type: select Password.

Select inbound ports: select all the inbound ports available. Network security group created in the previous procedure can be
selected fromt the Networking options.
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3. Click Next Disks.

The Disks tab page is displayed.

FIGURE 109 Disks tab

Micmsnﬂ Azure £ Search resources, services, and docs (G+/)

Home » Images * HTHImage > Create a virtual machine

Create a virtual machine

Basics Disks MNetworking Management Advanced Tags Review + create

Azure VM3 have one operating system disk and a temporary disk for short-term storage. You can attach additional data disks.
The size of the WM determines the type of storage you can use and the number of data disks allowed. Learn more

Disk options

Ps disk type * {0 Standard HDD ~

The selected VM size supports premium disks. We recommend Premium S50 for
high 10P5 workloads. Virtual machines with Premium S50 disks qualify for the
99.9% connectivity SLA.

Encryption type * (Default) Encryption at rest with a platform-managed key '

Enable Ultra Disk compatibility {0 Y N

Ultra Disk compatibility is not available for this VM size and location

[

ou can add and configure additicnal data disks for your virtual machine or attach existing disks. This VM also comes with a
temporary disk.

Data disks

LUN Mame Size (GiB) Disk type Haost caching

Create and attach a new disk Attach an existing disk

4.  From OS disk type, select Standard HDD.
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5. Click Next: Networking.

The Networking tab page is displayed.

FIGURE 110 Networking tab

—] Microsoft Arure £ Search resources, services, and docs (G+/]

Home »* HTHImage > Create a virtual machine

Create a virtual machine

Basics Disks Metworking Management Advanced Tags Review + create

Define netwark connectivity for your virtual machine by configuring network interface card (NIC) settings. You can control
ports, inbound and cutbound connectivity with security group rules, or place behind an existing load balancing sclution.
Learn more

Metwork interface

When creating a virtual machine, a network interface will be created for you.

Virtual network * (0D hithwn il

Croate mow

Subnet * 00 default (10.7.0.0,/24) e
Manage subnet u_'.n!igul ation

Public IF (0 (rew) hth-vsz-ip o

Create mew

HIC network security group (0 {:___:l Mone ":__:l Basic L_'.lg,' Advanced

-

Configure network seourity group | hith-nsg wr |

Create mew

Accelerated |1ctwnrking () :f.._.' Off

6. Update the following:
e  Virtual network: select the virtual network created in the earlier network.
e  Subnet: select a subnet.
o  NIC network security group: select the Advanced option.
Default configuration will apply to Management, Advanced, and Tags tab.
7. Click Review + Create to review the configuration.

8. Click Create.

Updating the Disk Size According to Resource Plan

Follow these steps to update the disk size according to the resource plan:

1. From the Virtual machines page, select the virtual machine and click Stop.

2. From the Settings area on the left pane, select Disks and click Add data disk.

RUCKUS Virtual SmartZone Getting Started Guide
130 Part Number: 800-72269-001 Rev G



3. Go to Data disks > Name > Create disk for creating customised disk.

The Create managed disk page is displayed.

FIGURE 111 Creating Managed Disks

Home > Virtual machines > Create a virtual machine > Create a new disk >

Select a disk size

4 GiB P1 120 25
8GiB P2 120 25
16 GiB P3 120 25
32 GiB P4 120 25
64 GiB P6 240 50
128 GiB P10 500 100
256 GiB P15 1100 125
512 GiB P20 2300 150
1024 GiB P30 5000 200
2048 GiB P40 7500 250
4036 GiB P50 7500 250
8192 GiB P60 16000 500
16384 GiB P70 18000 750
32767 GiB P80 20000 900

Custom disk size (GiB) * ©

150 N

Performance tier O

Select a performance tier to upgrade v

3500

3500

3500

3500

3500

3500

3500

3500

Installing the vSZ on Microsoft Azure

170

170

170

170

170

170

170

170

Setting up vSZ

4. In Custom disk size, enter the minimum disk size required and click Save.

5.  Click Start to apply the disk size and continue.

Setting up vSZ
1.  Start PuTTY with the public IP address assigned to vSZ.

NOTE
Ensure port 22 to the inbound security rules for SSH access.

NOTE

The default credentials are as follows:
e  Username: admin

e  Password: admin

e  Enable Password: admin

2. Click Open. The PuTTY console appears and displays the login prompt.

3. Inlogin as:,enter admin. The message “Welcome to vSZ” appears.

4. Inpassword:, enter admin. The vSZ> prompt appears.
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132

v ©® N oW

10.

11.

12.

13.

14.
15.

Enter en to enter the privileged mode.

In password:, enter admin. The vSZ# prompt appears.

Enter setup. The message “Start vSZ setup process” appears.

InSelect vSZ Profile:,enter 1 for Essentials and 2 for Highscale.

In Select address type,enter1for ITPv4 only and2for IPv4 and IPv6 IP version support.
The next prompt asks you to choose how you want to set up the IP address.

Enter 1 if you want to manually assign an IP address, or enter 2 to automatically obtain an IP address from a DHCP server on the network.

NOTE
The vSZ Cloud setup, supports single interface configuration. The configuration applied here will be the same for control,
cluster, and Management interfaces of the vSZ.

At the Primary DNS prompt, enter the IP address or host name of the primary DNS server that you want vSZ to use.

The next prompt asks you to enter the secondary DNS server address.

At the Secondary DNS prompt, enter the IP address or host name of the secondary DNS server that you want vSZ to use.
The next prompt asks you to confirm that you want to apply the IP address settings that you configured in the previous prompts.
When the prompt "Do you want to apply the settings? (y/n)" appears, entery to confirm and continue.

After applying the settings, the message, "Current Network Settings (After Applying)"isdisplayed.

At the prompt "Accept these settings and continue? (y/n)",entery to confirm and continue.

Run the setup again to configure the cluster details using CLI. To configure vSZ usning the setup wizard, refer to Using the Setup Wizard to
Install vSZ on page 205 for more information.
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Introduction

You can install vSZ on the Google Computing Engine using the steps mentioned in this section.

NOTE

The minimum memory and CPU requirements have changed in this release. You may need to upgrade your infrastructure before
upgrading. Please read carefully. This is the minimum requirement recommended. Refer to the tables in Virtual SmartZone Minimum

Requirements on page 16 in the Installation Preparation chapter.

Public cloud solution resource requirement
e  CPU or Memory: Minimum requirement of Custom Machine Type.

e  Storage Requirement (Disk Storage): Minimum requirement of SSD 150 GB above

NOTE
Any CPU with credit limitation type cannot support.

Select the proper disk size to run vSZ since disk sizes may have different disk 10 performance in each cloud platform.

Logging into GCE and Selecting a Project

This section describes how to log into the GCE and select a project.
Ensure that you have created an account with GCE and have the login details for the same.

1.  Click http://cloud.google.com to access the Google Cloud Platform website.
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2. Login using your user name and password.

FIGURE 112 Login with user credentials

Google
Signin

to continue to Google Cloud Platform

Email or phone
Forgot email?

Not your computer? Use a Private Window to sign in.

Learn more
Create account Next
English (United States) - Help Privacy Terms

3. Select My console as shown.

FIGURE 113 GCE Page - My console

36009'2 C|0ud Why Google Solutions Products Pricing Getting started

134

Q Docs Support Censole
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4. Alist of projects you created is displayed. Click to choose a project.

FIGURE 114 Choose the project

Select a project [  NewPROJECT

Q, search projects and foldars

RECENT ALL
Name |0
+ a* TODCST @ tdec-st

NOTE
You can create projects by clicking Create a project in the drop-down.
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5. Click Product and Services icon to view the list of GCE services.
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FIGURE 115 Selecting a Project

Home

EE:E Compute Engine

PRODUCTS A

%

Marketplace

L]
L]

Billing

API  APls & Services

'i' Support

B 1AM & admin
@ Getting started
';, Security
COMPUTE

-®- AppEngine

EE:E Compute Engine
@ Kubernetes Engine
[] Cloud Functions

)) Cloud Run
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e* TOC-5T

Wi instances
Instance groups
Instance templates

Sole tenant nodes

Disks

Snapshots

Images

TRUs

Committed use discounts
Metadata

Health checks

Z0Ones

Metwork endpoint groups
Dperations

Security scans

Settings
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Creating a Storage Bucket

You can create storage for the objects you create. Follow these steps to create storage.

138

1.

From Google Developers Console, click Product and Services icon > Storage. The Cloud Storage Buckets screen appears.

FIGURE 116 Storage Bucket Browser

1]
=

Google Cloud Platform

Home

Compute Engine

FROCUCTS A

@ Bigtable

Sis  Datastore
"-"5 Firestore

= Storage

£ sqL

.;l:, Spanner

E Memorystore

2* TDC-ST w

Browser
Transfer
Transfer Appliance

Settings
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2.

Click Create Bucket. The New bucket screen appears.

FIGURE 117 Creating a Storage Bucket

Google Cloud Platform

e olorage
W  Erowser
= Transfer

Complete the following fields,

Browser

2* TOC-5T =

Installing vSZ on the Google Computing Engine

Creating a Storage Buc

€ CREATE BUCKET

(' REFRESH

| Filter by prefix...

| Columns =

Buckets

a) In Name, type the name of the storage bucket

b) In Storage class, select the storage class you want. You can choose from Standard, Durable Reduced Availability (DRA) or Cloud
Storage Nearline in the drop-down list. Use the below table to compare the storage classes.

c) InLocation, select the location from the drop-down list.

TABLE 15 Bucket Storage Location

ket

Storage Class

Characteristics

Use Cases

Bucket Location

Standard Storage

High availability, low latency (time
to first byte is typically tens of
milliseconds).

Storing data that requires low
latency access or data that is
frequently accessed ("hot" objects),
such as serving website content,
interactive workloads, or gaming
and mobile applications

Continental locations

Durable Reduced Availability (DRA)

Lower availability than Standard
Storage and lower cost per GB
stored.

Applications that are particularly
cost-sensitive, or for which some
unavailability is acceptable such as
batch jobs and some types of data
backup.

Continental and regional locations
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TABLE 15 Bucket Storage Location (continued)

Storage Class Characteristics Use Cases Bucket Location

cost.

Cloud Storage Nearline Slightly lower availability and Data you do not expect to access Continental locations
slightly higher latency (time to first | frequently (i.e., no more than once
byte is typically 2 - 5 seconds) than per month). Typically this is backup
Standard Storage but with a lower data for disaster recovery, or so

called "cold" storage that is
archived and may or may not be
needed at some future time.

FIGURE 118 New Bucket Information

Google Cloud Platform

2 TDC-5T - Q

Browser

E Storage
-

2 Transfer
=E  Transfer Appliance

£ settings

140

<  Create a bucket

MNama
Wust be unique acress Cloud Storage. If you're serving website content, enter the
website domain as the name.

ysz-testing

Dafault storage class

Objects added 1o this bucket are assigned the selected stomge class by default. An
object's storage class and bucket location affect its gec-redundancy, availability, and
zosts. You can set stomge classes for individual objects in gsutil. Learn mare

Wearling and Ceoldline data in multi-regicnal locations is now Dismiss
stored gec-redundantly. Mew locations namd and eurd (available

in beta) enable co-location of compute and storage fer high

performance with gec-redundanecy. Learn maore

@ Multi-Reqgional
Reqgional
Mearline
Coldline

Location

United States (multiple regions in the United States) -

Compare storage classes

Storage enst Retrieval cost Class A operations Class B nperations
$0.026 per GB-month  Free $0.005per 1,000 0ps  $0.0004 per 1,000 ops

Aocass contrel model
Chooge how yvou'll contrel access tothis bucket's objects, Learn more
Set permissions uniformly at bucket-level (Bucket Policy Only)
Enforces the bucket’s |Ah policy without object ACLs. May help prevent unintended
geoess. If selected, this option becomes permanent after 00 days.
® Set object-level and bucket-level permissions
Enforees the 1AM policy and object ACLs for more granular control of object access.

Show advanced settings

Create Cancel
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4. Click Create. The storage bucket you created is listed in the browser.

5. To create another storage, click Create bucket as shown.

FIGURE 119 Creating Another Storage Bucket

Google Cloud Platform 3 ToCST »

E Storage Browser & CREATE BUCKET C REFRESH
i Elraiier | Filter by prefi.. | Columns =
= Transfer Buckets

6. Verify that the storage bucket has been created.

FIGURE 120 Selecting the Storage Bucket

= Google Cloud Platform & TDC-5T *

E Storage Browser & CREATE BUCKET C REFRESH
- EwEE vsz-testing Columns -
2 Transfer Buckets

Transfer Appliance

Nama Default storage class Location Public access Lifecycle Aocess control model
] Settings VEZ- Multi-Regional us Fer abject Mone Bucket policy & ACLs
testing

Uploading the vSZ Image to a Storage Bucket

Follow these steps to upload a controller image to the storage bucket you created.
1.  Extract the vSZ raw.bin file that you obtained from Ruckus Networks.
NOTE

e |Ifthe"Permission denied" error appears, execute the command "chmod +x vscg-3.5.0.0.808.raw.bin" before
extracting the file.

e [fthe "uudecode: command not found" error appears during the extraction process, install the "sharutils"
package, and then try extracting the image again.

2. Read the Virtual SmartZone (vSZ) Software License agreement that appears when you extract the raw.bin file.
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3. Whenthe Accept this agreement? prompt appears, enter yes to accept the license agreement.

When the extraction process is complete, a raw.tar.gz file appears.

4. Onthe GCE web interface, browse to the storage bucket where you want to upload the vSZ image file.

FIGURE 121 Browse to the storage bucket

Google Cloud Platform 8= TDC-5T *

Storage & Bucket details #" EDIT BUCKET C REFRESH BUCKET

Browser vaz-testing

Ohjects Chrendsicn Permissions Bucket Lock
Transfer

Transfer Appliance
Upload files  Upload folder  Createfolder  Manaoe holds  Delefs

# & n o [f

Settings
Filter by prefix...

Buckets [ wsz-testing

There are no live objects in this bucket. If you have object versioning enabled, this bucket may ¢o
using gsutil or the AFIS.

5. Click Upload files.
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6. Browse to the location of the .raw.tar.gz image file that you extracted, and then select it.

NOTE
You can only select .raw.tar.gz files.

FIGURE 122 Select the .raw.tar.gz image file that you extracted

Cancel | File Upload Q

© Recent < | [®  home ruckus = vscg | b

r Home | Name v Size Modified

B vscg5.1.1.0.x0. raw.tar.gz 13GB Yesterday

[ Documents
&, Downloads
dd Music

33 Pictures

vl Videos

+ Other Locations
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7. Click Open to upload the image file.

Your browser displays the progress of the file upload process. After the upload process is complete, the image file appears in the storage

bucket.

FIGURE 123 The image file appears in the storage bucket

= Google Cloud Platform

2 TDCST *

Storage

Browsar
Tranzfer

Transfer Appliance

1

(=]
.
&

Settings

144

& Bucket details # EDIT BUCKET (* REFRESH BUCKET

ysz-testing

Objects Crrenyien Permissions Bucket Lock

Uploadfiles  Upload folder  Create folder

Filter by prefic..

Buckets [ vsztesting

Nama Size

9 v5¢0-5.1.1. 0000 ravw targz 1.24
GB

hanage holds | Delete

Type Storage class Last modified
application/x Mlulti- 4723119,11:42:41
Qzip Regional PR UTC+3
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Creating a vSZ Image for Virtual Machines

Follow these steps to create a vSZ image for virtual machines.

1. From Google Developers Console, click Compute > Compute Engine.

FIGURE 124 Select Compute Engine

Google Cloud Platform §* TDC-5T =

Home

EE Compute Engine >

PROCUCTS A
LLIMEU I E n

@+ App Engine »

£} Compute Engine | ¥ >

YWhinstances

@ kubernetes Engine > Instance groups

[..

Instance templates

] Cloud Functions
Sole tenant nodes
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2. Onthe menu, click Images, and then cllick Create Image.

FIGURE 125 Click Create Image

Google Cloud Platform 2= TDC-5

ubuntu-rninimal-1810-¢osmic-y20130402

EIEF Compute Engine Images [+] CREATE IMAGE
B vMinstances
= Filterimages

#  Instance groups

Namea
B  Iinstance templates

0 ubuntu-1804-bionicv20190320
B soletenantnodes @ ubuntu-1804-bionicv20190404
B Disks & ubuntu-1810cosmicv20190402

ubuntu-1904-disco-v20190417

Snapshots o

0 ubuntu-rminimal-1604-xenial-y20190408
= Images

0 ubuntu-rinimal-1804-bionic-y20190403
| TPUs @

<

a3 Committed use discounts ubuntu-rminimal-1904-disco-w20190417

The Create an image page appears.
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Size

10 GB

10 GB

10 GB

10 GB

10 GB

10 GB

10 GB

10 GB

CREATE INSTANCE

Created by

Canonical

Canaonical

Canaonical

Canonical

Canonical

Canonical

Canonizal

Canonizal

DEPRECATE

Family

ubuntu-1204-Its
ubuntu-1804-1ts
ubuntu-1810
ubuntu-1904
ubuntu-rinimal-1604-1ts
ubuntu-rinimal-1304-1ts
ubuntu-minimal-1810

uburtu-rninirmal-1904
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3. Configure the properties of the new image by fillng out the boxes below.
a) In Name, type the name of the image.
b) In Description, provide a brief description about the image.
c¢) InEncryption, select an option from the drop-down list containing Automatic (recommended) and Customer supplied.
d) InSource, select Cloud storage file.

e) In Cloud Storage file, click Browse, and then select the .raw.tar.gz image file that you extracted previously.
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FIGURE 126 Creating an image

Google Cloud Platform

2 TOC-5T =

& D

# & ©

148

Compute Engine

Wi instances

Instance groups
Instance templates

Sole tenant nodes

Cisks

Snapshots

Images

TRUs

Committed use discounts
Metadata

Health checks

ZOMes

Metwork, endpoint groups
Dperations

Security scans

Settings

& Create animage

Namea
y¥52-5-1-1200¢

Family (Cpticnal)

Dascription [Cpticnal)

Labels = [Opticnal)

+ Add label

Encryption
Cata is encrypted automatically. Select an encryption key management solution.

® Google-managed key
Mo configuration required
Custarner-rnanaged key

hanage via Google Cloud Key Management Service
Custormersupplied key
Manage cutside of Google Cloud

Source

Cloud Storage file -

Cloud Storage file
Your image source must use the targz extension and the file inside the archive must be
named disk.raw. Learn more

ysz-testing/rscg-5.1.1 Dooodrawtargz Brovwse

¥ou will be billed for this image. Compute Engine pricing 17
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4. Click Create.The new image is listed.

Installing vSZ on the Google Computing Engine

Creating a vSZ Image for Virtual Machines

GCE creates the new image. When the process is complete, the image you created from the .raw.tar.gz image file appears on the Images

page.

FIGURE 127 The new image you created appears on the Images page

= Google Cloud Platform

2* TOC-5T +

EE:]E Compute Engine
A

WM instances
] Instance groups
B  Instance templatas
B  soletenant nodes
B oisks
snapshots
= Images

| TPUs

You have completed creating an image.
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= wsz-A-1-1aco ) Filterimages

Namse Size Created by

@ vszS1-1s0 40GB tdest

Show deprecated images

(C REFRESH

CREATE INSTANCE

x Calumns -

Family Creation time

APr23,2019,11:49:25 PM
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Creating a Network and Configuring Firewall Rules

Follow these steps to create a network and configure firewall rules for your network.

1. From Google Developers Console, click Networking > Networks. A page displaying a list of networks is displayed. Click on Create VPC
Network.

FIGURE 128 List of networks

Google Cloud Platform 2 TDCST Q  Search products and resources

::: VPC network VPC networks CREATE VPCNETWORK | (3 REFRESH

B  VPC networks

[Y  External IP addresses

Mame P Region Subnets MTU @ Mode
&  BringyourownIP b alto-wispr-network 27 1460 Auto -
E Firewall w alto-wispr-psk-network 1 1480 Custom
asia- ublic-
x Routes east] 5etwor1r.
4%  VPC network peering b default 29 1460 Auto w
bq  Shared VPC w tdc-ga-test 1 1460 Custom
us- us-
#x  Serverless VPC access centrall centrall
Jil Packet mirroring b vdp-newark 3 1460 Custom
b vsz-demo 2 1460 Custom
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Creating a Network and Configuring Firewall Rules

2. Inthe Create a VPC network screen, configure the following:
a) Name: enter the name of the VPC network.
b) Subnets: enter a name for new subnet.
c) Region: select a region from the list that is used to place the vSZ instance.
d) IP address range: enter a private subnet.

e) Private Google access: select On.

FIGURE 129 Configuring VPC network - part 1

= Google Cloud Platform &= TDCST + Q,  Search products and resources
::: VPC network & Create a VPC network
Mame *
B VPCnetworks vsz-demo 7]

Lowercase letters, numbers, hyphens allowed
[5§  External IP addresses

& Bring your own IP Description
g
£ Firewall
¢  Routes
Subnets
= VPC network peering Subnets let you create your own private cloud topology within Google Cloud. Click
Automatic to create a subnet in each region, or click Custom to manually define the
[+4] Shared VPC subnets. Learn more
& Serverless VPC access Subnet creation mode
@ Custom
o .
il Packet mirrorin
Il 9 O Automatic
New subnet ~
Name *
vsz-demo ]

Lowercase letters, numoers, hyphens allowed

Description

Region *
asia-east ~ @

IP address range *
10.0.0.0/9 e

CREATE SECONDARY IP RANGE

Private Google access @
@® on
O off

Flow legs
Turning on VPG flow logs doesmt affect performance, but some systems generate a large number of logs, which can increase costs in
Cloud Logaing. Learn more

O on
@ off

<l
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Google Cloud Platform & TDCST Q, Search products and resources
::: VPC network & Create a VPC network
IF address range ™
B VPCnetworks 10.0.0.0/9 (7]
[  Extemal IP addresses CREATE SECONDARY IP RANGE

Ering your own IP
Private Google access @

Firawall @® on
Off
»  FRoutes ®)
Flow logs
VPC network peerin
< P 9 Turning on VPC flow logs doesnt affect performance, but some systems generate a large number of logs, which can increase costs in
Cloud Logging. Leamn more
bdq Shared VPC O on
Off
#r  Serverless VPC access ®

o - N
il Packet mirroring CANCEL DONE

ADD SUBNET

Dynamic routing mode @

@ Regional
Cloud Routers will learn routes only in th@;im inwhich they were created

O alobal

Global routing lets you dynamically learn routes to and from all regions with a single VPN or interconnect and Cloud Router

DNS server policy
Mo server policy * @

Maximum transmission unit (MTU)
1460 -

CREATE CANCEL

EQUIVALENT COMMAND LINE =~

<l
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Installing vSZ on the Google Computing Engine
Creating a Network and Configuring Firewall Rules

3. Click Create, the new VPC network entry is displayed.

FIGURE 130 VPC network entry

= Google Cloud Platform & TDCST Q_  Search products and resources

::: VPC network VPC networks CREATE VPC NETWORK (! REFRESH

BB  VPCnetworks

[5  External IP addresses

Name 4 Region Subnets MTU 0 Mode IP address ranges Gateways Firewall Rules Global
& )
& Bring your own IP b alto-wispr-netwark 27 1460 Auto - & an
Firewall b alto-wispr-psk-network 1 1460 Custom 5 off

b default 29 1460 29 off
»  Routes Auto w

b tdc-ga-test 1 1460 Custom 4 off
< VPC network peering

b wdp-nework 3 1460 Custam 1 off
-] Shared VPC w vsz-demo 1 1460 Custom 1 off

asia-eastl vsz-demo 10.0.0.0/9 10.0.0.1

& Serverless VPC access

) Packet mirroring

4. To create a firewall rule, click Add a firewall rule.

FIGURE 131 Add a Firewall Rule

Google Cloud Platform & TDCST Q_ Search products and resources
::: VPC network < VPC network details # EDIT W DELETE VPC NETWORK
| VPC networks vsz-demo
[ External IP addresses I/\\s

Subnet creation mode

Bring your own IP Custom subnets

Dynamic routing mode

Firewall
Regional
¢  Routes
DMS server policy
a®  VPC network peering None
pq Shared VPC Maximum transmission unit
1450
3 Serverless WPC access
SUBNETS STATIC INTERMNAL IP ADDRESSES FIREWALL POLICIES FIREWALL RULES

il Packet mirroring

ADD FIREWALL RULE DELETE
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5. Inthe Create a firewall rule screen, configure the following:
a) Name, enter the name of the rule
b) Description, provide a brief description about the rule.
c) Network, enter the network address.
d) Source filter, select Allow from any source.
e) Source IP ranges, enter the range.

f)  Allowed protocols and ports, enter the protocols and ports that will be allowed. Refer to the RUCKUS SmartZone 300 and Virtual
SmartZone-High Scale Administrator Guide, for details of required open ports for control and management interface.

g) In Target tags, specify a tag name. It is recommended that you provide a tag as all network instances with this tag will adhere to the
firewall rule.

FIGURE 132 Creating a Firewall Rule

= Google Cloud Platform & TDCST w Q, Search products and resources
::: VPC network & Create afirewall rule
&=  VFCnetworks Firewall rules control incoming or outgoing traffic to an instance. By default, incoming
traffic from outside your network is blocked. Learn more
[%  External IP addresses
Name *
&5  Bring your own IP vsz-ctr-mgmit (2]
Lowercase letters, numbers, hyphens allowed
EE  Firewall
x Routes Description
-
% VPC network peering
Logs
b Shared VPC Turning on firewall logs can generate a large number of logs which can increase costs in Cloud

Logging. Learn more
&3 Serverless VPC access O on

@® off

MNetwork *
vsz-demo * @

il Packet mirrering

Priority *
1000 CHECK PRIORITY OF OTHER FIREWALL RULES @

Pricrity can be 0 - 65535

Direction of traffic @

@® Ingress
() Egress s

Action on match @

@ allow
() Deny

Targets
Specified target tags - @

Target tags *
vsz-demo @

<l
Source filter
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Google Cloud Platform &= TDCST Q  Search products and re|
::: VPC network & Create a firewall rule
@ allow

=  VPCnetworks O Deny
s External IP addresses Targets

Specified target tags ~ @
&  Bring your own IP

Target tags *
EE  Firewall vsz-demo €
»  Routes

Source filter
4% VPC network peering IP ranges * @
b4 shared VPC Source IP ranges *

0.0.0.0/0 € for example, 0.0.0.7/0, 192.168.2.0/24 (7]
35 Serverless VPC access

N Second source filter
iy Packet mirroring None ~ @

Protocols and ports g
O allow all
@ specified protocols and ports

icp: 21,22,91,443,2084,4443,7443,8022,8090,8099,8100,8200,8222 828(

udp: 67-69,161,546,547,3799,5353,12223,33434-33534

[C] Other protocoals

protocels, comma separated, e.g. ah, sctp

W DISABLE RULE

CREATE CANCEL

EQUIVALENT COMMAND LINE ~

<l
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6. Click Create. A page displaying the new firewall rule appears.

FIGURE 133 Adding Firewall Rules

(3

X

a
gl

VPC network

VPC networks

External IP addresses
Ering your awn IP
Firewall

Routes

WVPC network peering
Shared VPC
Serverless VPC access

Packet mirrering

& VPC network details /' EDIT

vsz-demo

Subnet creation mode
Custom subnets

Dynamic routing mode
Regional

DNS server policy
MNone

Maximum transmission unit
1460

£ SUBNETS STATIC INTERNAL IP ADDRESSES

W DELETE VPC NETWORK

FIREWALL POLICIES FIREWALL RULES ROUTES

VPC NETWORK PEERING

ADD FIREWALL RULE DELETE
= Filter Enter property name or value
D Name Type Targets Filters Protocols / ports Action
D vaz-ctrl- Ingress vsz-demao P 1ep:21,22,91,443,2084,4443,7443,8022,8090,8099,8100,6200,82 Allow
mgmt ranges: 22,8280,8443,9080,9443,9997,9998
0.0.0.0/0 7-69,161,546,547,3799,5353,12223,33434-33534
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Creating a Network and Configuring Firewall Rules

7.  For building up a 2-4 node cluster, create another firewall rule that allows all traffic on internal interface of all your vSZ instances.

Google Cloud Platform

= TDCST + Q, Search products and

il

<l

VPC network

VPC networks

External IP addresses
Bring your own IP
Firewall

Routes

WPC network peering
Shared VPC

Serverless VPC access

Packet mirroring

& Create afirewall rule

Firewall rules control incoming or outgoing traffic to an instance. By default, incoming
traffic from outside your network is blocked. Learn more

Name *
vsz-cluster (7]

Lowercase letters, numbers, hyphens allowed

Description

Logs
Turning on firewall logs can generate a large number of logs which can increase costs in Cloud
Logging. Leamn maore

O on
@® off

Network *
vsz-demo - @

Priority *
1000 CHECK PRIORITY OF OTHER FIREWALL RULES @

Priority can be 0 - 65533

Direction of traffic @

@® Ingress
() Egress

Action on match @

@® allow
() Deny

Targets
Specified target tags - @

Target tags *
vsz-demo €

Source filter
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Google Cloud Platform g TDCST +

.|§|.

<l

158

VPC network & Create a firewall rule

1000 CHECK PRIORITY OF OTHER FIREWALL RULES 9
WPC networks
Priority can be 0- 65533

External IP addresses .
Direction of traffic @

Bring your own IP @ Ingress

() Egress
Firewall

Action on match @

Routes @ Allow
VPC network peering O Deny
Targeis
Shared VPC Specified target tags ~ @
Serverless VPC access
Target tags *
vsz-demo €

Packet mirroring

Source filter
IP ranges * @

Source IP ranges *
10.0.0.2/32 192.0.0.2/32 € for example, 0.0.0.0/0, 192.168.2.0/24 (7]

Second source filter
None * @

Y

Protocals and ports @
@® Allow all
() Specified protocols and ports

v DISABLE RULE

CREATE CANCEL

EQUIVALENT COMMAND LINE  ~
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Creating a Virtual Machine Instance

VPC networks

Google Cloud Platform & TDCST v Q  Search products and resources
& VPC network details /' EDIT W DELETE VPC NETWORK
vsz-demo

::: VPC netwaork
=
i}

External IP addresses

@&  Bring your own IP

EE  Firewall
Regional

¢  Routes
DNS server policy

< VPC network peering None

P4 shared VPC Maximum transmission unit
1460

Serverless VPG access

-|ﬁ|- Packet mirroring

Subnet creation mode
Custom subnets

Dynamic routing mode

< SUBNETS STATIC INTERNAL IP ADDRESSES FIREWALL POLICIES FIREWALL RULES ROUTES VPC NETWORK PEERING >

ADD FIREWALL RULE DELETE

T Filter Enter property name or value 2] m
D Name Type Targets Filters Protocols / ports Action
O vsz- Ingress vsz-demo IP ranges: a Allow A
cluster 10.0.0.2/32,
192.0.0.2/32
D vsz-ctrl- Ingress vsz-dema IP ranges: 1cp:21,22,91,443,2084,4443,7443,8022,8090,8099,8100,8200,82 Allow ~
mgmi 0.0.0.0/0 22,8280,8443,9080,9443,9997 5998

udp:67-69,161,546,547,3799,5353,12223,33434-33534

Creating a Virtual Machine Instance

Follow these steps to create a new virtual machine (VM_ instance).

1. From Google Developers Console, click Compute > Compute Engine > VM instances.

The VM instances page appears.

FIGURE 134 The VM instances page

Google Cloud Platform 0

Compute Engine VM instances K CREATE INSTANCE & IMPORT VM C

VM instances
Filter by label or name Columns = Q@ Labels

Instance groups

RUCKUS Virtual SmartZone Getting Started Guide

Part Number: 800-72269-001 Rev G

159



Installing vSZ on the Google Computing Engine
Creating a Virtual Machine Instance
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2.

Click Create Instance.

The Create an instance page appears.

FIGURE 135 The Create an instance page

Compute Engine

VM instances

Instance groups
Instance templates
Disks

Snapshots

Images

Committed use discounts
Metadata

Health checks

< Create aninstance

Name

vsz-test

Zone

us-east1-b

Machine type

4vCPUs

Boot disk

——  Mew 10 GB standard persistent disk

)
I\EJ

= 18 GB memory

Image
Debian GNU/Linux 8 (jessie)

Customize

Change
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Creating a Virtual Machine Instance

3. Configure the new VM instance that you are creating by filling out the boxes below.
a) In Name, type the name of the VM instance.
b) InZone, select a zone from the drop-down list.
c) InMachine type, accept or modify the default values for vCPUs and Memory.

d) Under Boot disk, click Change. The Boot disk page appears. Click Custom images.In Show images from, select the storage bucket
where you uploaded the controller image, and then select the image. Click Select.

e) InProject access, allow API access as appropriate.

FIGURE 136 Creating a new VM instance

Boot disk

Select an image or snapshot to create a boot disk; or attach an existing disk. Can't find what you're looking for? Explore hundreds of VM solutions in Marketplace.

Public images = Custom images = Snapshots | Existing disks

Show images from
TDC-5T -

Show deprecated images
Image
vsz-r60-1331 -

Created on Mar 29, 2021, 10:18:24 AM

Boot disk type Size (GB)

Balanced persistent disk - 150

f)  InFirewall, select the options as appropriate.
g) InProject access, allow APl access as appropriate.

h) In Management, ensure that the tag provided is the same as the one provided while creating a firewall rule. This ensures port
mapping happens correctly.
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FIGURE 137 Management Tab

Management Disks Networking SSH Keys

Description (Optiona

Labels

Key Value
vsz empty

+ Add label

i) InDisk, select the options as appropriate.

FIGURE 138 VM Disk Configuration

Management Disks Networking SSH Keys

Deletion rule
+/ Delete boot disk when instance is deleted

Encryption

Automatic (recommended)

Additional disks

<+ Add item

Less

You will be billed for this instance. Learn more

Equivalent REST or command line

j)  In Networking, select the external options as per the following table.
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FIGURE 139 Networking

= Google Cloud Platform $e TDCST + Q,  Search products and

& Create an instance
Management Security Disks MNetworking Sole Tenancy
MNetwork tags Dpticna
vsz-demo €

Hastname
Set a custom hostname for this instance or leave it default. Choice is permanent

vsz-demo-nodel_c.tdc-stinterna

Network interfaces
Metwork imerface is permanenm

Network interface Y

Metwaork

v5Z-demo "
Subnetwork

vsz-demo (10.0.0.0/9) -

Primary internal IP

vsz-demo (10.0.0.2) -

Show alias IP ranges

External IP

vsz-dema-nodel-extip (35.221.214.25) v

Network Service Tier
Premium

IP forwarding

On -

Public DNS PTR Record
Enable

Done || Cancel

=+ Add network interface

External IP Options Description

Ephemeral The VM is assigned a dynamic public IP address

None The VM instance is not assigned an external IP address
New static IP address The VM is assigned a static public IP address

RUCKUS Virtual SmartZone Getting Started Guide
Part Number: 800-72269-001 Rev G 163



Installing vSZ on the Google Computing Engine
Creating a Virtual Machine Instance

k) In SSH Keys, select the options as appropriate.

FIGURE 140 SSH Keys

Management Disks Networking SSH Keys

These keys allow access only to this instance, unlike project-wide SSH keys Learn more

Block project-wide SSH keys
When checked, project-wide SSH keys cannot access this instance Learn more

Enter entire key data

-+ Add item

Less

You will be billed for this instance. Learn more

I)  Click Create. The VM instances page appears listing the new VM that is created.

FIGURE 141 The new VM appears on the list of VMs

VM instances [ CREATE INSTANCE & IMPORT VM C REFRESH SHOW INFO PANEL
® 12 instances could be resized to save you up to an estimated $190 per month and increase performance. Learn more Dismiss all
- e n e Columns ~

Name ~ Zone Recommendation Internal IP External IP Connect
& fresh50-524 asia-eastl-a @ Increase perf. l ' SSH ~ H
@ instance-1 us-centrall-c [ | SSH ~ :

You have completed creating a virtual machine instance.
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Installing vSZ on Amazon Web Services

©  INSTAIIING AWS CLL ettt ettt ettt et e bt e e a e s et e et e e s st e sab e e s bt e s e e sabeeabeeab e e bt e nabeeabeeabe e st e sabeeabeeseessbesaseenseensaens
o Creating @ VM IMPOIt SEIVICE ROIE........uiiiiiiieiiee ettt ettt e e et e e s ba e e s bt e e ebaeeeabeesssaeeessbeaessseeensseeessssaenssaaans
©  INSTAIIING VSZ ON AWS ...ttt ettt ettt ettt e e et e bt e bt e s ab e s st e et e e s st e s atesabeenstesa b e sabeeab e e bt eeaseeabeeabeenbeesabesaseenseennaes
®  Creating the VSZ INSLANCE......eiiuiiiiieieeit ettt ettt e s e st e bt e bt e s bt e sab e e b e e bt e s st e eabeeabe e st e sabeeabeeseessaesaseeseenseens

e  Configuring AWS for a vSZ Instance...

©  DElEtiNg @ VSZ INSTANCE. ..ceuiieiiiiiteiteete ettt ettt ettt e et e e bt et e bt e s st e sa b e et e e bt e s h b e e a b e e b e e ateeab e et e e bt e ateeabeeabeenteenaaes

Installing AWS CLI

Public cloud solution resource requirement

e  CPU or Memory: Minimum requirement of c4, c5 types and above.

NOTE
Does not support a1, t2, t3 types

e  Storage Requirement (Disk Storage): Minimum requirement of SSD - GP2 150 GB above

NOTE
Any CPU with credit limitation type cannot support.

Select the proper disk size to run vSZ since disk sizes may have different disk |10 performance in each cloud platform.

Ensure that you have created an account with AWS and have the login details for the same.

1. Install pip by running the command

# curl -O https://bootstrap.pypa.io/get-pip.py
# sudo python27 get-pip.py

Install AWS CLI using pip:# pip install

Test the installation by using the command: # aws help

o r 0N

Use the following command to configure CLI:

# aws configure

AWS Access Key ID [None]: xxx

AWS Secret Access Key [None]: xxx
Default region name [None]: us-west-2
Default output format [None]: Jjson

RUCKUS Virtual SmartZone Getting Started Guide
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Creating a VM Import Service Role

Creating a VM Import Service Role
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6. The default region should be the same as the bucket region. Refer to Table for the mapping details. In addition refer to you can also refer

to latest version.

Region Name Region

US East (Ohio) us-east-2
US East (N. Virginia) us-east-1
US West (N. California) us-west-1
US West (Oregon) us-west-2
Asia Pacific (Mumbai) ap-south-1

Asia Pacific (Osaka-Local)

ap-northeast-3

Asia Pacific (Seoul)

ap-northeast-2

Asia Pacific (Singapore)

ap-southeast-1

Asia Pacific (Sydney)

ap-southeast-2

Asia Pacific (Tokyo)

ap-northeast-1

Canada (Central)

ca-central-1

China (Beijing)

cn-north-1

China (Ningxia)

cn-northwest-1

EU (Frankfurt) eu-central-1
EU (Ireland) eu-west-1
EU (London) eu-west-2
EU (Paris) eu-west-3
EU (Stockholm) eu-north-1
South America (S0 Paulo) sa-east-1

AWS GovCloud (US-East)

us-gov-east-1

AWS GovCloud (US)

us-gov-west-1

1. Inthe AWS web interface navigate to AWS dashboard > Identity & Access Management.

RUCKUS Virtual SmartZone Getting Started Guide
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2. Check your account permission by navigating to Users > select your Username > Permissions. Your account should have the permission -
IAMFullAccess.

FIGURE 142 Account Permission

Services Resource Groups - *

Policies » IAMFullACcess

Dashboard

Policy ARN arm:aws:lam: aws:policyTAMFullACcess 6
Groups

Description Provides full access to 1AM via the AWS Management Console
Users
Roles Permissions Policy usage Policy versions Access Advisor
Policies

Policy summary [}JSON

dentily providers
Account seflings L

Credential repon

Encryption keys

3. Create a JSON file called trust-policy.json using the following commands:

{ "Version":"2012-10-17",
"Statement": [
{
"sidm:"r,
"Effect":"Allow",
"Principal": { "Service":"vmie.amazonaws.com"
}!
"Action":"sts:AssumeRole",
"Condition": {
"StringEquals": {
"sts:ExternalId":"vmimport"

}

4, Use the following command to create a role. Specify the name as vmimport and give the option VM Import/Export access.

# aws iam create-role --role-name vmimport --assume-role-policy-document file://trust-policy.Jjson

RUCKUS Virtual SmartZone Getting Started Guide
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5. Create a policy for the service role by creating a JSON file called role-policy.json using the following commands. Replace the bucket name
with the storage bucket name that you created.

{
"Version":"2012-10-17",
"Statement": [
{
"Effect":"Allow",
"Action": [
"s3:ListBucket",
"s3:GetBucketLocation"
]l
"Resource": [
"arn:aws:s3:::<bucket-name>"

]

"Effect":"Allow",
"Action": [

"s3:GetObject"
] 4

"Resource": [
"arn:aws:s3:::<bucket-name>/*"

]

6. Run the following command to attach the policy to the service role created. # aws iam put-role-policy --role-name

vmimport --policy-name vmimport —--policy-document file://role-policy.Jjson

Installing vSZ on AWS

Follow the steps to install vSZ using the AWS web user interface.

Logging into AWS
Follow these steps to login to the AWS site.

1. Click https://aws.amazon.com, to access the Amazon Web Services website.

RUCKUS Virtual SmartZone Getting Started Guide
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2. Login with your user credentials of user name and password.

FIGURE 143 Login with user credentials

dWS

Account ID or alias

VEL

IAM user name

Password

Sign-in using_root account credentials

3. Select My Account > AWS Management Console as shown.

FIGURE 144 AWS management console

Products Solutions Pricing Documentation  Leam  Partner Metwork

AWS Asia Pacific (Hong Kong)

Region

The AWS ng Region is no
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Creating a Storage Bucket
Create storage for the objects you create. Follow these steps to create storage.

1. Navigate to Amazon Web Services > Storage and Content Delivery > S3, click Create Bucket as shown.

FIGURE 145 Create Bucket

Services ~ Resource Groups ~ *

Amazon 53 Block Public Access lets you enforce a "no public access™ policy

Amazon S3
| Buckets ! 53 buckets
Public access Q Search for buckets

settings for this

account
+ Create bucket
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2. Type the name of the storage bucket and select a suitable regional endpoint to reduce data latency.

FIGURE 146 Selecting regional endpoint
Create bucket

(D Name and region @j Configure options @) Sel permissions

Name and region

Bucket name

Region

Copy sethngs from an existing bucket

3. Click Create. The storage bucket you created is listed in the browser.

4. Check the storage bucket has been created.

Uploading vSZ Image to a Storage

Follow these steps to upload a vSZ image to the storage bucket you created.

1. Select the storage bucket to upload the vSZ image.
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2. Click Upload as shown.

FIGURE 147 Selecting the Storage

Services ~ Resource Groups ~ *

Overview

Type a prefix and press Enter o search. Press ESC 1o clear
Tk H

3. Browse to the location of the vSZ image and select vSZ image file.

Only images with file-type *.raw or .ova or vmdk can be selected.

4. Click Start Upload to upload the file. The upload process is displayed.

5. Theimage is listed in the storage bucket after the image is uploaded.

FIGURE 148 vSZ Image Uploaded to Storage Bucket

Mame -

[ wecg-25.000 832 ova
[ wscg-35.1.0 255 ova
[ vscp-360050.0ma
[ vscp36.1.022.ma
[ wscg-5.1.000.456 ova

O wecge51.1.0.589 0va

NOTE

The vSZ image should be in the Bucket, which has Region information. Example:

AWS Service Policy

Last modified =

Mar 23 2018 21017 Pl GMT+0800

Mar 23 2018 920 30 AN GMT 0800

Feb 12 2018 13656 FM GIMT 0800

Mar 8, 2018 11:29:19 AW GMT+0500

Mow 20, 2018 1:55:29 P GMT+0B00

Apr 27, 2009 B2l 44 AN GMT+0800

Permissions

Management

US East (M. Virginla) &

Viewing 1 to 6
Sige - Slorage class »
1168 Slandard
10G8 Slandarg
10G8 Standarg
10GB Slandard
13 GB Slandand
13G8 Slandard
Wizwing 1 to 6

Test_bucket

VM Import uses a role in your AWS account to perform certain operations (for example, downloading disk images from an Amazon S3 bucket). You
must create a role with the name vmimport with the following policy and trusted entities.

1. Install the AWS CLI by following the instructions at http://docs.aws.amazon.com/cli/latest/userguide/installing.html

2. Enter the following command in the AWS CLI #sudo pip install awscli.
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3. Get the access key for the AWS CLI by following the instructions on the AWS website.
4, Add the access key details to the AWS CLI using the following commands

# aws
configureAWS Access Key ID [None]:
AWS Secret Access Key

[None]: Default region name [None]:
us-west-2Default output format
[None]: json

5. Create a file named role-policy.json with the following policy:

{
"Version":"2012-10-17",
"Statement": [
{
"Effect":"Allow",
"Action": [
"s3:ListBucket",
"s3:GetBucketLocation"
] 4
"Resource": [
"arn:aws:s3:::<disk-image-file-bucket>"

}7
{
"Effect":"Allow",
"Action": [
"s3:GetObject"
]l
"Resource": [
"arn:aws:s3:::<disk-image-file-bucket>/*"

"Effect":"Allow",

"Action": [
"ec2:ModifySnapshotAttribute",
"ec2:CopySnapshot",
"ec2:RegisterImage",
"ec2:Describe*"

] r

"Resource":"*"

6. Replace <disk-image-file-bucket> with the appropriate Amazon S3 bucket where the disk files are stored. Run the following command to
attach the policy to the role created above:

7. Replace <disk-image-file-bucket> with the appropriate Amazon S3 bucket where the disk files are stored. Run the following command to
attach the policy to the role created above aws iam put-role-policy --role-name vmimport --policy-name vsz34-policy --policy-document
file://role-policy.json
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Importing the vSZ Image

Follow these steps to import the vSZ image into AWS shared AMI.

1. Create a JSON file called import.json using the following commands. Replace the bucket name with the storage bucket name that you

created. In this example, the vSZ image file name is vscg-3.4.0.0.750.ova.

{
"Description": "Import vSz",
"DiskContainers": [

{

"Description": "vSz 3.4.0.0.750",
"UserBucket": {
"S3Bucket": "<bucket-name>",

"S3Key": "vscg-3.4.0.0.750.0va"

2. Run the following command to attach the policy to the role created. # aws ec2 import-image --cli-input-json file://import.json

3. The system displays the below response.

{

"Status": "active",
"Description": "Import vSz",
"Progress": "2",

"SnapshotDetails": [
{
"UserBucket": {
"S3Bucket": "<bucket-name>",
b
"DiskImageSize": 0.0
}
I
"StatusMessage": "pending",
"ImportTaskId": "import-ami-ffgofOwl"

"S3Key": "vscg-3.4.0.0.750.0va"

4, Check the status of the import vSZ image by running the following command. Ensure to enter the correct import task identifier.# aws ec2

describe-import-image-tasks --import-task-ids "import-ami-ffgofow1"

5. You will see the following converting status response. Check the status until the converting is complete. The estimated time for conversion

is 30 minutes.

"ImportImageTasks": [
{
"Status": "active",
"Description": "vSZ test",
"Progress": "28",
"SnapshotDetails": [
{

"UserBucket": {

"S3Bucket": "<bucket-name>",
"S3Key": "vscg-3.4.0.0.750.0ova"

}7

"DiskImageSize": 964430848.0,

"Format": "VMDK"
}
i
"StatusMessage": "converting",
"ImportTaskId": "import-ami-ffgofOwl"
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Creating the vSZ Instance

Follow these steps to create a vSZ instance on AWS.

1.

2.

FIGURE 149 Select EC2

11l

AWS v

From Amazon Web Service, click Compute > EC2.

Services v

Amazon Web Services

Compute

N =C2

= | =1 a ¥
Al =

Instances

Launch Templates
Spot Requests
Reserved Instances
Dedicated Hosts
Scheduled Instances

Capacity
Reservations
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FIGURE 150 Select AMI
E}ES Services ~ Resource Groups ~ *
EC2 Dashboard m Actions
Events
Tags Ownedbyme v (] search: 2618 Add filter
Repons
B Hame AMI Name
Lirnits
B v5751.1.0589% inctallation impuﬂ—ami—ﬂdSEdachh[ﬂaEm3I

Installing vSZ on Amazon Web Services
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AMIID

ami-03481854212a77000

Source

16090281656

Navigate to Images > AMIs to ensure that the imported Amazon Machine Image (AMI) exists. In this example the AMI file is import-ami-
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3. Navigate to Network & Security > Security Groups > Create Security Group. Security group acts as a virtual firewall that controls the
traffic for one or more instances.

FIGURE 151 Create Security Group

a_"ﬁ.l"u_"S Services ~  Resource Groups ~ *
Scheduled Instances Create Security Group |[JCI-iLlE R
Capacity
Resenvations i 3 search : example Add filter
= B HName =  Group ID =  Group Name = WVWPCID
AnIs

Bundle Tasks [ ] 50-0561893ciclccd5ds example_security_group vpe-ce3043aa

Volumes
snapshots

Lifecycle Manager

Security Groups

Elastic IPs

Placement Groups
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4.

Installing vSZ on Amazon Web Services

Creating the vSZ Instance

Define the setup group name, description, ports and the firewall rule. The table lists the common service ports. For more information, see
Ports to open for AP-vSZ communication.

Port Number
ubP

161

12223

TCP

21

22

91

443

7443

8022

8080

8443

8090, 8099
8100

9998

9080, 9443
16384-65000

Description

SNMP

ZD AP forward update using FTP (control connection)

ZD AP forward update using FTP (control connection)

AP SSH

AP forward update using HTTP

Allows AP get SSH private key and do AP FW udpate via HTTPs
Public API

SSH for management (mgmt-acl is enabled on 1 nic v5Z)

vSZ setup wizard using the web user interface (User will be redirected to the port 8443)
vSZ web user interface

WISPr for non-web-proxy user equipment

WISPr for web-proxy user equipment

Tomcat for WISPr (internal WISPr portal uses the port 9998)
Northbound API (NBI)

ZD AP forward update using FTP (data connection)
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FIGURE 152 Define Security Group

Create Security Group

Security group name |
Description [
VYFC (] vpc-ce9043aa (default)
Security group rules:

Inbsound Cutbound

Type (i Protocel (i Port Range (i Destination
All raffic v Al 0 - 65535 Curstom v
Add Rule
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5. Navigate to Instances and click on Launch Instances. Follow these steps.

a) Launch Instance

FIGURE 153 Launch instances

Services Resource Groups ~ *
ECZ2 Dashboard - Launch Instance - | Actions ¥
Events
Tags « Q search:eric Add filter
Reporis
Name = Instance ID « |nstance Type -~
Limits

i-04b341800af122175  t2.xlarge

Instances

Launch Templates
Spot Requests
Reserved Instances
Dedicated Hosts
Scheduled Instances

Capacity
Reservations

b) Navigate to My AMIs and choose the Amazon Machine Image (AMI) that you imported previously.

FIGURE 154 Choose the imported AMI
Step 1: Choose an Amazon Machine Image (AMI)

Ar AN 15 2 Bhal o oftveare config cperating sy N SEnEr, and applicalions) required bo launch your Inslance. You can seiect an AWM prowidsd by JWE, Sur user community, of the

a [impon-ami-0435dactcbiBaze 18] am-034818542 1eeT O m

AWS Marketplace

Community AMIS

c) Click Next.

d) Choose a suitable instance type. In this example the instance type is m4.xlarge. Based on the number of APs and client counts, select
the instance type to fit the recommended system resources.
The minimum memory and CPU requirements have changed in this release. You may need to upgrade your infrastructure before
upgrading. Please read carefully. This is the minimum requirement recommended. Refer to Table 5 and Table 6 in the chapter
Preparing to Install the vSZ.
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FIGURE 155 Choose the instance type
Step 2: Choose an Instance Type

General purpose 2. nano 1 0.5 EBS only
General purpose t2.iTD 1 1 EBS only
General purpose 1 2 EBS only
General purpose t2. medium 2 4 EBS only
General purpose t2 large 2 8 EBS only
. General purpose 12 xiarge 4 16 EBS only
General purpose 12 2xlarge B 32 EBS only

e) Click Next.
f)  Select the required network, subnet, and private IP address.

The private IP address cannot be changed once the vSZ image is launched.

FIGURE 156 Configure the instance
Step 3: Configure Instance Details

Configure the instance to suill your requirements. You can launch muitiphe instances from he same AMI, reques! Spol instances to take advantage of the lower pri

and mare.
Mumber of instances (| 1 Launch into Auto Scaling Group (J
Purchasing option (| Request Spot instances
Network (i vpc-ce9043aa (default) | & Create new vEC
Subnet [ Mo preference (defaull subnet in any Availability Zom * Create new subnet
Auto-assign Public IP [ LUse subnet setting (Enable) v
Placement group [ A Instance 1o placement group
Capacity Reservation  [j open v| & create new Capacity Resenvation
1AM role [} None v| & Create new 1AM role
Shutdown behavior (i Stop v
Enable termination protection [ Protect against accidental lemination
Monitoring (i Enable CloudWatch detailed monitoring
Additional charges apply
g) Click Next.

h)  Change the size of storage as required.
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FIGURE 157 Change the storage size

1.ChooseAMI 2. GhooseInstance Type 3. Configure Instance 4. Add Storage 5. Add Tags 6. Configure Security Group 7. Review

Step 4: Add Storage
Your instance will be launched with the following storage device settings. You can attach additional EBS volumes and instance store volumes to your instance, or
edit the settings of the root volume. You can also attach additional EBS volumes after launching an instance, but not instance store volumes. Learn more about

storage options in Amazon EC2.

Volume Type (i Device (i Snapshot ( | ) Size (GiB) (i Volume Type (i IOPS (i ;:I‘g:)gh?m Delete on Termination (i Encryption | | )
Root Idevisdal snap-0226eb206eb46f1ad [150 | | General Purpose SSD (gp2) ~| 45043000 N/A a Not Encrypted v

Add New Volume

Free tier eligible customers can get up to 30 GB of EBS General Purpose (SSD) or Magnetic storage. Learn more about free usage tier eligibility and
usage restrictions.

i)  Click Next.

j)  Specify the vSZ instance by giving it a name.

FIGURE 158 Specify the vSZ instance
Step 5: Add Tags
A 1ag consists of a case-sensitive key-value pair. For example, you could define a tag with key = Name and value = Webserver

A copy of a tag can be applied to volumes, instances or both.
Tags will be applied to all instances and volumes. Learmn more about tagging your Amazon EC2 resources

Key (127 characters maximum) Value (255 characlers maxirmum)

MName vSZ5.1.1.0.589-installation

k) Click Next.

I)  Create a new security group or select an existing group. Configure the rules if required.

FIGURE 159 Specify the security group
Step 6: Configure Security Group

A, SECUMY rouD 1S & Sel of Sreswall rukes That conlrol T Fafc fon your instance. On NS DAJE. you Can add rules. o altw Specic WAl b0 resch your nstance. For exampie, if you wanl 1o Sel up & wed Server and alkn
rhemed rAfic Ao Meach your instance. add rules That allow UnPesinicied access to the HTTF and HTTFS ports. YOu can CPease 3 Rew Securily group of select from an £xsing one beiow. Learn mone about Amazon EC2

SeCurty Qroups:

[Assign & security graup: S Create 3 mw secuity groug |

Select an sxisting securty group

Securiny group name:

Dwseripticn; Bunch-wizand-3 creabed 2019-04-20T15.36:45.819+08 00
Tips i Pratecal || Part Range | Source | Dagcrgticn i
53H v TCP 22 Arprahere v | DVDUDAD, S0 [ S5H for A

m) Click Next.

n) Review the configuration settings.
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FIGURE 160 Review the configuration settings
Step 7: Review Instance Launch

FiEase revitw your instance launch detais. Yoo can go back to edil changes for each seciion. Click Launch to assign a key pair o your nstance and complete the: lnch process

~ AMI Details

4

Edit AN
impart-ami-0a35dacicbiBai18 - ami-03481854 1 1eeTTO00
ANS VMimpsnt sarvics: Lisus - ComiOS relsase 5.8 (Final) - 7 5 327506 3.5 511 0vks. o5 <85 _Ed

Fooel Device Typa- ehs  Viruakzadon by mm

= Instance Type Edit inslance typs

Insiance Type ECUs vCPUs Memary (GiB) Instance Storage (GE) EBS-Optimized Available Metwork Performance

12 wiange Warabe 2 16 EBS only - Moderale

= Security Groups Edit S@curily groups

SHcufity group name BUnCR-wZan-9
Dascription Bunch-wizard-3 crealed 2019-04-30T15:36:45 81908 00
Troe (i Protosal (| Por Rangs | Saures (| Daseription (|
S5H TCP Iz 8 I T
b Inetanca Mataile -

Friit instanra dedails

Carcel Previcus m

o) Click Launch

p) Select the Proceed without a key pair for vSZ instance.

FIGURE 161 Select existing key pair

Select an existing key pair or create a new key pair b 4

A key pair consists of a public key that AWS stores, and a private key file that you store. Together, they
allow you to connect to your instance securely. For Windows AMIs, the private key file is required to
obtain the password used to log into your instance. For Linux AMIs, the private key file allows you to
securely SSH into your instance.

Mote: The selected key pair will be added to the set of keys authorized for this instance. Learn more
about remaving existing key pairs from a public AMI .

lProceed without a key pair v

¥/ | acknowledge that | will not be able to connect to this instance unless | already know the
password built into this AMI.

Cancel Launch Instances

q) Verify that the vSZ instance is running. Connect the vSZ instance with the selected key pair using the SSH interface.
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Configuring AWS for a vSZ Instance

Follow these steps to configure AWS for creating and launching a vSZ instance.

Attach a New Disk Volume

Follow these steps to add a new disk volume.

1. Navigate to EC2 Dashboard > Elastic Block Store > Volumes and click Create Volume as shown.

FIGURE 162 Create Volume

O N 2 merenc® x Actons ~ Lot o
EC2 Dashboard New Q search : vVSZH Add filter 9 1to10f1
Events
. Name ~ VolumelD -~ Size ~  Volume Type - IOPS - Throughput- Snapshot - Created ~  Availability Zone - State - Alarm Status. Attach
Limits vSZH-R6.0-1331 vol-06507b3. 150 GiB gp2 450 - snap-0226eb2.. March 29, 2021 at 1 ap-northeast-1a @ in-use None Y 0238
¥ Instances

Instances New

Instance Types

Launch Templates

Spot Requests

Savings Plans

Reserved Instances New
Dedicated Hosts

Capacity Reservations

<

Images

AMIs

Elastic Block Store Select a volume above _J_ Q=]

<

Volumes
Snapshots

Lifecycle Manager

4

Network & Security
Security Groups New

Elastic IPs New
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2. Enter the required disk type, size and availability zone.

FIGURE 163 Create Volume

Volumes > Create Volume

Create Volume

Volume Type = General Purpose SSD (gp2) v @

Size (GiB) ‘ B ‘ (Min 1 GiB, Max: 16384 GiB) (i ]
IOPS 450/3000 (Baseline of 3 |0PS per GiB with a
minimum of 100 I0PS, burstable to [i]
3000 I10PS)

Throughput (MB/s) Not applicable €@
Availability Zone* = ap-northeast-1a vy 0
SnapshotID | Select a snapshot v C e

Encryption () Encrypt this volume

Key (128 characters maximum) Value (256 characters maximum)

This resource currently has no tags

Choose the Add tag button or click to add a Name tag

Add Tag | 50 remaining  (Up to 50 tags maximum)

* Required

Feedback  English (US) ¥

Privacy Policy ~ Termsof Use  Cookie preferences

3. Click Create.

4. Right click on the newly created disk and select Attach Volume. Enter the instance identifier and the desired device name.

FIGURE 164 Attach Volume

Attach Volume X

Volume i vol-05e3eb908dae01232 in us-east-1a
Instance (j Search instance ID or Name tag In us-€asl-1a
Device (j

5. Click Attach.
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Allocate a Public IP Address

Follow these steps to allocate a public IP address.

1.

2.

RUCKUS Virtual SmartZone Getting Started Guide

EC2 Dashboard
Tags
Reports

Limits

Instances

Launch Templates
Spot Requests
Reserved Instances
Dedicated Hosts
Scheduled Instances

Capacity
Reservations

AMIs
Bundle Tasks

Volumes
Snapshots

Lifecycle M anager

Security Groups

Elastic IPs

Click Create.

Part Number: 800-72269-001 Rev G

FIGURE 165 Allocate New IP Address

Allocate new address Actions ¥

(), Filter by tags and attributes or search by keyword

Elastic IP

Installing vSZ on Amazon Web Services
Configuring AWS for a vSZ Instance

Navigate to EC2 Dashboard > Network & Security > Elastic IPs. Click Allocate New Address as shown.
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3. Right click on the newly created IP address and select Associate Address. Enter the instance identifier or network interface and the

desired device name.

FIGURE 166 Associate Address

ciac! the mtarce OF neteork inlerdaoe bo which you wan! 1o asccise i Eastic I addess

ReRource fype L i

Matwork interface t a nebwork in -
Preaaty 19 1 prteal - 0
Foeas s oo Allcw Elasic IF io be rexssocated if ainesoy anached
i
ahe an El with your instal bi
* Reguines

4. Click Associate.

Change Security Group
Follow these steps to change the security group.

1. Navigate to Instances and right click the target instance.

2. Select Network > Change Security Group.
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3. Select the security groups.

FIGURE 167 Allocate New IP Address

Change Security Groups

Instance 10:-040341800aM 22175
Interface ID:eni-073b6cdcde 2183023

Select Security Group(s) to associate with your instance

Security Group ID Security Group Name Description
- s s z " Ll o i
o £0-0561893cic0ecd5ds exampile_security_group example_security_group

erl| Assign Security Groups

4. Click Assign Security Groups.

Deleting a vSZ Instance

Follow these steps to delete a vSZ instance on AWS.

1. Navigate to Instances and right click to select the vSZ instance that you want to delete.
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2. Select Instance State > Terminate.

FIGURE 168 Select terminate

Connect

Create Template From Instance

Launch More Like This

Instance Settings
Image

Networking
CloudWatch Monitoring

3. Confirm deletion of the vSZ instance by clicking on Yes, Terminate. The vSZ instance is deleted from AWS.

FIGURE 169 Confirm termination of vSZ instance

Terminate Instances X

VAT . I

jl vWarning
On an EBS-backed instance, the default action is for the root EBS volume to be deleted when the
instance is terminated. Storage on any local drives will be lost

Are you sure you want to terminate these instances?
« |-04b341800aM 22175 (VSZ-5.1.1.0.589, ec2-54-173-T4-195 compute-1_amazonaws.com)

Clean up associated resources

Associated resources may incur costs after these instances are terminated

P Delete EBS volumes

Cancel Yes, Terminate
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Configuring the Virtual Machine Interfaces

o Configuring the Virtual Maching INTEITACES. ....cccuviiiiiiiciieeee ettt ettt e e eabe e e sta e e e tb e e eabeeessbeeessseeesssaaesnseeas
o Setting Up the VSZ With ONe INtEITACE......ccciiiiiiecee ettt et e e e e s tb e e e ateessbeeeabeeesbeeessbeeessseeenssaaennseeens
o Setting Up the VSZ With THIree INTEITACES. ...ccvviiieieeceee et ettt e e st e e e st e e s beeessbaeessbaeessbaeesssaaesnsaeas
e Important Notes About Selecting the System Default GateWay.........c.uieeiiiiiiiiiiiiiccieeceee et e

Configuring the Virtual Machine Interfaces

The vSZ comes with the option to operate with either one (1) network interface or three (3) network interfaces. Therefore the procedure for setting

up the vSZ interface depends on the number of interfaces that it has.

Follow the procedure below that corresponds to the number of interfaces that the vSZ you are installing has:
e  Setting Up the vSZ with One Interface on page 189
e  Setting Up the vSZ with Three Interfaces on page 202

NOTE

By default, the VMWare ESXi package comes with three network interfaces. If you want to deploy the vSZ with only one interface, you can

edit the virtual machine settings to remove the extra interfaces. The KVM package, on the other hand, comes with a single interface. If
you want to deploy the vSZ with three interfaces, edit the virtual machine settings to create two additional interfaces.

Setting Up the vSZ with One Interface

Follow these steps to set up the vSZ with a single network interface

1. Logon to the console using; User name: admin Password: admin

2. Atthe vSZ> prompt, enter en to enable privileged mode.
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3. At the Password prompt, enter admin. The vSZ# prompt appears.

FIGURE 170 At the vSZ> prompt, enter setup

HEARHERNHERRER A AR RERE
Welcome to wiE #
BEAHEHBUUHBHUERRRRANUERENNBRHEE
Z login: admin
Word :

wait. CLI initializing...

4. Enter setup. The console displays the current network settings (if any), and then displays the following prompt: Do you want to setup

network? [YES/no]

5. Enter YES. The next screen prompts you to select the profile configuration that you want to use for this instance of vSZ. The options

include: (1) High-Scale (2) Essentials
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6. Enter the number that corresponds to the profile configuration that you want to deploy.

If you selected Essentials and the virtual machine has insufficient memory resources available (for example, the VM has only 8GB of RAM
when the minimum RAM requirement is 12GB), you will be unable to continue with the setup process.

FIGURE 171 Enter the number that corresponds to the profile that you want to deploy

login: MHon Apr ££2 BZ:54:15 on ttyl
wait. CLI initializing...

ssword @ wessn

USER setup

HHBRuEdE R RN RO R R
Start v8Z setup process:
HEBHUNUBRHRERHRHERUUERRERRURBRNHNBERHEEIRRER Y

1. Ezssent
2. High I

nter "

& Profile (1
ARN I You cannot ch L profile once uou complete setup. Are you sure
you want to insta the ntials" 27 (ysndlY]
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7. EnterY for confirmation. At the IP Version Support prompt, enter one of the following options: 1: IPv4 Only 2: IPv4 and IPvé.

FIGURE 172 Configure the IP address settings of the single interface

# zetup

sEEEPEEEERE R R R EERS VBN B REE LR
Gtart viZ setup process:
HESHBHBRHEBRUERRUBREUERERUREBHHERRERERERERRUBRRREY

o e e e e e e e e e e e e e e e e
| . ¢ -
Profile

o e S ek g B S gk B e S BB e S B db e S e gl b B b S BE e g S B deh W -SE

ation.
O e el e e e e e B e e DB e e O e e

Profile (1 1

ou cannot change the profile once you complete setup. Are you sure
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8. The IPv4 address setup for Control, Cluster, Management option appears. At the Select IP configuration prompt, enter 1 for Manual and
2 for DHCP.

FIGURE 173 Configure the IP version setup
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9. At the Primary DNS Server prompt, enter the primary DNS server on the network.

10. At the Secondary DNS Server prompt, enter the secondary DNS server (if any) on the network.
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11.

194

Enter y to apply settings.

FIGURE 174 Apply Settings

] v IR - PRIy ey oo | 55 o i
IF Uersion Support Settings:
ot e S o o L W S e ek S e B e B e Sk e e ek e B e S B e BB e

IF U ion Support : IPwd omly

Interface IPvd zettings:
LR B R W e e e e B e D e e O O e e e e e e e e

Control ,Cluster , Management :

19£.1668.18.96
54

g S o3 S e S O St B S -6 S S g de S E S-S S g O SE
d.6.8.68
: 8.8.4.4

e e e T e T D e B e e e e T e el B e e B e

F 'y' to apply, ‘n’

o you want to apply the (ysm) y

Ple: wait while figures the network.
It may take a few minute

RUCKUS Virtual SmartZone Getting Started Guide
Part Number: 800-72269-001 Rev G



Configuring the Virtual Machine Interfaces
Setting Up the vSZ with One Interface

12. To accept settings enter y. Else, enter n

FIGURE 175 Accept Settings
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13. To setup a network, enter y. Else, enter n.

FIGURE 176 Network Setup
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14. Choose the option for cluster setup. Enter ¢ to create a new cluster or j to join an existing cluster.

FIGURE 177 Cluster Setup
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15. Enter the following information:
o  Cluster Name
e  Controller Description

Create/Join cluster, DISCOVERY PROTOCOL, Cluster Name, Blade ID, and DESCRIPTION are created by the system.
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16. When the prompt Are these correct? (y/n) appears, enter y to confirm the cluster setup. Enter the controller name of the blade and enter

y to specify if the controller is behind NAT. Else, enter n.
FIGURE 178 Configure Cluster Setup
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17. To Convert ZoneDirector APs in factory settings to vSZ APs to vSZ APs automatically, enter y, else enter n.

FIGURE 179 Converting Factory Settings to vSZ Settingsl

(=201 R s-cluster-1
oller De: ption: w3Z-E-1

St e BE LB SR B0 U B BE LR U S O OO0 BE i B0 st e B i e BE BE e
Join : create
¥ PROTOCOL: tcp
Hame ! RBuckus-cluster-1
cfalBcl1B8-44da-48ce
E-1

correct [ )iy
ontrol ler name of e blade ([a-zA-Z
troller behind NAT (ysm) n

UTC Time: 2819-84-22 B6:83:19 UTC
rver ([ 1-9.-1): [ntp.ruck
Check if N

synchromization: £813-H4-££ HG6: £4
factory settings to

admin’ s

admin

admin

the CLI able

“nter the CLI enable assword again:

18. In Reset admin's password, press <Enter>.
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19. Enter the following information:
e  Enter the admin password
e  Enter the admin password again

e  Enter the CLI enable command password

e  Enter the CLI enable command password again

The password reset confirmation appears and starts setup process.

FIGURE 180 Admin Password Reset
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20. The setup process begins and checks for system capabilities.

FIGURE 181 Checking System Capabilities
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e If the system capability is invalid an error message appears.

FIGURE 182 System Capability Error Message
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FIGURE 183 Setup Process Begins
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You have completed configuring the vSZ interfaces. You are now ready to run the vSZ Setup Wizard. See on
page 205.

1. Log on to the console using the following credentials: User name: admin Password: admin
2. At the vSZ> prompt, enter en to enable privileged mode.

3. At the Password prompt, enter admin. The vSZ# prompt appears.
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4.  Enter setup. The console displays the current network settings (if any), and then displays the prompt: Choose IP Version Support (either
1. IPv4 only or 2. IPv4 and IPvé)
FIGURE 184 At the vSZ> prompt, enter setup
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5. At the Select IP configuration prompt, enter 1 to set up the control interface manually.

6. Configure the IP address, netmask, and gateway of the control interface, and the press <Enter>.

FIGURE 185 Configure the IP address settings of the control interface
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7. At the Select IP configuration prompt, enter 1 to set up the cluster interface manually.

8. Configure the IP address, netmask, and gateway of the cluster interface, and then press <Enter>.

9. At the Select IP configuration prompt, enter 1 to set up the management interface manually.

10. Configure the IP address, netmask, and gateway of the management interface, and the press <Enter>.

Take note of the IP address that you assign to the management interface - you will use this IP address to log on to the vSZ web interface.
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11.

12.

When the message Select system default gateway (Control, Cluster, Management)?, enter Control or Management, depending on your
network topology (see on page 204).

This entry is case-sensitive. Make sure you enter the system default gateway exactly as shown at the prompt.

FIGURE 186 When prompted for the system default gateway, enter either Management or Control (depending on your network design)
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When prompted, enter the primary and secondary DNS server IP addresses.

13. Enter restart network.

You have completed configuring the vSZ interfaces. You are now ready to run the vSZ Setup Wizard. See on

page 205.

Depending on your network topology, you may select either the Management or Control interface as the system default gateway.

204

If all of the managed APs are located in different locations on the Internet, the vSZ may not know all of the IP subnets of these APs. In this
case, the control interface should be set as the default gateway for the vSZ and you will need to add a static route to reach the
management network.

If all of the managed APs belong to a single subnet or to multiple subnets on which you can set the route statically, then you can set the
management interface as the default gateway users can set default gateway for the vSZ and set static routes for the vSZ to reach all of its
managed APs.
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Before You Begin

The Setup Wizard helps you perform the initial configuration of the vSZ by presenting the vSZ configuration options in a set of easy-to-complete

screens.

The Setup Wizard will prompt you to select one of the two available profile configurations (High-Scale profile and Essentials profile). You must select
the profile configuration that corresponds to the vSZ license that you purchased. Before you start the Setup Wizard, make sure you know the profile
configuration that you need to select. If you are unsure which profile configuration you need to select, contact Ruckus Networks Support.

Follow these steps to run and complete the vSZ Setup Wizard:

Start the Setup Wizard and Set the Language

Select the Profile Configuration That Corresponds to Your vSZ License
Configure the Management IP Address Settings

Configure Dual Mode IP Address Settings Using CLI

Configure the Cluster Settings

Set the Administrator Password

Verify the Settings

NOTE

This guide describes the Setup Wizard screens that appear when you select the High-Scale profile configuration. If you select the
Essentials profile configuration, the screens that appear may be slightly different.
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Step 1: Start the Setup Wizard and Set the Language

1.  Start your web browser, and then enter the following in the address bar: https://{management-IP-address}:8443, where management-IP-
address is the address you assigned to the management interface. The vSZ Setup Wizard appears, displaying the Language page.

FIGURE 187 The Language page
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2. Select your preferred language for the vSZ web interface. Available options include:

e  English
e  Traditional Chinese
e  Simplified Chinese
3. Click Next. The Profile page appears.

Step 2: Select the Profile Configuration That Corresponds
to Your vSZ License

1. Select the profile configuration that corresponds to the vSZ license that you purchased. Available profile configurations include:

o  High Scale

e  Essentials

FIGURE 188 Select a profile configuration that matches your vSZ license
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2. Under Profile Tool, click Use Tool to configure a SmartZone profile. The system capability is checked and an error message is displayed if it

is invalid.

FIGURE 189 System Capability Invalid
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3. Inthe SmartZone Profiles page, enter the number of APs and switches, type of SmartZone network controller, and click Submit.

The following is an example to configure a SmartZone profile.

SmartZone Profiles

Enter the number of APs/Switches in your network to find out which SmartZone profile you should use.

Numberof APs o0 |
Number of Switches: 1@ |

Type of SmartZone network controller:

Virtual SmartZone Essentials (vSZ-E) ®

Virtual SmartZone High Scale (vSZ-H)

Recommendation:

You should be using profile vSZ-E L2 with 1 to 2 nodes.

Per Node Information:

Disk Size

8 core 18 GB 250 GB

4. Click Next. The Confirmation message appears. Once you accept the confirmation, the Management IP page is displayed.

Step 3: Configure the Management IP Address Settings

While installing vSZ on Cloud, always use DHCP.

The vSZ comes in either a single network interface or three network interfaces (one interface each for Control (AP), Cluster, and Management (Web)
traffic). The following procedure assumes that the vSZ you are installing uses a single network interface.
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If the vSZ that you are installing comes with three network interfaces, you must configure each of the three interfaces to be on three different
subnets. Failure to do so may result in loss of access to the web interface or failure of system functions and services.

208

1. InIP Version Support, select one of the following options:

IPv4 Only: Click this option if you want the controller to obtain an IPv4 address from a DHCP server on the network.

IPv4 and IPvé: Click this option if you want the controller to obtain both IPv4 and IPvé6 addresses from DHCP and DHCPv6 servers on the
network. Refer to Step 4: Configure Dual Mode IP Address Settings Using CLI for configuring dual setup using CLI. This is an alternative

method for configuring IPv4 and IPv6 manually if the DHCP server is not available on the network.

FIGURE 190 Select the IP version support
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2. Configure the IP address settings of the Management interface.

a)

Under the IPv4 section, click Static, and then enter the network settings that you want to assign to the AP/DataPlane interface,
through which client traffic and configuration data are sent and received.

Although it is possible to use DHCP to assign IP address settings to the Control interface automatically, Ruckus Networks strongly
recommends assigning a static IP address to this interface.The following network settings are required (others are optional):

e |Paddress
e  Netmask
e  Gateway

If you clicked IPv4 and IPvé at the beginning of this procedure, under the IPvé6 section, click Auto Configuration if you want the
controller to obtain its IP address from Router Advertisements (RAs) or from a DHCPvé server on the network. If you want to
manually assign the IPvé network address, click Static, and then set the values for the following: IP address (IPv6): Enter an IPvé
address (global only) with a prefix length (for example, 1234::5678:0:C12/123). Link-local addresses are unsupported. Gateway: Enter
an IPvé address (global or link-local) without a prefix length. Here are examples:

Global address without a prefix length: 1234::5678:0:C12

Link-local address without a prefix length: fe80::5678:0:C12

3. At the bottom of the screen, select the interface that you want to set as the default system gateways for IPv4 and IPvé (if enabled), and

then type the Default Gateway, Primary DNS Server address and Secondary DNS Server Address.

The appropriate interface to use as the default system gateway depends on the topology of your network. See Important Notes About

Selecting the System Default Gateway on page 204 for more information.

4. Check the network settings that you have configured.
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5. Click the Next to continue. The controller validates and applies the network settings that you have configured. Continue to Step 5:
Configure the Cluster Settings on page 214

Important Notes About Selecting the System Default Gateway

Depending on your network topology, you may select either the Management or Control interface as the system default gateway.

o If all of the managed APs are located in different locations on the Internet, the vSZ may not know all of the IP subnets of these APs. In this
case, the control interface should be set as the default gateway for the vSZ and you will need to add a static route to reach the
management network.

e |If all of the managed APs belong to a single subnet or to multiple subnets on which you can set the route statically, then you can set the
management interface as the default gateway users can set default gateway for the vSZ and set static routes for the vSZ to reach all of its
managed APs.

Step 4: Configure Dual Mode IP Address Settings Using CLI

The following are the steps to configure the dual setup using CLI. This is an alternative method of configuring IPv4 and IPvé6 manually if the DHCP
server is not available on the network.

1. Using CLI execute the setup command: vSZ# setup

2. InvSZ Profile, choose either 1. Essentials or 2. High Scale.
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3. InIP Version Support, choose 2. IPv4 and IPvé.

FIGURE 191 Choose 2. IPv4 and IPvé to use dual mode IP addresses
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4. Configure the IPv4 address settings that you want to assign to the AP/DataPlane interface, through which client traffic and configuration
data are sent and received.

a) Enter the setup for Control as either:
1. Manual
2. DHCP
b) Enter the IP configuration as 2 (DHCP).
c) Enter following network settings as required:
e |P address
e  Netmask
e  Default gateway

d) Save the networking configuration of Control settings.

FIGURE 192 |IPv4 Control Settings
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e) Enter the setup for Cluster as either: 1. Manual 2. DHCP
f)  Enter the IP configuration as 1 (Manual)
g) Enter following network settings as required: IP address, Netmask, and Default gateway

h) Save the networking configuration of Cluster settings.

FIGURE 193 IPv4 Cluster Settings
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i) Enter the setup for Management as either: 1. Manual 2. DHCP
j)  Enter the IP configuration as 2 (DHCP)

k)  Enter following network settings as required:
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e |P Address
e  Netmask
e  Gateway

I)  Save the networking configuration of Management settings

FIGURE 194 IPv4 Management Settings
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1. Manual
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select IP configuration:

IP Addr e

Netmask: 255.255.0.0

Gateway: 172.19.10.254

The available gateway for Control, Cluster and Management will be displayed. You can select the system default gateway.

FIGURE 195 Default Gateway Settings

1. Control
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3. Management

Select gateway i
Frimary DNS: 4.2
Secondary DNS:
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5. Configure the IPv6 address settings that you want to assign to the AP/Data Plane interface, through which client traffic and configuration
data are sent and received.

NOTE
The cluster interface setting does not support IPvé addresses.

a) Enter the setup for Control as either: 1. Manual2. Auto Configuration
b) Enter the IP configuration as 1 (Manual).

c)  Enter following network settings as required:

e |IPv6 Address
o  Gateway

d) Save the networking configuration of Control settings.

FIGURE 196 IPv6 Control Settings
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b addresses will be obtained according to BA settings.
m:

e) Enter the setup for Management as either: 1. Manual2. Auto Configuration
f)  Enter the IP configuration as 1 (Manual)
g) Enter following network settings as required: IP address Default gateway

h) Save the networking configuration of Management settings.

FIGURE 197 IPv6 Management Settings
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The available gateway for Control and Management will be displayed. You can select the system default gateway.

RUCKUS Virtual SmartZone Getting Started Guide
Part Number: 800-72269-001 Rev G 213



Using the Setup Wizard to Install vSZ
Step 5: Configure the Cluster Settings

FIGURE 198 Default Gateway Settings

ol e e e e e D e B W e W W W WM BB e e e e B b e

secondary ll"'lb DH:

6. To apply the settings, press Y. The system takes a while to configure the network.

FIGURE 199 Network Configuration

Enter 'y’ to 11!1!]! . n' to modify
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Hetwork will be Lar . You connect back wvia Management interface (172.19.10.2 or 3000:2:1:1:

2).

Flease wait while sytem configures the network.
It may t few minut

7.  Verify that the Control Plane network settings display the IPv4 and IPvé addresses that you configured.
8. Continue to on page 214

The next step is to configure the vSZ cluster settings. The actions that you need to perform in this step depend on whether you are creating a new
cluster (with this vSZ as the first node) or you are setting up this vSZ to join an existing cluster.

° on page 215
° on page 216
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FIGURE 200 The Cluster Information page, showing the New Cluster option
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FIGURE 201 The Cluster Information page, showing the Join Existing Cluster option
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If This vSZ Is Forming a New Cluster
Follow these steps if you want to use this vSZ to create a new cluster.
On the Cluster Information page, configure the following settings:

1.  InvSZ Cluster Setting, select New Cluster.

2. In Cluster Name, type a name for the new cluster that you are creating.

NOTE
The Cluster Name and Controller Name boxes only accept alphanumeric characters, hyphens (-), and underscores (_). They do
not accept the space character or other special characters (for example, $, *, #, !).

In Controller Name, type a name for the vSZ controller in this new cluster.
In Controller Description, type a brief description for the vSZ controller.

In Default Country Code, select the country.

o A ow

In NTP Server, type the address of the NTP server from which members of the cluster will obtain and synchronize time. The default NTP
server is ntp.ruckuswireless.com

7. If you want ZoneDirector APs that are in factory default settings to be converted to SmartZone APs automatically, select the AP
Conversion check box.
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8. If the controller is behind NAT, select the check box and enter the Controller NAT IP.

9. Click Next to continue to the Administrator page.

If This vSZ Is Joining an Existing Cluster
If this is not the first vSZ cluster on the network, you can set up this vSZ virtual appliance to join an existing cluster.

NOTE
o A VSZcluster supports a maximum of four nodes. If you are building a vSZ-E cluster with more than two nodes, two (2)
additional cores must be added to each node to support the added search and replication capabilities.

e  For vSZ deployments, the node that you are joining into an existing cluster must have identical virtual machine resources (CPU,
memory, and disk size) as the existing nodes in the cluster.

o  Use the AP Rebalance feature to distribute AP load evenly between the existing and new cluster nodes, and the Dataplanes in
appliance SZ models.

To add this vSZ to an existing cluster, the entire target cluster must be in a healthy state (no node must be in “out of service” state). If any member
node is out of service, the join request will fail. You will need to remove any out-of-service node from the cluster before you can add a new node
successfully.

NOTE

When adding a new node into an existing cluster, any ARC signature files, AP or switch firmware, and AP patches on the existing cluster
will be synchronised onto the new node.

Kernel Space Program (KSP) patches must be independently uploaded to the new node. Refer to the KSP documentation to ensure
whether the KSP patches are applied per node and whether the cluster needs to be reloaded.

Follow these steps to configure this to join an existing cluster.

1. InvSZ Cluster Setting, select Join Existing Cluster.
2. In Cluster Name, type the name of the cluster that this vSZ is joining.

The Cluster Name and Controller Name boxes only accept alphanumeric characters, hyphens (-), and underscores (_). They do not accept
the space character or other special characters (for example, $, *, #, !).

In Controller Name (optional), type a name that you want to assign to this new controller.
In Controller Description, type a description for this new controller.

In Join Exist vSZ Cluster IP, type the IP address of the leader in the existing cluster.

o AW

In Admin Password, type the administrator password to the web interface of the leader node.
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7.

Using the Setup Wizard to Install vSZ
Step 6: Set the Administrator Password

Click Next to continue to the Administrator page. See Step 6: Set the Administrator Password on page 217.

FIGURE 202 The Cluster Information page, showing the Join Existing Cluster option
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If the firmware version on this vSZ (shown in the bottom-left area of the Cluster Information page) does not match the firmware version of the
cluster, a message appears and prompts you to upgrade the vSZ firmware. Click Upgrade, and then follow the prompts to perform the upgrade.

Step 6: Set the Administrator Password

Set the administrator passwords for the web interface and command line interface (CLI).

Follow these steps to set the web interface and CLI passwords.

R e

NOTE
The web interface and CLI passwords must be at least eight (8) characters in length and must include one number, one letter, and one
special character (for example, $, *, #,!).

In Admin Pasword, type a password that you want to use to access the web interface.

In Confirm Password, retype the password above to confirm.

In Enable Password, type a password that you want to use to enable CLI access to the vSZ.
In Confirm Password, retype the password above to confirm.

Click Next to continue. The Confirmation page appears and displays all the controller settings that you have configured using the Setup
Wizard.

FIGURE 203 Set the web interface and CLI passwords
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Step 7: Verify the Settings

After you complete setting the web interface and CLI passwords, check the Confirmation page and review all of the controller settings that you have

configured using the Setup Wizard.

Follow these steps to verify the controller settings that you have configured.

1.
2.

Verify that all the settings displayed on the Confirmation page are correct.

If they are all correct, click Finish to apply the settings and activate the controller on the network.

FIGURE 204 The Confirmation page

Setup Wizard - Virtual SmartZone

NOTE
If you find an incorrect setting, click the Back button until you reach the related page, and then edit the settings. When you
finish editing the settings, click the Next button until you reach the Confirmation page again.

A progress bar appears and displays the progress of applying the settings, starting the vSZ services, and activating the vSZ on the network.

When the process is complete, the progress bar shows the message 100% Done. The page also shows the IP address through which you

can access the vSZ web interface to manage the controller.

FIGURE 205 Setup is complete when the progress bar shows “100% Done”

Setup Wizard - Virtual SmartZone

Congratulations! You have completed the Setup Wizard. You are now ready to log on to the web interface. Go to https://{management-IP-
adddress}:8443, and then log on with the user name and password that you assigned to the web interface.
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Logging On to the Web Interface

You can access the web interface from any computer that is on the same subnet as the management (web) interface. Follow these steps to log on to
the vSZ web interface.

1. Onacomputer that is on the same subnet as the Management (Web) interface, start a web browser.

2. Inthe address bar, enter the IP address that you assigned to the Management (Web) interface and append a colon and 8443 (vSZ
management port number) at the end of the address. The vSZ web interface logon page appears.

If the IP address that you assigned to the Management (Web) interface is 10.10.101.1, then you should enter:
https://10.10.101.1:8443

The vSZ logon page appears.

FIGURE 206 The vSZ logon page
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3. InUser Name, type admin.
4. InPassword, type the administrator password that you assigned to the web interface earlier.
5. Click Log On. The web interface refreshes, and then displays the vSZ dashboard page, which indicates that you have logged on

successfully.

You are now ready to configure the controller. For information on how to configure the controller, refer to the Administrator Guide for the
controller platform that you have installed.

RUCKUS Virtual SmartZone Getting Started Guide
Part Number: 800-72269-001 Rev G 219



220

RUCKUS Virtual SmartZone Getting Started Guide
Part Number: 800-72269-001 Rev G



Deployment of vSZ

©  DEPIOY VSZ ON ESXi SEIVEN eeeeeeeieeeeeeeeeiteeee e eeette e e e eestteeeeeeettareeeseesssaseeeeeesssseeeesasssssaeeeeasssasseeseassssssessessssreeeeeessssseeeseenssrseeens 221
©  DEPIOY VSZ ON LINUX SEIVE ..uvveeeeieeirrieeeeeeetreeeeeeeetreeeeeeeeaeeeeeeesasreeeeeessssseeeeessssseeseassssseeeeassassseseesssassseseessssssseseensssseeesennsrens 239
o Deploying VSZ on the OpenStack PlatforMe..........cciiiiiiiiiiccie ettt ettt e e st e e s bee e sbaeessaaeessraeesasaaesssaeansns 260

Deploy vSZ on ESXi Server

Hardware Requirement and Prerequisite for ESXi Server

The following are the hardware and prerequisite for deploying vSZ on ESXi 5.5 or later version.

Hardware Requirement

1. DELL Inc. PowerEdge R530

2. ESXi Server License 5.5 or later version

3. Broadcom NetXtreme BCM5720 Gigabit Ethernet 4 Ports

4. Intel Ethernet 10G 2P X520

5. CPU minimum 8 cores

6. vSphere ESXi Server 5.5 or later version

7. 1or 3vNICs

8. 16 GB memory

9. 256 GB Hard disk

Prerequisite

e A hypervisor on ESXi to install vSZ. Recommended version is ESXi 5.5 or later version.

e Download the vSZ package (.OVA file) from Ruckus support .

e The IP addresses, netmask, gateway, DNS, DHCP and NAT support for vSZ.

o  Ensure that the vSZ license that you have, is a high-capacity mode or an essential mode.

o  Ensure the number of physical network interfaces. Choose the interface group, 3 or 1, that would be used implement for vSZ. vSZ-E mode
supports only 1 interface group. vSZ-H mode supports both 3 and 1 interface groups.

o  Before you power on vSZ, ensure that the networking is configured on ESXi.

e Recommended to use static network addresses that are assigned to vSZ during setup.

NOTE
Due to different servers and NIC, the deployment procedure mentioned in this section is for reference.
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Topology for vSZ Deployment on ESXi 5.5 Server

The network topologies for vSZ deployment on ESXi 5.5 server.

The following are basic topologies for setting up vSZ. Based on your requirement you can choose any of the alternatives for deployment.

o  High-Scale mode with three group interfaces.

FIGURE 207 vSZ-H with Three Group Interfaces
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e  Essentials mode with one group interface.
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FIGURE 208 Example 1: vSZ-E with one Group Interface
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FIGURE 209 Example 2: vSZ-E with one Group Interface
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Deployment Procedure on the ESXi Server

The following are basic instructions for setting up vSZ on the ESXi server.
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VMware ESXi 5.5 is installed and working.

1. Login to the server through vSphere client tool as seen below.

FIGURE 210 Login to vSphere
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Naime.
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vCenter Server.
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The vSphere Client management page appears as shown in the following figure.
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FIGURE 211 vSphere Client management page
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Navigate to Configuration > Network Adapters. Ensure the physical ports are linked to the correct port speed as seen below.

FIGURE 212 Define network adapters
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3. Create each vSphere standard switch (vSwitch) using the physical network adapters since vSZ requires three interfaces for management,
cluster, and control. Navigate to Configuration > Networking > Add Networking. Select the option Virtual Machine to choose the

connection type.

FIGURE 213 Define connection type
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4. Click Next.
5. Select the Network Adapter from the list and click Next.
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6. Enter the Network Label and click Next as shown in the following figure.

FIGURE 214 Define the Network Adapter
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7.  Click Finish.

8. View the created vSwitch as seen below.

FIGURE 215 View created vSwtich
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9. Repeat step 3 to step 6 to create three vSwitch for vSZ. View the created vSwitch as seen below.

NOTE

vSZ management interface is associated to the Control-IP-Domain.

FIGURE 216 View vSwitch for management and data interfaces
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10. Download the vSZ (.ova file) from the Ruckus Website.
11. Click File > Deploy OVF Template.

The Deploy OVF Template form appears.
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12. Click Browse to select the source location to install the OVF package as shown in the following figure.

FIGURE 217 Deploy the file
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13. Click Next.

230

RUCKUS Virtual SmartZone Getting Started Guide
Part Number: 800-72269-001 Rev G



Deployment of vSZ
Deploy vSZ on ESXi Server

14. Enter the vSZ datastore name and choose the disk format as seen below.
FIGURE 218 Choose the disk format
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15. Click Next and wait for deploying.
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16. From the vSphere client, select Edit Settings to change network interface settings for vSZ-H and vSZ-E as shown in the following figure.

FIGURE 219 vSphere Client Settings
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17. By default, vSZ supports three network interfaces as shown in the figure.

FIGURE 220 vSphere Setting
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NOTE
If your vSZ is running as Essential mode, select the two interfaces and click Remove.

Connect to vSZ Using CLI on ESXi Server

Follow the below procedures to connect to vSZ.

Open a CLI console window to run the deployed vSZ.

RUCKUS Virtual SmartZone Getting Started Guide
Part Number: 800-72269-001 Rev G 233



Deployment of vSZ
Deploy vSZ on ESXi Server

FIGURE 221 Run vSZ on the console
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1.  Atthe login prompt, login using administrator credentials of username and password. Run the setup command to initialize vSZ as shown
in the figure below.
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FIGURE 222 Login and Privileged mode
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2. Enter 2 for High-Scale mode and press Y to continue.

3.  Enter static IP address for control interface as shown in the figure below.

FIGURE 223 Static IP Address for Control Interface
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4. Enter static IP address for cluster interface as shown in the figure below.

FIGURE 224 Static IP Address for Cluster Interface
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5.  Enter static IP address for management interface as shown in the figure below.

FIGURE 225 Static IP Address for Management Interface
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6. Select the default gateway interface. Enter 1 for control interface, 2 for cluster interface, and 3 for management interface as shown in the
figure below.

FIGURE 226 Default Gateway Interface
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7. Enter the DNS server setting and press Y to apply all setting.

FIGURE 227 DNS Server Settings
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Do you want to apply the settings? (ysmd y_

8. Access the web link http://172.17.65.234:8443 to continue other setting as shown in the figure below.

FIGURE 228 vSZ Web Ul
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9. Enter your Cluster Information and click Next as shown in the following figure.
FIGURE 229 Cluster Information
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10. Enter your vSZ Administrator password requirements and click Next as shown in the following figure.
FIGURE 230 vSZ Administrator Password
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11. Click Finish and wait until vSZ is configured.
12. After vSZ is configured, reconnect to vSZ web as shown in the following figure.
FIGURE 231 vSZ Configuration
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13. Enter Username and Password to access vSZ as shown in the following figure.

FIGURE 232 vSZ Homepage
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Deploy vSZ on Linux Server

Hardware Requirement and Prerequisite for LINUX CentOS 7
The following are the hardware and prerequisite for deploying vSZ on LINUX CentOS 7.
Hardware Requirement

1.  DELL Inc. PowerEdge R320

2. Linux CentOS 7

3. Broadcom NetXtreme BCM5720 Gigabit Ethernet 2 Ports

4. Intel Ethernet 10G 2P X520
Prerequisite

e  AlLinux host enabled KVM which to install vSZ VM. Prefer CentOS 7 and later.

e  Download the vSZ package (.qcow? file) from Ruckus support .

o  The IP addresses, netmask, gateway, DNS, DHCP and NAT support for vSZ.

e  Ensure if the vSZ license that you have, is a high-capacity mode or an essential mode.

e  1Ensure the number of physical network interfaces. Choose the interface group, 3 or 1, that would be used implement for vSZ. vSZ-E
mode supports only 1 interface group. vSZ-H mode supports both 3 and 1 interface groups.

e  Before you power on vSZ, ensure that the networking is configured on LINUX.
e Recommended to use static network addresses that are assigned to vSZ during setup.

e  Using CentOS 7, install KVM package with the yum command.

root@localhost ruckusvncl# yum -y install gemu-kvm gemu-img virt-manager virt-viewer virt-install
libvirt libvirt-phthon libvirt-client
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e  Ensure KVM is active and running the following command.

[root@localhost ruckusvnc]# systemctl status libvirtd

e  Edit the following commands and file.
sudo yum install grub2-common
gedit /etc/default/grub
GRUB_TIMEOUT=5
GRUB_DISTRIBUTOR="S (sed 's, release .*$,,g' /etc/system-release)"
GRUBiDEFAULT=Saved
GRUB_DISABLE_ SUBMENU=true
GRUB_TERMINAL OUTPUT="console"
GRUB_CMDLINE LINUX="crashkernel=auto rd.lvm.lv=centos/root rd.lvm.lv=centos/swap rhgb quiet
intel iommu=on"
GRUB_ DISABLE RECOVERY="true"

sudo grub2-mkconfig -o /boot/grub2/grub.cfg
®  Reboot Linux host.

NOTE
Due to different servers and NIC, the deployment procedure mentioned in this section is for reference.

Topology for vSZ Deployment on LINUX CentOS7
The network topologies for vSZ deployment on LINUX CentOS 7.

The following are basic topologies for setting up vSZ. Based on your requirement you can choose any of the alternatives for deployment.

o  High-Scale mode with three group interfaces.
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FIGURE 233 vSZ-H with Three Group Interfaces
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e  Essentials mode with one group interface.
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FIGURE 234 Example 1: vSZ-E with one Group Interface
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FIGURE 235 Example 2: vSZ-E with one Group Interface
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Deployment Procedure on the LINUX Server

The following are basic instructions for setting up vSZ on LINUX KVM.
LINUX CentOS 7 KVM Package is installed and working.
1. Download vSZ package (.qcow?2 file) from Ruckus website.

2.
following figure.

FIGURE 236 Virtual Machine Manager
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3. Create a new VM.

a) Click File and select New Virtual Machine as shown in the following figure.

FIGURE 237 Creating a Virtual Machine

Virtual Machine Manager - =] x
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Close
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b) Inthe New VM dialog box, choose the disk format option as shown in the following figure.

FIGURE 238 Disk Format

Mew VM

m Create a new virtual machine

Connection: QEMU/KVM

Choose how you would like to install the operating system
Local install media (150 image or COROM)
MNetwork Install (HTTP, FTP, or NF5)
Metwork Boot (PXE)

+ Import existing disk image

Cancel Back Forward
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c) Click Forward.

d) Choose destination storage path and storage volume. Click Browse Local as show in the following figure.

FIGURE 239 Storage Volume
Choose Storage Volume X
Size: 38.50 GiB Free / 11.48 GiB In Use
Filesystem Directory Location: /var/lib/libvirt/images
Downloads -
o Filesystem Directory Volumes | € ‘ ® h
- Volumes ¥ Size Format Used By
ubuntul6.04.qcow2 15.00 GIB gcow? ubuntul6.04
+ l b4 ‘ @ Browse Local || Cancel || Choose Volume

e) Select the vSZ file and click Open as shown in the following figure.

FIGURE 240 vSZ File

f)  To select the storage path, click Browse as shown in the following figure.
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FIGURE 241 Storage Path

MNew VM x

m Create a new virtual machine

Provide the existing storage path:
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Choose an operating system type and version

05 type: | Generic -
Version:  Generic -
Cancel Back Fonsward

g) Click Forward.

h)  Enter the Memory (RAM) and CPUs setting as shown in the following figure.

NOTE
Memory (RAM) must be 15GB and CPUs must be 4 cores.

246
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FIGURE 242 Memory and CPU Settings
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Cancel Back Forward

i)  Click Forward.

j)  To confirm the installation process, click Finish as shown in the following figure.

NOTE
The sequence for Network interfaces must first be Management and the Data.
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FIGURE 243 Installation Confirmation
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From the VNC Viewer, click Add Hardware, select the NIC and choose the Device model to update the Control, Cluster and Management

interface associate as shown in the following figures.

NOTE
VSZ needs three interfaces; Control, Cluster, and Management.

NOTE

For Essential mode, you need not add two NICs.

FIGURE 244 Control Interface
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FIGURE 245 Cluster Interface
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FIGURE 246 Management Interface
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5. Define the CPU Configuration. Select the Copy host CPU configuration check box as shown in the following figure.

FIGURE 247 CPU Configuration
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6. Define the IDE Disk Configuration. Choose the Disk bus option as shown in the following figure.

FIGURE 248 IDE Disk Configuration
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Select Begin Installation as shown in the following figure.

FIGURE 249 Begin Installation
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Connect to vSZ Using CLI on LINUX Server

Follow the below procedures to connect to vSZ.

Open a CLI console window to run the deployed vSZ.

254
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FIGURE 250 Run vSZ on the console
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1. At the login prompt, login using administrator credentials of username and password. Run the setup command to initialize vSZ as shown
in the figure below.
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FIGURE 251 Login and Privileged mode
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2. Enter 2 for High-Scale mode and press Y to continue.

3. Choose IP version IPv4 only or IPv4 and IPvé. For example, press 1 for IPv4.

4. Enter static IP address for control interface as shown in the figure below.

FIGURE 252 Static IP Address for Control Interface

BB R R B BB R S BB e B

nf iguration: (1-2) 1

256

RUCKUS Virtual SmartZone Getting Started Guide
Part Number: 800-72269-001 Rev G



Deployment of vSZ
Deploy vSZ on Linux Server

5. Enter static IP address for cluster interface as shown in the figure below.

FIGURE 253 Static IP Address for Cluster Interface
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6. Enter static IP address for management interface as shown in the figure below.

FIGURE 254 Static IP Address for Management Interface
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7. Select the default gateway interface. Enter 1 for control interface, 2 for cluster interface, and 3 for management interface as shown in the
figure below.

FIGURE 255 Default Gateway Interface
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8. Enter the DNS server setting and press Y to apply all setting.

FIGURE 256 DNS Server Settings
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9. Access the web link http://172.17.65.234:8443 to continue other setting as shown in the figure below.

FIGURE 257 vSZ Web Ul
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10. Enter your Cluster Information and click Next as shown in the following figure.
FIGURE 258 Cluster Information
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11. Enter your vSZ Administrator password requirements and click Next as shown in the following figure.
FIGURE 259 vSZ Administrator Password
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12. Click Finish and wait until vSZ is configured.
13. After vSZ is configured, reconnect to vSZ web as shown in the following figure.
FIGURE 260 vSZ Configuration
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14. Enter Username and Password to access vSZ as shown in the following figure.

FIGURE 261 vSZ Homepage
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Deploying vSZ on the OpenStack Platform

Deploying a Three-Interface vSZ Without a Built-in SNAT

Complete the following basic steps to deploy a three-interface vSZ on the OpenStack platform.

1. Logout of OpenStack as an administrator and log in to OpenStack with an existing user account.

2. Select Project > Compute > Instances.

The Instances page is displayed.

FIGURE 262 Viewing the Project Instances
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3. Click Launch Instance.

The Launch Instance page is displayed.

FIGURE 263 Launching an Instance
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4. Click Details to enter the Instance Name and click Next.

5. Click Source and perform the following steps:
a. Move the required image from the Available to the Allocated list.

NOTE
The supported image format is gcow2.

b. Under Create New Volume, select No and click Next.

6. Click Flavor to move the required resource plan from the Available to the Allocated list and click Next.

NOTE
You must use resources according to the requirements for the release being installed.

7.  Click Networks to move the required network interface from Available to Allocated list and click Next.

NOTE
You must select the network interfaces in the following order:

a. Control interface
b. Cluster interface

c. Management interface
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10.

11.

Click Network Ports and then click Next.

Click Security Groups to move the required security rule from the Available to the Allocated list and click Next.

Click Key Pair to move the required key pair from the Available to the Allocated list and click Next.

NOTE

If only one key pair is available, then the system will automatically move the key pair to the Allocated list.

Click Launch Instance.

NOTE

When the new instance of vSZ is created, the Power State of the instance is shown as Running.

Deploying a One-Interface vSZ with a Built-in SNAT

Complete the following basic steps to deploy a one-interface vSZ with a built-in SNAT.

1.

2
3.
4
5

Create an internal network.

Create a router.

Allocate a floating IP address to a project.
Launch a vSZ instance.

Associate a floating IP address to a project.

Creating an Internal Network

You must create an internal network to deploy vSZ instances.

1.
2.

262

Log out of OpenStack as an administrator and log in to OpenStack with an existing user account.

Select Project > Network > Networks.

The Networks page is displayed.

FIGURE 264 Viewing the Internal Networks
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3. Click Create Network.

The Create Network page is displayed.

FIGURE 265 Creating an Internal Network

r &

Create Network

MNetwork Subnet Subnet Details

Network Name Create a new network. In addition, a subnet associated

‘ Ipternal_Management | with the network can be created in the following steps of
this wizard.
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Availability Zone Hints @
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Cancel a Back

4. Click Network to enter the network name and click Next.

NOTE
Enable Admin State and Create Subnet are enabled by default.

5. Click Subnet to enter the subnet name and network address, and click Next.

NOTE
IPv4 is the default value.

6. Click Subnet Details to enter DNS name servers.

7.  Click Create.
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Creating a Router
Before creating a network interface, you must create a router.
1. Select Project > Network > Routers.

The Routers page is displayed.

FIGURE 266 Viewing the Routers
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2. Click Create Router.

The Create Router page is displayed.

FIGURE 267 Creating a Router

Create Router

Router Name
R_mamt Description:

Creates a router with specified parameters.
 Enable Admin State

External Network

mgmt A

Availability Zone Hints @

nova

Cancel Create Router
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3. Inthe Router Name field, enter the router name.

NOTE
Enable Admin State is enabled by default.

4. Inthe External Network list, select the network that must be the NAT interface.

5. Click Create Router.

NOTE
The Routers page reflects the router that was added.

6. Click the name of the router that was created.

7. Click Interfaces.

FIGURE 268 Viewing the Network Interfaces

-
fiopenstack. =wz- & nolan +
Project v
Project / Network / Routers / R_mgmt
API Access
ClearGateway |14
Compute > R_mgmt
Volumes >
teraces tic R
. &
Network Topology + Add Interface
Netwarks Name Fixed IPs Status Type Admin State Actions
Security Groups

Floating IPs

Trunks
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8. Click Add Interface.

The Add Interface page is displayed.

FIGURE 269 Adding an Interface

Add Interface

Subnet *

Internal_Management: 10.199.3.0/24 (internal_... =

IP Address (optional) @

Description:
You can connect a specified subnet to the router.

If you don't specify an IP address here, the gateway's
IP address of the selected subnet will be used as the
IP address of the newly created interface of the router.
If the gateway's IP address is in use, you must use a
different address which belongs to the selected subnet.

9. Inthe Subnet list, select the subnet (internal interface).

NOTE

If an IP address is not specified, the gateway's IP address of the selected subnet is used. If the gateway's IP address is already in
use, specify a different IP address that belongs to the selected subnet.

10. Click Submit.

Confirming the Router Creation

Complete the following steps to confirm the router is created correctly.
1. Select Project > Network > Network Topology.

2. Select Normal mode.
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FIGURE 270 Checking the Network Topology

Project v
Project / Network / Network Topology

APl Access

Compute > Network Topology

Volumes >
Network 4
Topology |~ Graph
Network Topology
m =
Networks I Small &8 Normal
Routers

Security Groups

Floating IPs
Trunks
Router
Object Store > (5)
vSZ_1inf
Identity > Instance

DEL0ZLVTLL
VEOERRLOL

If the router is created successfully, it will be displayed as shown in the figure.

Allocating a Floating IP Address to a Project
You must allocate a floating IP address to a project from a pool of floating IP addresses.
1. Select Project > Network > Floating IPs.

The Floating IPs page is displayed.

FIGURE 271 Viewing the Floating IPs

Project v
Project / Network / Floating IPs
AP Access

Compute » Floating IPs

Volumes >

Network v % Allocate [P To Project

Network Topology 1P Address Mapped Fixed IP Address Pool Status Actions.

Networks No items to display.
Routers
Security Groups

Object Store >

Identity >
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2. Click Allocate IP To Project.

The Allocate Floating IP page is displayed.

FIGURE 272 Allocating a Floating IP Address

Allocate Floating IP

*
Pool

mgmt

Description

NOTE

Description:

Allocate a floating IP from a given floating IP pool.

Project Quotas

Floating IP

Cancel Allocate IP

After the allocation of a floating IP address to a project, the entry is reflected in the Floating IPs page.

3. Select a floating IP address (external interface) from the Pool list.

4. Click Allocate IP.

Launching a vSZ Instance

Complete the following basic steps to deploy a new instance of a one-interface vSZ on the OpenStack platform.

1. Select Project > Compute > Instances.

The Instances page is displayed.

FIGURE 273 Viewing the Project Instances

-
£ openstack test v

Project v
Project / Compute / Instances

Compute . Instances

Images Instance Name Image Name 1P Address
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Status. Availability Zone

No items to display.

Power State Time since created
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2. Click Launch Instance.

The Launch Instance page is displayed.

FIGURE 274 Launching an Instance

Launch Instance

Source *

Flavor *
Networks *
Network Ports
Security Groups
Key Pair
Configuration
Server Groups
Scheduler Hints

Metadata

% Cancel
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Please provide the initial hostname for the instance, the availability zone whers it will be deployed, and the instance 9
count. Increase the Count to create multiple instances with the same settings.

*
Instance Name

vSZ_1inf

Description

Availability Zone

nova

Count *

1

Total Instances
(10 Max)

W
20%

B 1 Current Usage
1 Added

E‘ 8 Remaining

<Back Mext »

3. Click Details to enter the instance name and click Next.
4. Click Source and perform the following steps:

a) Move the required image from the Available to the Allocated list.

NOTE

The supported image format is qcow?2.

b) Under Create New Volume, Select No and click Next.

5. Click Flavor to move the required resource plan from the Available to the Allocated list and click Next.

NOTE

You must use resources according to the requirements for the release being installed.

6. Click Networks to move the required network interface from the Available to the Allocated list and click Next.

7. Click Network Ports and then click Next.

8. Click Security Groups to move the required security rule from the Available to the Allocated list and click Next.
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9. Click Key Pair to move the required key pair from the Available to the Allocated list.

NOTE
If only one key pair is available, then the system will automatically move the key pair to the Allocated list. Remove the default
security rule from the Allocated list.

10. Click Launch Instance.

NOTE
When the new instance of vSZ is created, the power state of the instance is shown as Running.

Associating a Floating IP Address to a Project
To direct network traffic to the OpenStack instances, you must associate a floating IP address to a project.
1. Select Project > Compute > Instances.

The Instances page is displayed.

FIGURE 275 Viewing the Project Instances

fopenstack. =z~ & nolan »

Project v
Project / Compute / Instances
APl Access

Compute . Instances

Overiew
m Instance 1D =+ Fiter | @ Launch Instance More Actions ~
Images  Displaying 2 tems
Keypasrs O Instance Name Image Name 1P Address. Flavor Key Pair Status Availability Zone Task  Power State Time since created Actions.
Volumes > o vsZ_tinf 362056 10.199.37 SZ_resource_plan nolan-project-key Active noa None  Running 0 minutes Greate Snapshot ‘-‘
Associate Floating IP
Network >
control amotes O
Object Store > 10.10.30.128 Detach Interface.
cluster . Edtinstance
denti o vz 362056 S7_resource_plan nolan-project-ke; Active noa None  Rumin 2 hours, 16 minutes
Identity > propetiey 9 Aach Volume

192.168.66.122
Detach Volume

mgmt
Update Metadata
2121231 Edit Security Groups
Dispiaying 2 tems Cansole
ViewLog

Pause Instance
Suspend instance
Sheive Instance

Resize Instance

Lock Instance

RUCKUS Virtual SmartZone Getting Started Guide
270 Part Number: 800-72269-001 Rev G



Deployment of vSZ
Deploying vSZ on the OpenStack Platform

2. Click Associate Floating IP from the Action list.

The Manage Floating IP Associations page is displayed.

FIGURE 276 Managing a Floating IP Association

Manage Floating IP Associations

*
IP Address Select the IP address you wish to associate with the

172 17.21.233 - + selected instance or port.

Port to be associated *

vSZ_1inf 10.199.3.7 - S

Cancel Associate

3. Select an IP address from the IP Address list or click + to allocate a floating IP address. Refer to Allocating a Floating IP Address to a Project

on page 267 for more information.

NOTE
The Port to be associated is automatically selected by OpenStack in a one-interface vSZ.

4. Click Associate.

Setting Up a vSZ Cluster on OpenStack
Complete the following steps to set up a vSZ cluster on the OpenStack platform.

1. Select Project > Compute > Instances.

2. Click the instance name of the vSZ.
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3. Click Console to view the vSZ login prompt.

NOTE

The Linux PC uses a private key to connect to the vSZ console.

FIGURE 277 Viewing the vSZ Login Console

fopenstack. =z~

Project
Project / Compute / Instances / vSZ_finf
APl Access
Computs « VSZ_1inf
mages  INStance Console
Key Pairs If console is not responding to keyboard input: click the grey status bar below. Click here to show or
To exit the fulscreen made, cick the browser' back button
Volumes >
Network >
Object Store >
Identity >

-profiles/functions: line 149

e-netuork-security.cont

4, Complete the vSZ setup flow steps. Refer to Using the Setup Wizard to Install vSZ on page 205.

NOTE

You must configure the vSZ interface IP address as DHCP to avoid network issues.

& nolan ~

Create Snapshot v

Send CtrlAltDel
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Upgrading the Controller for Microsoft Azure, AWS, and
GCE Platforms

Ruckus Networks may periodically release controller software updates that contain new features, enhancements, and fixes for known issues.

These software updates may be made available on the Ruckus Networkssupport website or released through authorized channels.

CAUTION

A Although the software upgrade process has been designed to preserve all controller settings, Ruckus Networks strongly recommends
that you back up the controller cluster before performing an upgrade. Having a cluster backup will ensure that you can easily restore
the controller system if the upgrade process fails for any reason.

CAUTION
A Ruckus Networks strongly recommends that you ensure that all interface cables are intact during the upgrade procedure.

CAUTION
A Ruckus Networks strongly recommends that you ensure that the power supply is not disrupted during the upgrade procedure.

NOTE
If you are managing a vSZ, you can also perform system configuration backup, restore, and upgrade from the controller command line
interface.

Upgrading the Controller Software

This section outlines the procedure to upgrade the controller software for Microsoft Azure, Amazon Web Services, Google Computing Engine
platforms.

Follow these steps to upgrade the controller software.

CAUTION
A Ruckus Networks strongly recommends backing up the controller cluster before performing the upgrade. If the upgrade process fails
for any reason, you can use the latest backup file to restore the controller cluster.

NOTE
Before starting this procedure, you should have already obtained a valid controller software upgrade file from Ruckus Networks Support
or an authorized reseller.
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vSZ supports APs starting version 3.4. You must first upgrade the vSZ. Only a new vSZ can handle an old vDP. During the vSZ upgrade, all tunnels will
stay up except the main tunnel which moves to the vSZ.

Upgrade to 5.0 does not support data migration (statistics, events, administrator logs). Existing system and network configuration is preserved. For
further clarification, Contact Ruckus support.

To Upgrade:

1.

274

Copy the software upgrade file that you received from Ruckus Networks to the computer where you are accessing the controller web
interface or to any location on the network that is accessible from the web interface.

Go to Administration > Administration > Upgrade > Upgrade.

In the Upload section, select the Run Pre-Upgrade Validations box to verify if the data migration was successful. This option allows you to
verify data migration errors before performing the upgrade. If data migration was unsuccessful, the following error is displayed:
Exception occurred during the validation of data migration. Please apply the system
configuration backup and contact system administrator.

Typically, the file name of the software upgrade file is scg-installer {version}.ximg.

Click the Browse button, and then browse to the location of the software upgrade file. 1q

FIGURE 278 Click Browse in the Upload section to upload the software upgrade file

# |#” Monitor ita Network U Security & Services & Administration w se u Administration > Administration > Upgrade > Upgrade

Upgrade DPPatch  APPatch  Switch Firmware Schedule Zone Firmware Upgrade

Current System Information

Controller Version 6.1.0.0.913
Control Plane Software Version 6.1.0.0.683

AP Firmware Version 6.1.0.0.1567

Upload
B run ere-uperade validations (1t will take a few minutes to check if the system has sufficient resources to complete the upgrade)

Upload the patch file (*ximg) that you want to use to upgrade the controller.
Browse

Upgrade History

Select the software upgrade file, and then click Open.

Click Upload to upload the software upgrade file. The controller uploads the file to its database, and then performs file verification. After
the file is verified, the Upgrade Pending Patch Information section is populated with information about the upgrade file.
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7. Start the upgrade process by clicking one of the following buttons:
e Upgrade: Click this button to start the upgrade process without backing up the current controller cluster or its system configuration.

e  Backup & Upgrade: Click this button to back up the controller cluster and system configuration before performing the upgrade.

A CAUTION

Ruckus Networks strongly recommends using Backup & Upgrade when performing the upgrade. If the upgrade process
fails for any reason, you can use the latest backup file to restore the controller cluster.

A confirmation message appears.

8. Click Yes.

The controller starts the process that you selected. The screens that appear next will depend on the process that you selected to upgrade
immediately or to back up and then upgrade the controller.

FIGURE 279 The System Upgrade page displays the status of the upgrade process

System is back, and system is performing cluster operation, please wait...

Current Cluster Operation: Upgrade

Operation Status: Performing post upgrade cleanup.

Progress Status: 15/15

When the upgrade (or backup-and-upgrade) process is complete, the controller logs you off the web interface automatically. Wait for a few minutes
until the web interface log on page appears.

FIGURE 280 The controller web interface may display the following message as it completes the upgrade process

X

Are you sure you want to back up the cluster?

O
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When the controller logon page appears again, you have completed upgrading the controller.

Continue to the Verifying the Upgrade task to check if the upgrade was completed successfully.

Verifying the Upgrade

Follow these steps to verify that the controller upgrade was completed successfully.
1. Logon to the controller web interface.
2. Go to Administration > Administration > Upgrade > Upgrade.
3. Inthe Current System Information section, check the value for Controller Version.

If the firmware version is newer than the firmware version that controller was using before you started the upgrade process, then the
upgrade process was completed successfully.

NOTE

APs periodically send scheduled configuration requests to the controller, including the firmware version. Therefore, when an AP
joins a zone for the first time, the firmware version is verified by the controller. If the firmware version is different from that
which is configured for the zone, the controller responds with a request to upgrade it, after which the AP initiates a request to
upgrade the firmware using HTTP.

FIGURE 281 Check the value for Controller Version

# |#* Monitor 4 Network U Security € Services & Administration w Administration > Administration > Upgrade > Upgrade

Upgrade  DPPatch AP Patch  Switch Firmware Schedule Zone Firmware Upgrade

Current System Information

Controller Version 6.1.0.0.913

Control Plane Software Version 6.1.0.0.683

AP Firmware Version 6.1.0.0.1567
Upload

B run ere-upgrade validations (1t will take a few minutes to check if the system has sufficient resources to complete the upgrade)

Upload the patch file (*ximg) that you want to use to upgrade the controller.
Browse

Upgrade History

search table Q o%

Rolling Back to a Previous Software Version

There are two scenarios in which you may want to roll back the controller software to a previous version:

1. You encounter issues during the software upgrade process and the controller cannot be upgraded successfully. In this scenario, you can
only perform the software rollback from the CLI using the restore local command. If you have a two-node controller cluster, run the
restore local command on each of the nodes to restore them to the previous software before attempting to upgrade them again.
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2. You prefer a previous software version to the newer version to which you have upgraded successfully. For example, you feel that the
controller does not operate normally after you upgraded to the newer version and you want to restore the previous software version,
which was more stable. In this scenario, you can perform the software rollback either from the web interface or the CLI. If you have a two-
node controller cluster, you must have cluster backup on both of the nodes.

To ensure that you will be able to roll back to a previous version, Ruckus Networks strongly recommends the following before attempting to
upgrade the controller software:

o  Always back up the controller before attempting a software upgrade. If you are managing a multi-node cluster, back up the entire cluster,
and then verify that the backup process completes successfully. See Creating a Cluster Backup on page 277 for more information.

e If you have an FTP server, back up the entire cluster and upload the backup files from all the nodes in a cluster to a remote FTP server.

Backing Up and Restoring Clusters

Back up the controller cluster periodically to ensure that you can restore the control plane, data plane, and AP firmware versions as well as the
system configuration in the cluster if is a system failure occurs.

This section covers the following topics:

NOTE
You can also perform these procedures from the vSZ command line interface. Note, however, that you will need to execute the
commands on each node.

Creating a Cluster Backup
Follow these steps to back up an entire controller cluster.
1. Take note of the current system time.

To view the current system time, go to Administration > System > Time.
2. Go to Administration > Administration > Backup & Restore > Cluster.

3. Click Back Up Entire Cluster.

The following confirmation message appears: Are you sure you want to back up the cluster?

4. Click Yes.
The following message appears: The cluster is in maintenance mode. Please wait a few minutes.

When the cluster backup process is complete, a new entry appears in the Cluster Backups History section with a Created On value that is
approximate to the time when you started the cluster backup process.

NOTE
If you have an FTP server, back up the entire cluster and upload the backup files from all the nodes in a cluster to a remote FTP server.

You have completed backing up the controller cluster.

RUCKUS Virtual SmartZone Getting Started Guide
Part Number: 800-72269-001 Rev G 277



Upgrading the Controller for Microsoft Azure, AWS, and GCE Platforms
Rolling Back to a Previous Software Version

FIGURE 282 A new entry appears in the Cluster Backups section

&/ |#” Monitor a5 Network U Security & Services & Administration *

Cluster  Configuration Switches

Cluster Backup and Restore

Back up the cl
planes and AP

nsure that it can be rec
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& the controller's software. Cluster backup includes the contraller's 08, firmware versions (cantrol
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&3 Back Up Entire Cluster

Cluster Backups History

search table Q| %

Patch Version & Created On File Size

5.2.1.0.149 2020/02/06 16:10:42 1.5GB

5.2.1.0.177 2020/03/10 09:42:05 1.9GB

6.0.0.0.1009 2020/12/0220:31:42 11.4G8

6.0.0.0.1331 2021/05/24 11:43:58 14.4GB

6.1.0.0.582 2021/09/01 14:29:26 18.6GB

6.1.0.0.875 2021/12/09 14:15:41 20.5GB T

EFEETET -

Restoring a Cluster Backup

When restoring a cluster backup, remember that you must perform the restore procedure on the exact same node which you generated the cluster
backup.

Follow these steps to restore a cluster backup

1.  Go to Administration > Administration > Backup & Restore > Cluster.
2. In the Cluster Backups History section, locate the cluster backup that you want to restore.

3. Select the backup file that you want to restore, and then click Backup Entire Cluster.

FIGURE 283 Select the backup file, and then click Backup Entire Cluster
« |#* Monitor s Network U Security & Services & Administration *

Cluster  Configuration Switches

Cluster Backup and Restore

Back up the clust
planes and AP

&3 Back Up Entire Cluster

Cluster Backups History

y if a serious error occurs. Ruckus also recommends backing up the cluster before upgrading the controller's software. Cluster backup includes the controller's 0S, firmware versions (control

search table Q o%

PatchVersion a

5.2.1.0.149 2020/02/06 16:10:42 1.5GB
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6.0.0.0.1331 2021/05/24 11:43:58 14.4G8

6.1.0.0.583 2021/09/01 14:29:26 18.6GB

6.1.0.0.875 2021/12/09 14:1%:41 20.9GB -
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The following confirmation message appears: Are you sure you want to restore the cluster?.Click Yes.

FIGURE 284 Confirm Backup

X

Are you sure you want to restore the cluster?

The page refreshes, and then the following message appears: System is restoring! Please wait...

NOTE

The cluster restore process may take several minutes to complete.

When the restore process is complete, the controller logs you off the web interface automatically.

Do not refresh the controller web interface while the restore process is in progress. Wait for the restore process to complete
successfully.

Log back on to the controller web interface.

NOTE

If the web interface displays the message Cluster is out of service. Please try again in a few
minutes. appears after you log on to the controller web interface, wait for about three minutes. The dashboard will appear
shortly. The message appears because the controller is still initializing its processes.

Go to Administration > Administration > Upgrade > Upgrade, and then check the Current System Information section and verify that all
nodes in the cluster have been restored to the previous version and are all in service.

Go to Monitor > Troubleshooting & Diagnostics > Application Logs .

Check the Health Status column and verify that all of the controller processes are online.

You have completed restoring the cluster backup. After the upgrade is complete, go to the Application Logs page and verify that all of the controller

processes are online.
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FIGURE 285 On the Application Logs page, verify that all controller processes are online
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Warning

Warning
Warning

Warning

Warning

Warning

Warning

Warning

Warning

Warning

Warning
Warning
Warning
Warning
Warning
Warning
Warning

Warning

Warning

Follow these steps to restore a cluster backup using the CLI.

1. Enter the vSZ CLI.

2. Enter the following command and enter the password to log into the CLI.

VSCG35> en
Password:

3. Enter the following command to restore a cluster backup:
VSCG35> restore

All the cluster backups are listed in an order of the cluster backup created date.

4. Specify the number mentioned against the cluster backup that you wish to restore.

You have restored the cluster backup.

FIGURE 286 Cluster Backup Restore Using CLI

B
# Welcome to vSZ #
s e S
admin@l3.94.61.64's password:

Please wait. CLI initializing...

C-26> en
Password: ###%*d

C-26# restore
File Size

7 GMT
23 03:47:41 GMT

Please choose a backup to restore or 'No' to cancel: 2
This action will reboot the system. you want to restore "the entire" cluster system (or input 'no' to cancel)? [yes/no] yesl

RUCKUS Virtual SmartZone Getting Started Guide
280 Part Number: 800-72269-001 Rev G



Upgrading the Controller for Microsoft Azure, AWS, and GCE Platforms
Rolling Back to a Previous Software Version

Deleting a Cluster Backup
Follow these steps to delete a cluster backup.

1. Go to Administration > Administration > Backup & Restore > Cluster.

2. In the Cluster Backups History section of the Cluster tab, locate the cluster backup that you want to delete, and then click it.

The cluster backup becomes highlighted, which indicates that you have selected it.

@ Delete
3. Click

A confirmation message appears.

FIGURE 287 After you click the Delete button, a confirmation message appears

_ |#* Monitor it Network U Security L Services & Administration W se men Administration > Administration > Backup & Restore > Cluster

Cluster  Configuration Switches

Cluster Backup and Restore

@

Are you sure you want to delete the selected resource?

&3 Back Up Entire Cluster

Cluster Backups History

&3 Restore | X Download | Delete Yes “ search table Q - ]

4. Click Yes.
The page refreshes, and then the cluster backup that you deleted disappears from the Cluster Backups History section.

You have completed deleting a cluster backup.
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